Legal Information

Trademarks
Snap-on, ShopStream Connect, SureTrack, Fast-Track Troubleshooter, ProDemand, ShopKey Pro and VERDICT are trademarks registered in the United States and other countries of Snap-on Incorporated. All other marks are trademarks or registered trademarks of their respective holders.

The Bluetooth word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such marks by Snap-on Incorporated is under license.

Copyright Information
© 2018 Snap-on Incorporated. All rights reserved.

Disclaimer of Warranties and Limitation of Liabilities
All pictures and illustrations shown are for reference purposes only. All information, specifications and illustrations in this manual are based on the latest information available at the time of printing and are subject to change without notice. While the authors have taken due care in the preparation of this manual, nothing contained herein:

• Modifies or alters in any way the standard terms and conditions of the purchase, lease, or rental agreement under the terms of which the equipment to which this manual relates was acquired.

• Increases in any way the liability to the customer or to third parties.

Snap-on® reserves the right to make changes at any time without notice.

IMPORTANT:
Before operating or maintaining this unit, please read this manual carefully paying extra attention to the safety warnings and precautions.

Manuals / Technical Documentation - The information in this manual is periodically revised to ensure the latest information is included. Download the latest version of this manual and other related technical documentation from the Snap-on Diagnostics website.

Software License Information
Use of Software is governed by the terms and conditions of the End User License Agreement. The diagnostic tool should not be initially operated until the End User License Agreement is read. Use of the device acknowledges your acceptance of the End User License Agreement. The Snap-on Incorporated Software End User License Agreement may be provided with the diagnostic tool, and is available at: https://eula.snapon.com/diagnostics

Patent Information
For a listing of Snap-on products that are protected by patents in the United States and elsewhere, visit: https://patents.snapon.com
Contact Information (North America)

Websites:

Snap-on Diagnostics and Information
- http://diagnostics.snapon.com

Training and Support (by platform) - Find specific support and training information for your Diagnostic Tool.
- http://diagnostics.snapon.com/cc.htm

Forums and Training (all platforms) - Watch free instructional product videos. Connect with and share your Diagnostic Tool questions, ideas and success stories.
- http://diagnostics.snapon.com/ForumsandTraining.htm

Manuals / Technical Documentation (all platforms) - The information in this manual is periodically revised to ensure the latest information is included. Download the latest version of this manual and other related documentation at:
- http://diagnostics.snapon.com/usermanuals

Phone / E-mail - Technical Assistance
1-800-424-7226 / diagnostics_support@snapon.com

For technical assistance in all other markets, contact your selling agent.
FCC Compliance Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

CAUTION

You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void your authority to operate the equipment.

FCC RF Radiation Exposure Statement

1. This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.
2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This device was tested for typical lap held operations with the device contacted directly to the human body to the back side of the Display Unit. To maintain compliance with FCC RF exposure compliance requirements, avoid direct contact to the transmitting antenna during transmitting.
3. According to FCC 15.407(e), the device is intended to operate in the frequency band of 5.15GHz to 5.25GHz under all conditions of normal operation. Normal operation of this device is restricted to indoor use only to reduce any potential for harmful interference to co-channel MSS operations.
READ ALL INSTRUCTIONS

For your own safety, the safety of others, and to prevent damage to the product and vehicles upon which it is used, it is important that all instructions and safety messages in this manual and the accompanying Important Safety Instructions manual be read and understood by all persons operating, or coming into contact with the product, before operating. We suggest you store a copy of each manual near the product in sight of the operator.

For your safety, read all instructions. Use your diagnostic tools only as described in the tool user’s manual. Use only manufacturer recommended parts and accessories with your diagnostic tools.

This product is intended for use by properly trained and skilled professional automotive technicians. The safety messages presented throughout this manual and the accompanying Important Safety Instructions manual are reminders to the operator to exercise extreme care when using this product.

There are many variations in procedures, techniques, tools, and parts for servicing vehicles, as well as in the skill of the individual doing the work. Because of the vast number of test applications and variations in the products that can be tested with this instrument, we cannot possibly anticipate or provide advice or safety messages to cover every situation. It is the responsibility of the automotive technician to be knowledgeable of the system being tested. It is essential to use proper service methods and test procedures. It is important to perform tests in an appropriate and acceptable manner that does not endanger your safety, the safety of others in the work area, the equipment being used, or the vehicle being tested.

It is assumed that the operator has a thorough understanding of vehicle systems before using this product. Understanding of these system principles and operating theories is necessary for competent, safe and accurate use of this instrument.

Before using the equipment, always refer to and follow the safety messages and applicable test procedures provided by the manufacturer of the vehicle or equipment being tested. Use the product only as described in it’s user manual. Use only manufacturer recommended parts and accessories with your product.

Read, understand and follow all safety messages and instructions in this manual, the accompanying Important Safety Instructions manual, and on the test equipment.

Environmental Conditions:

- This product is intended for indoor use only
- This product is rated for Pollution Degree 2 (normal conditions)
Safety Signal Words

All safety messages contain a safety signal word that indicates the level of the hazard. An icon, when present, gives a graphical description of the hazard. Safety Signal words are:

**DANGER**

Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury to the operator or to bystanders.

**WARNING**

Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury to the operator or to bystanders.

**CAUTION**

Indicates a potentially hazardous situation which, if not avoided, may result in moderate or minor injury to the operator or to bystanders.

Safety Message Conventions

Safety messages are provided to help prevent personal injury and equipment damage. Safety messages communicate the hazard, hazard avoidance and possible consequences using three different type styles:

- Normal type states the hazard.
- **Bold type states how to avoid the hazard.**
- *Italic type states the possible consequences of not avoiding the hazard.*

An icon, when present, gives a graphical description of the potential hazard.

Safety Message Example

**WARNING**

Risk of unexpected vehicle movement.

- **Block drive wheels before performing a test with engine running.**

*A moving vehicle can cause injury.*

Important Safety Instructions

For a complete list of safety messages, refer to the accompanying *Important Safety Instructions manual.*

SAVE THESE INSTRUCTIONS
# Contents

||
|---|---|
|**Safety Information**| v|
|**Chapter 1: Using This Manual**| 1|
|Conventions| 1|
|Bold Text| 1|
|Symbols| 1|
|Terminology| 1|
|Notes and Important Messages| 2|
|Procedures| 2|
|Hyperlinks| 2|
|Tool Help| 2|
|**Chapter 2: Introduction**| 3|
|Features and Specifications| 3|
|Diagnostic Tool| 3|
|Scan Module (Wireless)| 7|
|M2 Scope/Meter (Wireless)| 9|
|**Chapter 3: Basic Operation and Navigation**| 11|
|Turning On/Off and Emergency Shutdown| 11|
|Turning On| 11|
|Turning Off| 11|
|Emergency Shutdown| 11|
|Controls and Indicators| 12|
|Control Buttons| 12|
|LED Indicators| 13|
|Basic Navigation| 13|
|Starting the ShopStream Diagnostic Suite Program| 13|
|Home Screen Layout| 14|
|Function Icons| 14|
|Toolbar| 15|
|Windows Toolbar| 17|
|Virtual Keyboard| 18|
|Camera Operation| 20|
|Operating the Camera| 20|
|Viewing Pictures| 21|
|Changing the Units of Measurement| 21|
|Wi-Fi Setup| 22|
|Printing / Printer Setup| 24|
|USB Printer Setup| 25|
|Add Printer Wizard (network printer connection)| 25|
|Default Printer Setting| 25|
|**Chapter 4: Scanner Function**| 26|
|Demonstration Program| 26|
## Contents

- **Vehicle Identification** .................................................. 80
- **Chapter 7: Guided Component Test Operations** ............... 80
- **OBD Diagnose** .............................................................. 75
- **Troubleshooting** ............................................................ 63
- **Chapter 6: OBD Direct Operations** ................................ 72
- **OBD Health Check** .......................................................... 73
- **Updating Scan Module Firmware** .................................... 68
- **Data Cable Connection** .................................................... 62
- **Checking Scan Module Paired Status** ............................... 61
- **Pairing The Scan Module** ............................................... 60
- **Overview** ..................................................................... 59
- **Stopping Communication and Exiting the Scanner** .......... 58
- **Chapter 5: Scan Module Operation** ................................. 59
- **Overview** ..................................................................... 59
- **Pairing The Scan Module** ............................................... 60
- **Checking Scan Module Paired Status** ............................... 61
- **Data Cable Connection** .................................................... 62
- **Troubleshooting** ............................................................ 63
- **No Communication Message** .......................................... 63
- **Signal Loss / Out of Range Alarm** ................................... 63
- **Checking Hardware Status** .............................................. 64
- **Recovery Procedure** ........................................................ 66
- **Updating Scan Module Firmware** .................................... 68
- **Chapter 6: OBD Direct Operations** ................................ 72
- **OBD Health Check** .......................................................... 73
- **Global OBD II Code Check** ............................................. 73
- **Global OBD II Clear Codes** ............................................. 74
- **Readiness Monitors** ......................................................... 74
- **MIL Status** ................................................................... 75
- **OBD Diagnose** .............................................................. 75
- **Start Communication** ....................................................... 75
- **Connector Information** ................................................... 79
- **Manual Protocol Selection** .............................................. 79
- **Chapter 7: Guided Component Test Operations** ............... 80
- **Vehicle Identification** ..................................................... 80
- **Menu Options, Guided Component Test** .......................... 81
- **Creating a Favorites List** ............................................... 81
- **Identifying a Test Vehicle** .............................................. 82
- **Training and Classes** ........................................................ 84
- **Features Benefits** .......................................................... 85
- **Power User Tests** ........................................................... 85
- **How To** ....................................................................... 85
- **Snap-on Automotive Theory** ........................................... 86
- **Operations** ................................................................. 86
- **Component Information** ................................................ 86
- **Tests** ......................................................................... 87
- **Chapter 8: M2 Scope/Meter** ............................................ 91
- **Overview** ..................................................................... 91
# Contents

M2 Scope/Meter Controls, and Features .......................................................... 92
  Rotary Selector Switch ................................................................................ 93
  M2 Scope/Meter Soft Keys ........................................................................ 94
M2 Scope/Meter Operations ................................................................. 95
  Volts DC ................................................................................................. 95
  Volts AC .................................................................................................. 99
  Resistance ............................................................................................... 101
  Continuity and Diode Check .................................................................. 102
  Auxiliary ................................................................................................. 102
  Capacitance ......................................................................................... 104
  Oscilloscope ......................................................................................... 105
M2 Scope/Meter Remote Operation .......................................................... 111
  Remote Functions Setting ................................................................. 111
  Pairing the M2 Scope/Meter ............................................................ 112
  Remote Operation (Once paired) .................................................... 115

## Chapter 9: Scope Multimeter Operations ......................................................... 119

Getting Started ......................................................................................... 119
  Capabilities ......................................................................................... 119
  Leads and Adapters .......................................................................... 120
  Menu Options, Scope Multimeter .................................................. 123
Navigation ................................................................................................. 124
  Screen Layout .................................................................................... 124
  Making Selections ............................................................................ 129
Operations ................................................................................................. 129
  Starting the Scope and Multimeter .................................................. 129
  Measurement Out of Range ......................................................... 131
  Scope and Multimeter Setup .......................................................... 132

## Chapter 10: Repair Information .................................................................. 140

About ShopKey Pro .................................................................................. 140

## Chapter 11: Vehicle History Operations ......................................................... 142

Screen Layout ......................................................................................... 142
  Vehicle History Main Body (Records List) ....................................... 142
  Vehicle History Toolbar ............................................................... 143

## Chapter 12: Data Manager Operations .......................................................... 148

Screen Layout ......................................................................................... 148
Navigation ................................................................................................. 149
Operations ................................................................................................. 150
  My Data ............................................................................................... 150
  Up ........................................................................................................ 150
  Open .................................................................................................... 150
  New ...................................................................................................... 151
  Delete ................................................................................................. 152
  Rename ............................................................................................... 153
  Properties ......................................................................................... 154
  Shortcut ............................................................................................ 154
  Email .................................................................................................. 155
Viewing Saved Files .............................................................................. 160
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShopStream Connect™</td>
<td>160</td>
</tr>
<tr>
<td>Saved File Structure</td>
<td>160</td>
</tr>
<tr>
<td>Scanner DataViewer Operation</td>
<td>161</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>162</td>
</tr>
<tr>
<td>Display Toolbar</td>
<td>165</td>
</tr>
<tr>
<td>Navigation Tools</td>
<td>166</td>
</tr>
<tr>
<td>Customizing the Display</td>
<td>168</td>
</tr>
<tr>
<td>Customizing the Parameter List</td>
<td>169</td>
</tr>
<tr>
<td>Scope Viewer</td>
<td>171</td>
</tr>
<tr>
<td>Image Viewer</td>
<td>172</td>
</tr>
<tr>
<td><strong>Chapter 13: Help Operations</strong></td>
<td>173</td>
</tr>
<tr>
<td>Using the Help Toolbar</td>
<td>173</td>
</tr>
<tr>
<td><strong>Chapter 14: System Settings Operations</strong></td>
<td>174</td>
</tr>
<tr>
<td>Paired Devices</td>
<td>174</td>
</tr>
<tr>
<td>Scan Module Pairing</td>
<td>175</td>
</tr>
<tr>
<td>M2 Scope/Meter Pairing</td>
<td>175</td>
</tr>
<tr>
<td>Shop Information</td>
<td>176</td>
</tr>
<tr>
<td>Code Scan (Timestamp)</td>
<td>177</td>
</tr>
<tr>
<td>Data Backup</td>
<td>178</td>
</tr>
<tr>
<td>Backup Settings (message)</td>
<td>178</td>
</tr>
<tr>
<td>Backup</td>
<td>178</td>
</tr>
<tr>
<td>Restore</td>
<td>180</td>
</tr>
<tr>
<td><strong>Chapter 15: SureTrack</strong></td>
<td>181</td>
</tr>
<tr>
<td>Getting Started Using SureTrack</td>
<td>181</td>
</tr>
<tr>
<td>Using SureTrack in the Scanner Function</td>
<td>182</td>
</tr>
<tr>
<td>Common Replaced Parts Graph</td>
<td>182</td>
</tr>
<tr>
<td>Dashboard Feature Information</td>
<td>183</td>
</tr>
<tr>
<td>SureTrack Status Messages</td>
<td>184</td>
</tr>
<tr>
<td>Using the SureTrack Community (within ShopKey Pro)</td>
<td>185</td>
</tr>
<tr>
<td>Getting Started</td>
<td>185</td>
</tr>
<tr>
<td>Logging In (existing active account)</td>
<td>188</td>
</tr>
<tr>
<td>Logging In (existing expired account)</td>
<td>189</td>
</tr>
<tr>
<td>About Upgrade Reminder Messages</td>
<td>189</td>
</tr>
<tr>
<td><strong>Chapter 16: ShopStream Update Tool (SST)</strong></td>
<td>190</td>
</tr>
<tr>
<td>Basic Operation</td>
<td>190</td>
</tr>
<tr>
<td>End User License Agreement</td>
<td>192</td>
</tr>
<tr>
<td>Manual Software Download</td>
<td>193</td>
</tr>
<tr>
<td>Installing Software Updates</td>
<td>195</td>
</tr>
<tr>
<td>Installing Software Upgrades</td>
<td>197</td>
</tr>
<tr>
<td><strong>Chapter 17: Maintenance</strong></td>
<td>199</td>
</tr>
<tr>
<td>Diagnostic Tool</td>
<td>199</td>
</tr>
<tr>
<td>Cleaning the Touch Screen</td>
<td>199</td>
</tr>
<tr>
<td>Calibrating the Touch Screen</td>
<td>199</td>
</tr>
<tr>
<td>Cleaning and Inspecting the Diagnostic Tool</td>
<td>202</td>
</tr>
<tr>
<td>Battery Service</td>
<td>203</td>
</tr>
</tbody>
</table>
Operating System Restore ........................................................................................................ 206
Scan Module .......................................................................................................................... 206
Cleaning and Inspecting the Scan Module ........................................................................ 206
Replacing the Protective Handgrip .................................................................................... 207
M2 Scope/Meter .................................................................................................................... 207
M2 Scope/Meter Cleaning and Inspecting the M2 Scope/Meter ........................................ 207
Replacing the Battery Pack ............................................................................................... 207
Chapter 1 Using This Manual

This manual contains basic operating instructions and is structured in a manner to help you become familiar with your diagnostic tool features and perform basic operations.

The illustrations in this manual are intended as reference only and may not depict actual screen results, information, functions or standard equipment. Contact your sales representative for availability of other functions and optional equipment.

1.1 Conventions

1.1.1 Bold Text

Bold emphasis is used in procedures to highlight selectable items such as buttons and menu options.

Example:
• Select Functions.

1.1.2 Symbols

The “greater than” arrow (>) indicates an abbreviated set of selection instructions.

Example:
• Select Utilities > Tool Setup > Date.

The above statement abbreviates the following procedure:
1. Select the Utilities icon.
2. Select the Tool Setup submenu.
3. Highlight the Date option from the submenu.

1.1.3 Terminology

The term “select” describes tapping/touching an icon on the touch screen, or highlighting an icon or menu choice and then selecting the confirmation menu choice such as Continue, Accept, OK, Yes, or other similar choice.

Example:
• Select Reset.

The above statement abbreviates the following procedure:
1. Navigate to the Reset icon.
2. Select the Reset icon with your stylus.
1.1.4 Notes and Important Messages

The following messages are used.

**Note**

A note provides helpful information such as additional explanations, tips, and comments.

Example:

**NOTE:**
For additional information refer to...

**Important**

Important indicates a situation which, if not avoided, may result in damage to the test equipment or vehicle.

Example:

**IMPORTANT:**
Disconnecting the USB cable during vehicle communication can cause damage to the ECM.

1.1.5 Procedures

An arrow icon indicates a procedure.

Example:

**To change screen views:**
1. Select **View**.
   - The dropdown menu displays.
2. Select an option from the menu.
   - The screen layout changes to the format you selected.

1.1.6 Hyperlinks

Hyperlinks, or links, that take you to other related articles, procedures, and illustrations are available in electronic documents. Blue colored text indicates a selectable hyperlink.

Example:

**IMPORTANT:**
Read all applicable **Safety Information** before using this tool!

1.1.7 Tool Help

To display help topics for this tool, select a help option from the Help menu.
This chapter introduces the basic features of the Diagnostic Tool, including the control buttons, data ports, battery pack, and power sources. Your Diagnostic Tool is a specialized personal automotive diagnostic solution that combines information with test instrumentation to help you diagnose symptoms, codes, and complaints quickly and efficiently. There are three main components to the system:

- **Diagnostic Tool**—central processor and monitor for the system
- **Scan Module**—wireless device for accessing vehicle data
- **M2 Scope/Meter**—wireless device for sampling circuits and signals

This manual describes the operation of these three devices and how they work together to deliver diagnostic solutions.

### 2.1 Features and Specifications

#### 2.1.1 Diagnostic Tool

1. Audio Speaker
2. Battery Status Indicator LED (light emitting diode)
3. Microphone
4. Hard Drive Activity LED
5. Directional Buttons; left ( ), right ( ), up ( ), down ( )
6. Stylus lanyard anchor post
7. S (Shortcut) Button (special functions)
8. Enter Button
9. Camera (shutter) Button
10. Virtual Keyboard Button
11. Brightness Button
12. Power Button

*Figure 2-1 Model D7 front view*
Introduction Features and Specifications

1— USB (universal serial bus) Ports (2)
2— Head Phone Jack
3— Microphone Jack
4— DC Power Supply Input Jack
5— SD (secure digital) Card Port
6— Mini USB Client Jack

Figure 2-2 Model D7 side views

1— Battery Compartment Cover
2— Kensington Lock (standard security device connection, device not included)
3— Stylus
4— Camera Lens
5— Collapsible Stand (closed)
6— Docking Station Connection (not shown)

Figure 2-3 Model D7 back view
Technical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description / Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Screen</td>
<td>Resistive Touch Panel</td>
</tr>
<tr>
<td>Display</td>
<td>7 inch diagonal, LCD TFT</td>
</tr>
<tr>
<td></td>
<td>1024 x 600 resolution SWVGA, 16 bit color</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Atom</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Embedded Standard SP3</td>
</tr>
<tr>
<td>Communications</td>
<td>802.11 b/g/n Wireless</td>
</tr>
<tr>
<td></td>
<td>Wireless Bluetooth\textsuperscript{\textregistered} 2.0 Technology</td>
</tr>
<tr>
<td>Battery</td>
<td>Lithium Ion Smart Battery Pack</td>
</tr>
<tr>
<td></td>
<td>Approximate 3.5 hour run time</td>
</tr>
<tr>
<td></td>
<td>Approximate 3 hour charge time (unit not operating)</td>
</tr>
<tr>
<td></td>
<td>Approximate 4 hour charge time (with unit operating)</td>
</tr>
<tr>
<td>Power Supply</td>
<td>Supply Rating; 19 VDC, 3.24A</td>
</tr>
<tr>
<td>DC Operating Voltage</td>
<td>10 to 32VDC</td>
</tr>
<tr>
<td>Width</td>
<td>9.9 in. (252 mm)</td>
</tr>
<tr>
<td>Height</td>
<td>6.8 in. (173 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>1.8 in. (46 mm)</td>
</tr>
<tr>
<td>Weight (including battery)</td>
<td>2.9 lb (1.32 kg)</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>At 0 to 90% relative humidity (non-condensing)</td>
</tr>
<tr>
<td>Range (ambient)</td>
<td>32 to 113\degree F (0 to 45\degree C)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>At 0 to 70% relative humidity (non-condensing)</td>
</tr>
<tr>
<td>(ambient)</td>
<td>–4 to 140\degree F (–20 to 60\degree C)</td>
</tr>
<tr>
<td>Operating Altitude</td>
<td>Maximum 2000 m</td>
</tr>
<tr>
<td>Environmental Conditions</td>
<td>This product is intended for indoor use only</td>
</tr>
<tr>
<td></td>
<td>This product is rated for Pollution Degree 2 (normal conditions)</td>
</tr>
</tbody>
</table>

Built-in Stand

The built-in stand extends from the back of the Diagnostic Tool to allow hands-free viewing. The stand clips into the Diagnostic Tool for storage and pivots out so the display is at a 35 degree angle when in use.

Power Sources

Your Diagnostic Tool can receive power from any of the following sources:

- Internal Battery Pack
- AC Power Supply
- Vehicle Power
- Docking Station
**Internal Battery Pack**

The Diagnostic Tool can be powered from the internal rechargeable battery pack. A fully charged standard battery pack provides sufficient power for about 4 hours of continuous operation. A LED on the front of the Diagnostic Tool indicates the battery charge state.

**AC Power Supply**

The Diagnostic Tool can be powered from a standard AC outlet using the AC power supply. When connected to the Diagnostic Tool, the AC power supply also recharges the internal rechargeable battery pack.

**Vehicle Power**

The Diagnostic Tool can be powered from a standard 12VDC vehicle power port using the Diagnostic Tool DC power port adapter. The DC power port adapter connects to the DC power supply jack on the left side of the Diagnostic Tool.

**Docking Station (Optional)**

The Diagnostic Tool can be powered (when connected) by the optional docking station. When connected to the docking station, the internal rechargeable battery pack is recharged. Contact your sales representative for additional details.
2.1.2 Scan Module (Wireless)

1— Data cable connector
2— Memory card port (remove protective hand grip for access)
3— Bluetooth LED (green)
4— Communication issue LED (red)
5— Vehicle power LED (green)
6— Universal serial bus (USB) jack (remove protective hand grip for access)

Wireless Communication

The Scan Module is a wireless communications device that transmits vehicle data to the Diagnostic Tool without a physical connection. A signal lost due to moving out of range automatically restores itself when the Diagnostic Tool is brought closer to the Scan Module. The Scanner sounds a tone when the signal is lost.
Technical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description / Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications</td>
<td>Wireless Bluetooth® 2.0 Technology</td>
</tr>
<tr>
<td>USB Power</td>
<td>5V @ 500mA</td>
</tr>
<tr>
<td>Data Cable Connector Power</td>
<td>8V to 32V, Maximum 12 Watts</td>
</tr>
<tr>
<td>Width</td>
<td>8.04 in. (204.3 mm)</td>
</tr>
<tr>
<td>Height</td>
<td>3.82 in. (97 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>1.66 in. (42.1 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>0.9 lb (0.408 kg)</td>
</tr>
<tr>
<td>Operating Temperature Range (ambient)</td>
<td>At 0 to 90% relative humidity (non-condensing) 32 to 113°F (0 to 45°C)</td>
</tr>
<tr>
<td>Storage Temperature (ambient)</td>
<td>At 0 to 70% relative humidity (non-condensing) –4 to 140°F (–20 to 60°C)</td>
</tr>
<tr>
<td>Operating Altitude</td>
<td>Maximum 2000 m</td>
</tr>
<tr>
<td>Environmental Conditions</td>
<td>This product is intended for indoor use only</td>
</tr>
<tr>
<td></td>
<td>This product is rated for Pollution Degree 2 (normal conditions)</td>
</tr>
</tbody>
</table>

Power Sources

The Scan Module operates on 12V or 24V vehicle power, which it receives through the data cable connector. The Scan Module powers on whenever it is connected to an OBD-II/EOBD compliant data link connector (DLC). For non OBD-II/EOBD compliant vehicles, the Scan Module can be powered from a suitable power port on the test vehicle using the auxiliary power cable supplied with your kit.
2.1.3 M2 Scope/Meter (Wireless)

M2 Scope/Meter Wireless Communication

The M2 Scope/Meter is a digital graphing multimeter and wireless communications device. The unit can be used as a stand-alone meter, or configured to transmit data to the D7 Diagnostic Tool without a physical connection. The working range of the transmitter is about 30 feet (9.14 m). A signal lost due to moving out of range automatically restores itself when the Diagnostic Tool is brought closer to the M2 Scope/Meter. The M2 Scope/Meter sounds a tone and the Diagnostic Tool shows a warning message when the signal is lost.

1— DC Power Supply Input Jack
2— Color Graphic Display Screen
3— Soft Keys for Selecting Additional Functions
4— Rotary Switch for Selecting Primary Functions
5— Common (Ground) Lead Input Jack
6— Channel 1 (Red) Lead Input Jack
7— Channel 2 (Green) Lead Input Jack

Figure 2-5 Model M2 Scope/Meter
Introduction

Features and Specifications

Technical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description / Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Color graphical display</td>
</tr>
<tr>
<td>Battery Pack</td>
<td>4 1.2V Ni-Mh (nickel-metal hydride)</td>
</tr>
<tr>
<td>Width</td>
<td>9.125 in. (231.8 mm)</td>
</tr>
<tr>
<td>Height</td>
<td>4.25 in. (107.9 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>2.00 in. (50.8 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>1.9 lb (0.86 kg)</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>At 0 to 90% relative humidity (non-condensing)</td>
</tr>
<tr>
<td>Range (ambient)</td>
<td>32 to 113°F (0 to 45°C)</td>
</tr>
<tr>
<td>Storage Temperature Range</td>
<td>At 0 to 70% relative humidity (non-condensing)</td>
</tr>
<tr>
<td>(ambient)</td>
<td>–4 to 140°F (–20 to 60°C)</td>
</tr>
<tr>
<td>Operating Altitude</td>
<td>Maximum 2000 m</td>
</tr>
<tr>
<td>Environmental Conditions</td>
<td>This product is intended for indoor use only</td>
</tr>
<tr>
<td></td>
<td>This product is rated for Pollution Degree 2 (normal conditions)</td>
</tr>
<tr>
<td>Agency Approvals</td>
<td>IEC 61010-1 Over Voltage</td>
</tr>
<tr>
<td></td>
<td>CAT III—1000 VAC/DC</td>
</tr>
<tr>
<td></td>
<td>CAT IV—600 VAC/DC</td>
</tr>
<tr>
<td></td>
<td>Pollution Degree 2</td>
</tr>
<tr>
<td>UL Listed 61010-1</td>
<td>CAT II 750 VAC, 1000 VDC</td>
</tr>
<tr>
<td></td>
<td>CAT III 600 VAC/DC</td>
</tr>
</tbody>
</table>

Power Sources

The M2 Scope/Meter comes with a rechargeable battery pack, which is already installed in the unit. Simply turn on the unit and observe the battery icon on the display to determine the battery pack state of charge. Use the AC Power Supply (included) to recharge the battery pack, or to power the unit if the battery pack charge is low.

Internal Battery Pack

The M2 Scope/Meter is powered it’s internal rechargeable battery. An icon in the upper right-hand corner of the display screen indicates the battery state of charge.

AC Power Supply

An AC Power Supply for charging the internal battery of the M2 Scope/Meter is also provided. The power supply connector that inserts into the M2 Scope/Meter is longer than the power supply connector that is used for the Diagnostic Tool.
Chapter 3 Basic Operation and Navigation

This chapter describes the basic operation, controls and navigation of the Diagnostic Tool.

3.1 Turning On/Off and Emergency Shutdown

The following sections describe how to turn the Diagnostic Tool on and off and how to perform an emergency shutdown.

Before using the Diagnostic Tool, make sure the battery is fully charged or is connected to an AC power supply. see Power Sources on page 5.

3.1.1 Turning On

Press the Diagnostic Tool Power button to switch the Diagnostic Tool on. The system boots up, then opens the Home screen (Figure 3-2).

3.1.2 Turning Off

All vehicle communication must be terminated before shutting down the Diagnostic Tool. A warning message displays if you attempt to shut down while the Scan Module is communicating with a vehicle. Forcing a shut down while communicating may lead to ECM problems on some vehicles. Exit the Scan Module before turning off.

Before turning the Diagnostic Tool off, it is highly recommended to back up personal and saved data to a USB mass storage device on a regular basis to prevent loss in the event of system corruption or hard disk drive failure.

To turn off the Diagnostic Tool:
1. Navigate to the Home screen.
2. Select the Exit icon.
3. From the Windows desktop, open the Windows Start menu.
4. Select Turn Off Computer.
5. Select Turn Off in the dialog box.
   The open programs close and the power turns off.

3.1.3 Emergency Shutdown

In case of emergency, press and hold the Power button for 5 seconds to force a shutdown.
3.2 Controls and Indicators

The external controls on the Diagnostic Tool are simple because most operations are controlled through the touch screen. Touch screen navigation is menu driven, which allows you to quickly locate the test, procedure, or data that you need through a series of choices and questions. Detailed descriptions of the menu structures are found in the chapters for the various modules.

The following sections describe the external controls and features of the Diagnostic Tool.

3.2.1 Control Buttons

Name and location of control buttons:

<table>
<thead>
<tr>
<th>Name</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S (Shortcut) Button</td>
<td>![S button]</td>
<td>A function button that provides a shortcut for capturing a screen image.</td>
</tr>
<tr>
<td>Directional Buttons</td>
<td>![Directional buttons]</td>
<td>Moves the cursor or highlight on the display screen up, down, right, or left.</td>
</tr>
<tr>
<td>Enter Button</td>
<td>![Enter button]</td>
<td>Selects a highlighted item or returns the display to the previous screen.</td>
</tr>
<tr>
<td>Camera Button</td>
<td>![Camera button]</td>
<td>Operates the built-in camera. Press once to open the application. The button then acts as a shutter to take a photograph of what is visible on the screen. See Camera Operation on page 20.</td>
</tr>
<tr>
<td>Keyboard Button</td>
<td>![Keyboard button]</td>
<td>Opens or closes the virtual keyboard.</td>
</tr>
<tr>
<td>Brightness Button</td>
<td>![Brightness button]</td>
<td>Increases the screen backlighting in seven incremental steps, then returns to the lowest setting and repeats.</td>
</tr>
<tr>
<td>Power Button</td>
<td>![Power button]</td>
<td>Turns the Diagnostic Tool on and off.</td>
</tr>
</tbody>
</table>

All other tool operations are controlled through the touch screen.
3.2.2 LED Indicators

There are two light-emitting diodes (LEDs) on the front face of the Diagnostic Tool (see Figure 2-1 on page 3 for locations):

- Battery Status Indicator LED—this Diagnostic Tool uses three colors to show the battery and power status as follows:
  - Green indicates either a battery with a full or nearly full charge, or the Diagnostic Tool is being powered by the AC Power Supply.
  - Orange indicates a battery that is charging. An orange LED that fades on and off at three second intervals indicates the Diagnostic Tool is in Standby mode.
  - Red indicates a low battery (15% of capacity or less).
- Hard Drive Activity LED—illuminates when the central processing unit (CPU) is reading or writing to the hard disk drive (HDD).

3.3 Basic Navigation

3.3.1 Starting the ShopStream Diagnostic Suite Program

The ShopStream Diagnostic Suite program is automatically started when the Diagnostic Tool is turned on through the Windows “start up” folder function. After the program has started, the ShopStream Diagnostic Suite Home Screen displays, see Home Screen Layout on page 14. The application runs as a normal Windows program and it’s window can be minimized, resized and closed like any other Windows program. To access the Windows desktop, minimize the program window.

If the program is exited or closed, select the ShopStream Diagnostic Suite icon from the Windows desktop to start the program.

![ShopStream Diagnostic Suite desktop icon]

**Figure 3-1 ShopStream Diagnostic Suite desktop icon**

---

**NOTE:**
The ShopStream Diagnostic Suite can also be started from the Windows Start menu.
3.3.2 Home Screen Layout

The Home screen includes the diagnostic suite toolbar and the Windows toolbar. The Home screen includes function icons, one for each of the primary Diagnostic Tool functions.

![Sample Home screen](image)

1. Function Icons
2. Toolbar
3. Windows Toolbar

**Figure 3-2 Sample Home screen**

3.3.3 Function Icons

The Function icons configure the Diagnostic Tool for the type of test to be performed. Table 3-2 gives brief descriptions of the available Function icons, which operations are available depends upon the individual configuration of your VERDICT system.

Use the stylus or your finger tip to select from the Function icons.

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner</td>
<td><img src="image" alt="Icon" /></td>
<td>Configures the Diagnostic Tool to operate as a scan tool. See Scanner Function on page 26.</td>
</tr>
<tr>
<td>OBD Direct</td>
<td><img src="image" alt="Icon" /></td>
<td>Allows you to perform generic OBD-II or EOBD system tests without identifying the specific vehicle. See OBD Direct Operations on page 72.</td>
</tr>
<tr>
<td>Guided Component Test</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a diagnostic database of specific tests for the identified vehicle. See Guided Component Test Operations on page 80.</td>
</tr>
</tbody>
</table>

Table 3-2 (sheet 1 of 2)
Table 3-2  (sheet 2 of 2)

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope Multimeter</td>
<td>![Icon]</td>
<td>Configures the Diagnostic Tool to operate as a lab scope, graphing multimeter, or digital multimeter. See Scope Multimeter Operations on page 118.</td>
</tr>
<tr>
<td>Repair Information</td>
<td>![Icon]</td>
<td>Provides the information needed to make repairs once you have made your diagnosis. The linked program varies by region. See Repair Information on page 140.</td>
</tr>
<tr>
<td>Vehicle History</td>
<td>![Icon]</td>
<td>Identifies the test vehicle and organizes and manages work in progress and service records. See Vehicle History Operations on page 142.</td>
</tr>
<tr>
<td>Data Manager</td>
<td>![Icon]</td>
<td>Opens the organization system for saved data files. See Data Manager Operations on page 148.</td>
</tr>
<tr>
<td>Help</td>
<td>![Icon]</td>
<td>Opens the on-line help for the system. See Help Operations on page 173.</td>
</tr>
<tr>
<td>System Settings</td>
<td>![Icon]</td>
<td>Establishes and manages wireless connections to peripheral devices, such as the Scan Module and the M2 Scope/Meter. See System Settings Operations on page 174.</td>
</tr>
<tr>
<td>Exit</td>
<td>![Icon]</td>
<td>Closes the VERDICT Diagnostic Tool software and returns the display to the Windows desktop.</td>
</tr>
</tbody>
</table>

3.3.4 Toolbar

Operation of the icons located on the toolbar are described in the table below:

Table 3-3  (sheet 1 of 2)

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>![Icon]</td>
<td>Selecting this icon returns you to the Home screen from any test.</td>
</tr>
<tr>
<td>Desktop</td>
<td>![Icon]</td>
<td>Selecting this icon opens and closes the standard Windows toolbars at the top and bottom of the screen, which allow you access to the Windows desktop.</td>
</tr>
<tr>
<td>Menu</td>
<td>![Icon]</td>
<td>Selecting this icon opens a menu that provides information and basic operations and features for the current screen.</td>
</tr>
</tbody>
</table>
Menu Options

The Menu icon on the Toolbar at the base of the display screen opens a list of basic operations and features. The list of options varies depending upon which module, or tool function, is active. Selecting a menu item opens a submenu of choices, and some submenus also open an additional menu. A right arrowhead ( › ) indicates additional choices are available. Touch an item to select it. The following Menu options are available from the Home Screen:

- Safety Information—opens the *Important Safety Instructions* document.
- Help—allows you to view supporting documentation, selecting opens a submenu.

Safety Information

Selecting Safety Information opens a PDF copy of the *Important Safety Instructions* that are included in your Diagnostic Tool kit. The *Important Safety Instructions* document should be read and understood prior to using the Diagnostic Tool.

Help

A variety of utilities and additional resources are available through the Help menu. Basic menu options, which are available for all modules, include:

- User Manuals
- Version Info
- Activation Status

User Manual

This option opens this document, which provides overall navigation and operation information for the Diagnostic Tool.

Version Info

This option opens a window showing the version of the software and a copy of the Software License Agreement. Select OK to close the window.
Activation Status
This option opens a dialog box with version and licensing details for the system, and activation status for the Diagnostic Tool and all other modules.

3.3.5 Windows Toolbar
This is the standard Windows toolbar. Your Diagnostic Tool is a fully functional personal computer based on the Windows Embedded Standard operating system. Refer to Microsoft documentation for additional information.

Windows System Tray ShopStream Diagnostic Suite Programs
The Windows system tray may contain standard Windows application icons (e.g. Wireless Network Connection Status, Audio volume, etc) and specialized application icons designed for use only on this Diagnostic Tool (e.g. ShopStream Update Tool and Virtual Keyboard). Refer to Microsoft software documentation for additional information on the standard Windows applications. For additional information on the ShopStream Update Tool and Virtual Keyboard, see:

ShopStream Update Tool - ShopStream Update Tool (SST) on page 190
Virtual Keyboard - Virtual Keyboard on page 18
3.4 Virtual Keyboard

The Virtual Keyboard allows you to type characters and key in information to complete form and data entry fields, similar to a physical keyboard.

The Virtual Keyboard is normally running in the Windows background and can be opened by pressing the Virtual Keyboard button on the Diagnostic Tool. The program can be accessed as follows:

- **Virtual Keyboard button on the Diagnostic Tool control panel** - opens the Virtual Keyboard
- **Virtual Keyboard icon in the Windows system tray** - opens the Virtual Keyboard menu
  
  Menu options include:
  
  - **Hide Virtual Keyboard** - minimizes the keyboard
  - **Close Virtual Keyboard** - closes the Virtual Keyboard program
  - **Show Virtual Keyboard** - displays the keyboard
  - **Settings** - opens the Virtual Keyboard settings window (Figure 3-5)
  - **About** - displays the Virtual Keyboard program software version number

- **Virtual Keyboard program selection from the Windows “All Programs” or “Startup” menus** - starts the Virtual Keyboard program and adds the Virtual Keyboard icon to the Windows system tray

**NOTE:**

As an alternative, you can connect a USB keyboard to the Diagnostic Tool and use it to key in information.

---

**Figure 3-3 Virtual Keyboard button and system tray icon**
1. **Settings icon** - opens the Virtual Keyboard settings window (Figure 3-5)
2. **Expand icon** - expands the Virtual Keyboard to full display (press again to return to standard display)
3. **Top** - moves the keyboard to top of screen
4. **Close** - closes the keyboard
5. **Bottom** - moves the keyboard to bottom of screen

**NOTE:**
The Virtual Keyboard can be set to open automatically, when a data field or form is selected in certain applications. See the Settings window (Figure 3-5) for selection options.

---

**Figure 3-4 Virtual Keyboard (shown expanded)**

---

**Figure 3-5 Virtual Keyboard settings window**
3.5 Camera Operation

3.5.1 Operating the Camera

A single press of the Camera button on the front of the Diagnostic Tool activates the camera. With the camera active, the touch screen becomes the view finder and is also used for reviewing photographs that are taken. Icons on the touch screen are used to operate the camera. The icons change depending on which camera function is active:

**Table 3-4 Camera icons (sheet 1 of 2)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo</td>
<td><img src="image" alt="Photo Icon" /></td>
<td>Acts as a shutter to take a photograph of what is visible in the view finder, which is the left-hand portion of the screen.</td>
</tr>
<tr>
<td>Gallery</td>
<td><img src="image" alt="Gallery Icon" /></td>
<td>Opens a thumbnail gallery of recently taken pictures.</td>
</tr>
<tr>
<td>Exit</td>
<td><img src="image" alt="Exit Icon" /></td>
<td>Closes the camera application and returns to the previous screen.</td>
</tr>
<tr>
<td>OK</td>
<td><img src="image" alt="OK Icon" /></td>
<td>Displays after a picture is taken. Selecting saves the photograph and returns to the view finder.</td>
</tr>
<tr>
<td>Delete</td>
<td><img src="image" alt="Delete Icon" /></td>
<td>Displays after a picture is taken and in Gallery mode. Selecting discards the photograph and returns to the previous screen.</td>
</tr>
<tr>
<td>Back</td>
<td><img src="image" alt="Back Icon" /></td>
<td>Displays in Gallery mode. Selecting returns to the previously viewed screen.</td>
</tr>
</tbody>
</table>
### Table 3-4 Camera icons (sheet 2 of 2)

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td><img src="image" alt="Previous icon" /></td>
<td>Displays in Gallery mode. Selecting opens the picture prior to the current image in the gallery.</td>
</tr>
<tr>
<td>Next</td>
<td><img src="image" alt="Next icon" /></td>
<td>Displays in Gallery mode. Selecting opens the picture after the current image in the gallery.</td>
</tr>
</tbody>
</table>

**Taking pictures:**
1. Press the **Camera** button.
   - The camera screen opens and the **Camera** button now controls the shutter.
2. Focus the image to be captured in the view finder.
3. Press the **Camera** button, or select the **Photo** icon.
   - The view finder now shows the captured picture.
4. Select **OK** to save the image, or **Delete** to delete it.
   - The view finder is live and the Camera button is the shutter, repeat steps 2, 3, and 4 to take additional pictures.
5. Select **Exit** from the live view to close the camera application.

### 3.5.2 Viewing Pictures

Photographs are stored on the hard drive and can be retrieved two ways:

- From the Diagnostic Suite; select **Data Manager** from the Home screen, then open the **Camera Folder**.
- From the desktop; select **My Documents > ShopStream > Camera Folder**.

### 3.6 Changing the Units of Measurement

The Diagnostic Suite units of measurement can be changed for temperature, vehicle speed, air pressure and other pressure readings. Choose between US customary or metric units of measure.

**To change the units of measurement:**
1. Select **Scanner**.
2. Select the **Menu** icon from the lower toolbar.
3. Select **Tools > Units Setup**.
The Units setup dialog box opens.

4. Use the dropdown menus to select the desired value for each item.
5. Select **Accept** to close the dialog box and apply the changes.

### 3.7 Wi-Fi Setup

The diagnostic tool uses Windows® XP embedded system software. Wi-Fi connection is controlled through the Windows operating system.

The Wi-Fi connection instructions shown here are intended for quick reference only. For Wi-Fi related instructions / troubleshooting that are outside the scope of these instructions, visit Windows online support.

Wi-Fi connection allows you to:

- Access the Internet using the Windows web browser.
- Use built-in ShopStream Diagnostic Suite Repair Information applications (e.g. SureTrack®, etc). **Note:** Repair Information applications are not available on all models, are optional and vary by model.
- Receive diagnostic software updates
- Receive important product messages.
Connecting to Wi-Fi

NOTE:
Whenever the diagnostic tool is turned on, Wi-Fi will automatically try to connect to a network.

1. Turn on the diagnostic tool and allow Windows to bootup, then allow the ShopStream Diagnostic Suite software to open.

After bootup if Wi-Fi is not automatically connected you may notice a pop-up message at the System Tray (lower right side). This message indicates Wi-Fi is not connected (shown below). The Wi-Fi icon in the System Tray will also display a red “X” (shown below).

2. To connect to a network, click the pop-up message, or the Wi-Fi icon in the System Tray. The wireless network connection window opens (shown below).

3. Choose your Wireless Network from the list of available networks, then select Connect.

NOTE:
A password is required when choosing a protected network.

A wireless network connection progress window displays as the connection is being made.
4. After the connection is successfully made, close the network connection window. Notice the Wi-Fi icon in the System Tray will display as Connected (shown below).

The diagnostic tool is now connected to the Wi-Fi network.

NOTE:
Wi-Fi performance varies depending on your wireless network equipment and ISP.

3.8 Printing / Printer Setup

Selecting Print opens a standard Windows Print dialog box.

To print, a printer must installed and set as the system default printer.

NOTE:
The factory default printer setting is (.XPS file format). From the standard Windows print dialog box, you can name the file and specify the location that it is saved to. The file can then be viewed onscreen using the Windows XPS Viewer.

The following is intended as a basic printer setup instruction only. Printer setup will vary. For specific instructions and details, refer to your printer setup information and the online Windows printer setup help information.
3.8.1 USB Printer Setup
1. Turn the printer on.
2. Connect the USB cable from the printer to the diagnostic tool.
3. Windows should automatically detect and install the printer.
4. Follow the onscreen instructions to install the printer and then set the printer as the default printer. See Default Printer Setting on page 25.

If the printer driver files are not automatically installed, you will have to manually install the printer driver files. Printer driver files may be supplied with the printer (e.g. CD or memory stick), or check the printer manufacturer’s website to download the files. Follow the manufacturer’s instructions for driver installation.

3.8.2 Add Printer Wizard (network printer connection)

NOTE:
Use this procedure if you not directly connecting the printer with a USB cable to the diagnostic tool.

1. Turn the printer on.
2. Select Start from the Windows desktop.
3. Select Printers and Faxes from the systems menu (right side).
4. Select Add Printer.

The Add Printer Wizard opens.
5. Follow the onscreen instructions to install the printer and then set the printer as the default printer. See Default Printer Setting on page 25.

If the printer driver files are not automatically installed, you will have to manually install the printer driver files. Printer driver files may be supplied with the printer (e.g. CD or memory stick), or check the printer manufacturer’s website to download the files. Follow the manufacturer’s instructions for driver installation.

3.8.3 Default Printer Setting
To set a default system printer:
1. Select Start from the Windows desktop.
2. Select Printers and Faxes from the systems menu (right side).
3. Select (double-click) the printer you want to set as the default printer from the list of installed printers.

The printer status window opens.
4. Select Printer from the toolbar menu.
5. From the menu, select “Set as default printer”. When set, a check mark is displayed next to the option.
6. Close the printer status window.
Chapter 4 Scanner Function

The Scanner function allows your Diagnostic Tool to communicate with the electronic control modules (ECMs) of the vehicle being serviced. This allows you to perform tests, view diagnostic trouble codes (DTCs), and view live data parameters from various vehicle systems such as the engine, transmission, antilock brake system (ABS) and more.

This section includes information and instructions on the following topics:

- **Demonstration Program** - learn the basics, using the built-in demonstration program
- **Basic Operation and Navigation** - become familiar with Scanner icons and menu navigation
- **Scanner Operation** - follow along with step-by-step basic vehicle scanning operations
- **Stopping Communication and Exiting the Scanner** - review important Scanner exiting procedures

### 4.1 Demonstration Program

A Scanner demonstration program is provided to help you to become familiar with Scanner operations, without connecting to a vehicle. Sample data and test results are provided to help you learn the menus and basic operations.

**IMPORTANT:**
Do not connect the Scan Module to a vehicle while using the Demonstration mode.

**Using the demonstration program:**

1. From the Home screen, select the **Scanner** icon to open the manufacturer menu.

The manufacturer menu includes all makes for which Scanner information is available. There is also a Demonstration icon included in the list.

![Sample demonstration selection](image)

*Figure 4-1 Sample demonstration selection*
2. Select the **Demonstration** icon.

A menu of demonstration choices now displays:
- US Domestic—contains actual vehicle data
- OBD Training Mode—provides simulated data for an OBD-II/EOBD vehicle that allows you to access any of the standard functions.

3. Select either option and a confirmation message displays.

4. Select **OK** to load the selected database.

5. Follow the on-screen instructions and select as needed until the Systems menu displays.

6. Select from any of the systems listed, then select from the submenus.

### 4.2 Basic Operation and Navigation

This section describes the basic menus, controls and navigation of the Scanner function and select scanner tests.

#### 4.2.1 Screen Messages

Screen messages appear when additional input is needed before proceeding. There are three types of on-screen messages; confirmations, warnings, and errors.

- **Confirmation Messages** - Confirmation messages inform you when you are about to perform an action that cannot be reversed or when an action has been initiated and your confirmation is needed to continue. When a user-response is not required to continue, the message displays briefly before automatically disappearing.

- **Warning Messages** - Warning messages inform you when completing the selected action may result in an irreversible change or loss of data.

- **Error Messages** - Error messages inform you when a system or procedural error has occurred. Examples of possible errors include a disconnected cable or a peripheral, such as a printer, is powered off.

#### 4.2.2 Making Selections

The Scanner interface is a menu driven program that presents a series of choices one at a time. As you select from a menu, the next menu in the series displays. Each selection narrows the focus and leads to the desired test. Use your fingertip or the stylus to make menu selections.
4.2.3 Scanner Screen Layout

The Scanner screens typically include three sections (Figure 4-2):

1. Scanner Toolbar
2. Main Body
3. Lower Toolbar

![Scanner Screen Layout](image)

**Figure 4-2 Scanner screen layout**

**Scanner Toolbar**

The Scanner toolbar contains a number of icons that allow you to configure the displayed data and to exit. The table below provides a brief explanation of the Scanner toolbar icon operations:

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td><img src="image" alt="Exit Icon" /></td>
<td>Closes the current test and returns you to the menu.</td>
</tr>
<tr>
<td>Back</td>
<td><img src="image" alt="Back Icon" /></td>
<td>When available, returns to the previously viewed screen.</td>
</tr>
<tr>
<td>Custom</td>
<td><img src="image" alt="Custom Icon" /></td>
<td>Allows you to select which parameters are displayed on the screen.</td>
</tr>
<tr>
<td>Alarms</td>
<td><img src="image" alt="Alarms Icon" /></td>
<td>Allows you to set an alarm on certain data parameters when the signal goes above or below the alarm setting.</td>
</tr>
<tr>
<td>Properties</td>
<td><img src="image" alt="Properties Icon" /></td>
<td>Allows you to adjust the display characteristics for all of the data screens.</td>
</tr>
<tr>
<td>Graph View</td>
<td><img src="image" alt="Graph View Icon" /></td>
<td>Allows you to simultaneously view up to 16 data graphs at a time.</td>
</tr>
</tbody>
</table>
The Scanner toolbar is used to configure certain aspects of the displayed data and to exit. The following sections explain how to use the toolbar.

### Custom

The **Custom** icon on the Scanner Toolbar is used to determine which specific parameters display. Minimizing the number of parameters on the data list allows you to focus on any suspicious or symptom-specific data parameters. You can add or remove most parameters from the list. Any parameter that has a lock icon next to it cannot be removed from the list.

**IMPORTANT:**

Limiting the number of parameters that display allows for a faster refresh rate of the data. A smaller data lists also reduces the amount of memory used for saved files.

#### To create a custom data list:

1. Select **Custom** on the Scanner Toolbar.
   
   The parameter selection dialog box with all of the parameters selected opens (**Figure 4-3**).

2. Select the **Deselect All** icon to clear the highlights from the screen.

3. Create a custom data list by selecting the parameters to be included. Highlighting indicates a parameter that displays, parameters that are not highlighted do not display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td><img src="image" alt="Save Icon" /></td>
<td>Saves a copy of the current frame of data that can be viewed using Data Manager.</td>
</tr>
<tr>
<td>Print</td>
<td><img src="image" alt="Print Icon" /></td>
<td>Opens a standard Windows Print dialog box for saving a print copy of the current frame of data. See Printing / Printer Setup on page 24.</td>
</tr>
<tr>
<td>More</td>
<td><img src="image" alt="More Icon" /></td>
<td>Opens a dropdown menu of the additional options shown below.</td>
</tr>
<tr>
<td>Scale</td>
<td><img src="image" alt="Scale Icon" /></td>
<td>Switches the scale values, displayed along the left-hand side of the graphs, on and off.</td>
</tr>
<tr>
<td>Sweep</td>
<td><img src="image" alt="Sweep Icon" /></td>
<td>Switches the sweep values, displayed at the base of the graphs, on and off.</td>
</tr>
</tbody>
</table>
Keep the following in mind when configuring a custom data list:

- Gesture scroll if the list of parameters is longer than what is shown on the screen.
- Use the Select All icon to display the complete list.
- Use the Deselect All icon to remove all the currently selected parameters from the list.
- Select individual parameters to highlight and include them in the list.
- Select individual highlighted parameters to remove them from the list.
- Use the Cancel icon to return to the data display.

4. Once all desired parameters have been selected, return to the data list:
   - Use the List View icon to return to a data screen in PID List format.
   - Use the Graph View icon to return to a data screen in Graph View format, see Graph View on page 32 for details.

**NOTE:**

Graph View is only available when 16 or fewer parameters (the number that can display on a single screen) were selected for the custom list. Make sure that no more than 16 parameters are highlighted if the screen displays a single graph when the Graph View icon is selected.

**Alarms**

Alarms are visual indicators alongside a parameter in the data display list that change color to show the signal status. A green alarm indicates on, a gray alarm indicates off. Only digital parameters, those with a range limited to two states, can have alarms. Parameters with continuous ranges, such as variable voltage and pressure values, cannot have alarms. The alarm indicator assignments remain as selected until you exit the data list.

**To configure alarm settings:**

1. Select the Alarms icon on the Scanner Toolbar.
   The Alarm List dialog box opens.
2. Check the parameters that you want to show alarms.
3. Select Save.
Alarm indicators now appear next to the selected parameters in the Data List (Figure 4-4).

Figure 4-4 Sample alarm indicators

NOTE:
Alarms can only be set for certain parameters. If the Alarm List dialog box is empty, no parameters are available and alarms cannot be set.

Properties
The Properties icon on the Scanner Toolbar is used to configure certain characteristics of the parameter graph display. Selecting opens a Properties dialog box that allows you to adjust colors, settings, and sweep (Figure 4-5).

Figure 4-5 Sample properties dialog box
Selecting either color option, **Edit Plot Color** or **Edit Background Color** opens a standard color selection dialog box. Select a color, then select **OK** to close the dialog box.

The Show Grid icon is used to switch a background grid pattern on the data graphs on and off:

- To switch the grid on; select to highlight **Show Grid**, then select **Accept**.
- To switch the grid off; select **Show Grid** twice so it is not highlighted, then select **Accept**.

The Samples After Trigger setting determines how many data samples are recorded following a triggering event. The highlighted samples icon indicates the number of frames that are included in the recording after a triggering event.

The sweep options let you choose the amount of data that displays across the graph. Values are in sample points, or frames of data. A frame of data equals one complete transmission of the serial data by the electronic control module.

**Graph View**

Graph View allows you to simultaneously display up to 16 parameter graphs (Figure 4-6). The graphs must first be opened in the data list in order to be included when **Graph View** is selected from the toolbar. The display defaults to a single graph if more than 16 graphs are open when the toolbar icon is selected. Should this happen, return to the data list and close some of the graphs.

A toolbar in Graph View allows you switch scale and sweep values on and off, and to return to the List View. The Data Buffer toolbar at the base of the screen remains active.

**NOTE:**
The screen does not scroll in Graph View mode, it adjusts to show only the selected parameters.

![Graph View](image)

**Figure 4-6 Sample Graph View screen**

Graph View mode can also be engaged from the custom data list configuration screen. Refer to **Custom** on page 29 for details.
Save

The **Save** icon is used to record movies of vehicle datastream values. Saved files can be helpful when trying to isolate an intermittent problem or to verify a repair during a road test.

**To save a movie:**

- Select **Save**.

  A save movie dialog box displays while data is being saved. The movie is saved when the message box disappears.

![Sample save dialog box](image)

**Figure 4-7 Sample save dialog box**

To open saved Scanner data files, from the Home screen select **Data Manager > Scanner Data Folder**, see **Scanner DataViewer Operation** on page 161.

Print

Selecting **Print** from the toolbar opens a standard Windows Print dialog box. See **Printing / Printer Setup** on page 24.

---

**NOTE:**

Saved print files cannot be viewed using the Data Manager, they can only be opened into an internet browser.

---

**To open a saved print file:**

1. Minimize the Diagnostic Suite to view the desktop.
2. From the desktop select **My Documents > ShopStream > Scanner Data Folder**.
3. Locate the file you wish to view.
4. Double select the file to open it.
   - The internet browser and file open.
**More**

Whenever the More icon appears on the toolbar it indicates that there are additional options available. Selecting the More icon from the Scanner toolbar opens a dropdown menu that offers two choices that only apply to data graphs:

- Scale
- Sweep

**Scale**

The Scale option switches the scale values, displayed along the left-hand side of the data graphs, on and off (Figure 4-8). The dropdown menu closes once a selection is made.

![Figure 4-8 Sample data graph scales](image)

**Sweep**

The Sweep option switches the sweep values, displayed below the data graphs, on and off (Figure 4-9). The dropdown menu closes once a selection is made.
Main Body

The main body of the screen varies depending on the stage of operation. The main body can show vehicle identification selections, the main menu, test data, instructions, troubleshooting information, controls, and other diagnostic information.
Lower Toolbar

Whenever communication is established with a vehicle, the Scanner continuously records data transmitted by the ECM in the data buffer. The toolbar below the main body of the screen contains the icons for navigating the buffered data and other options (Table 4-2).

Table 4-2  Data buffer toolbar icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot</td>
<td><img src="image" alt="Snapshot Icon" /></td>
<td>Arms the software to take a snapshot of vehicle data</td>
</tr>
<tr>
<td>Go To Start</td>
<td><img src="image" alt="Go To Start Icon" /></td>
<td>Moves to the first frame in the data buffer</td>
</tr>
<tr>
<td>Pause</td>
<td><img src="image" alt="Pause Icon" /></td>
<td>Suspends data capture and changes to show the Play icon</td>
</tr>
<tr>
<td>Play</td>
<td><img src="image" alt="Play Icon" /></td>
<td>Starts or resumes data capture and changes to show the Pause icon</td>
</tr>
<tr>
<td>Go To End</td>
<td><img src="image" alt="Go To End Icon" /></td>
<td>Moves to the last frame in the data buffer</td>
</tr>
<tr>
<td>Clear</td>
<td><img src="image" alt="Clear Icon" /></td>
<td>Erases data in the data buffer</td>
</tr>
<tr>
<td>Step Back</td>
<td><img src="image" alt="Step Back Icon" /></td>
<td>Moves to the previous frame in the data buffer</td>
</tr>
<tr>
<td>Frame Counter</td>
<td><img src="image" alt="Frame Counter Icon" /></td>
<td>Indicates the data buffer frame currently displayed</td>
</tr>
<tr>
<td>Step Forward</td>
<td><img src="image" alt="Step Forward Icon" /></td>
<td>Moves to the next frame in the data buffer</td>
</tr>
<tr>
<td>Zoom In</td>
<td><img src="image" alt="Zoom In Icon" /></td>
<td>Increases the magnification by decreasing the sweep of the graph</td>
</tr>
<tr>
<td>Zoom Out</td>
<td><img src="image" alt="Zoom Out Icon" /></td>
<td>Decreases the magnification by increasing the sweep of the graph</td>
</tr>
</tbody>
</table>

Use the slider in the middle of the toolbar to quickly move through paused data.
4.2.4 Menu Options

The Toolbar Menu icon at the base of the screen opens a menu near the top of the display.

![Sample Scanner Menu icon options](image)

Figure 4-11 Sample Scanner Menu icon options

The following Menu options are available:

- **Safety Information**—opens the *Important Safety Instructions* document.
- **File**—allows you to print or save the data being viewed.
- **Tools**—allows you to perform certain maintenance operations and adjust tool settings.
- **Help**—allows you to view supporting documentation.

**File**

Use to print or save a copy of the data currently being viewed. Menu options include:

- **Save**—opens a submenu with these options:
  - **Screenshot**—saves a graphic image of the current screen.
  - **Collected Data**—saves a recording of all the data currently in the buffer plus the number of frames designated after the trigger event (see Properties on page 31).
- **Print**—opens a submenu with these options: (see Printing / Printer Setup on page 24)
  - **Screen**—sends the current screen image to a printer.
  - **Troubleshooter**—prints the full text of the troubleshooter topic shown in the main body. Selecting an option opens a Windows Print dialog box for printing or saving the file.

**Tools**

This option allows you to adjust tool settings to your personal preferences. Selecting **Tools** opens a menu with two options:

- **Units Setup**
- **Display BEN**
**Units Setup**

The units of measurement can be changed for temperature, vehicle speed, air pressure and other pressure readings. Choose between US customary or metric units of measure.

To change the units setup:
1. Select **Tools > Units Setup**.
   The Measurement Units Setup dialog box opens.

![Sample Units Setup screen](image)

2. Use the dropdown menus to select the desired value for each item.
3. Select **Accept** to close the dialog box and apply the changes.

**Display BEN**

Selecting opens a screen with the Balco Engine Number (BEN) of the currently identified vehicle. The BEN is used internally for data coordination, and you may be asked to provide to a Customer Care representative for troubleshooting communication problems.

**Help**

A variety of utilities and additional resources are available through the Help menu:

- User’s Manuals
- About Scanner Hardware Version
- About Scanner

The User Manual, Version Info, and Activation Status options are the same as explained previously, see **Menu Options** on page 37 for details. Other options are explained below.
**User’s Manuals**

This option opens a menu of additional support documentation, such as vehicle communication software manuals, available to assist in your diagnosis. These manuals provide connection information, detailed test procedures, and other resource material for specific vehicles.

![Sample User’s Manuals menu](image)

Figure 4-13 Sample User’s Manuals menu

Select **Exit** to close the Help module and return to the Scanner.

**About Scanner Hardware Version**

This option opens a dialog box showing the hardware version and other details about the Scanner module. A **Copy to Clipboard** icon allows you to paste the information to a document or e-mail.

**About Scanner**

This option opens a dialog box that shows the software version and other Scanner module details. A **Copy to Clipboard** icon allows you to paste the information to a document or e-mail.
4.3 Scanner Operation

The Scanner function communicates with vehicle control modules, to provide you with DTCs, parameter data (PIDs), applicable functional tests, and troubleshooting information.

Basic Scanner Operation Steps

NOTE:
Menus, options and procedures may vary by vehicle.

1. If needed, turn the diagnostic tool on.
2. Connect the data cable to the vehicle and to the Scan Module. *Note:* The wireless Scan Module must be paired to the diagnostic tool to communicate. See Pairing The Scan Module on page 60.
3. Turn the vehicle ignition switch on.
4. Select **Scanner** from the Home screen.
5. Depending on the vehicle, Instant ID may occur. See Instant ID on page 41 for additional information.
   a. If Instant ID is not supported, after selecting vehicle year and make, choose Auto or Manual ID and enter the vehicle information at the screen prompts to continue.
6. Select a **System** to test. *Note:* If the Scan Module is not connected, an onscreen message may appear providing connection instructions.
7. Select a **Test** to be performed.

*Note:* The above information applies to most OBD-II vehicles. Not all vehicles support Instant ID.

4.3.1 Connecting the Scan Module

The Scan Module is a wireless device that is connected (using the vehicle data cable) to the vehicle and transmits vehicle data to the Diagnostic Tool. To use the Scanner function the Scan Module must be paired with the Diagnostic Tool. If the Scanner tries to communicate with the vehicle and the Scan Module is not connected to the vehicle, a Connect Data Cable confirmation screen will display. For Scan Module connection and operation information, see Pairing The Scan Module on page 60.

4.3.2 Vehicle Identification

Connection of the data cable and Scan Module to the diagnostic tool and vehicle DLC is required for Scanner testing.

Vehicle identification is the initial step in using the Scanner function. Once vehicle identification information is entered it is saved in Vehicle History and can be selected again for later use to save time when testing the same vehicle.

NOTE:
Menus options and procedures may vary by vehicle.
**Instant ID**

Instant vehicle identification is a built-in (default) Scanner feature that will save you time when identifying a vehicle, by automatically communicating with the vehicle to complete the vehicle identification process. Depending on the vehicle, Instant ID may occur automatically and only ask you to confirm the vehicle, or additional screen prompts may be displayed to enter vehicle information.

To complete the Instant ID process and continue, select **Continue** from the vehicle confirmation screen.

**Manual ID**

If Instant ID is not supported, the vehicle identification must be manually entered. The vehicle identification sequence is menu driven, follow the screen prompts to enter the vehicle information.

To complete the Manual ID process and continue, select **Continue** from the vehicle confirmation screen.

**Identifying a vehicle:**

1. Select the **Scanner** from the Home screen.
   A list of vehicle manufacturers (make) displays (Figure 4-14).

![Figure 4-14 Manufacturer list (typical)](image)

2. Select a manufacturer from the list.
   A model year menu displays.

**NOTE:**

You can limit the number of manufacturers that appear on the list by selecting **Configure Favorites** from the toolbar. See **Creating a Favorites List** on page 81 for details.

3. Select the vehicle year.
   A list of vehicle types or models displays. Several selections may be required to identify the vehicle type and model, follow the screen prompts and enter the required information.
A confirmation page showing the identified vehicle displays once all the required data has been entered. Review the information to make sure it is correct.

4. Select OK.

**Alternative Vehicle Identification**
Occasionally, you may try to identify a test vehicle that the Scanner does not recognize, the database does not support, or has some unique characteristics that prevents it from communicating with the Scanner. In these instances, there is an alternate choice that allows you to establish communication with the vehicle:

- **OBDII/EOBD Function**—this function allows you to connect to the OBDII equipped vehicle and perform basic OBD-II or EOBD diagnostic functions, see OBD Direct Operations on page 72 for additional information.

### 4.3.3 Vehicle System Selection

Selecting a vehicle system:

1. After the vehicle has been identified, a list of available systems for testing displays (Figure 4-15). Select a system to continue.
Code Scan

NOTE:
Depending on the vehicle, the Code Scan option may be available from the systems menu (Figure 4-16).

Figure 4-16 Systems Menu - Code Scan

Code Scan is used to scan all available vehicle control modules for DTC’s at once. This time saving feature displays the following information progressively as the modules are scanned.

- The total number of systems detected
- A summarized list of modules detected with DTCs totals for each
- Individual system module reports that include a list of the DTCs set, the DTC common replaced parts graph and a direct link to SureTrack® Fix It! information for each specific DTC. For additional information on SureTrack, the Fix It! and common replaced parts graph features see SureTrack on page 181.

NOTE:
SureTrack information is optional, and is displayed when SureTrack is activated and if data is available for a selected DTC.
Figure 4-17 Code Scan Features

1 — SureTrack Common Replaced Parts Graph
2 — Code Scan Summary
3 — Progressive status indicator
4 — Systems Summary List (with DTC totals)
5 — Individual System DTC Reports
6 — SureTrack Fix It! icon

**Edit Code Scan Report Shop Information**

To edit the Shop Information displayed on the Code Scan Report header, see Shop Information on page 176.

**Hide / Show Code Scan Report Timestamp**

See Code Scan (Timestamp) on page 177.
Printing the Code Scan Report

Select **Print** from the toolbar to print the Code Scan Report.

To install a printer, see **Printing / Printer Setup** on page 24.

![Printed Code Summary Report](image)

Clear All Codes Read by Code Scan

Selecting **Clear All Codes Read by Code Scan** erases all DTCs from all vehicle system modules that were read by Code Scan.
4.3.4 Vehicle Test Selection

Selecting a vehicle test:

1. After a system is selected and the Scanner establishes communication with the vehicle, the Scanner Main menu displays available tests. Select a menu item to continue.

Main menu options vary slightly by year, make, and model. The main menu may include:

- **Data Display** — displays data parameter information from the vehicle electronic control module (ECM). Selecting may open a submenu of viewing options.
- **Codes Menu** — displays diagnostic trouble code (DTC) records from the vehicle electronic control module. Selecting may open a submenu of viewing options.
- **Clear Codes** — erases DTC records and other data from the ECM. This selection is found on a Codes submenu for some models.
- **Functional Tests** — provides specific subsystem and Guided Component Tests. The tests vary depending on the manufacturer and model.
- **Actuator Tests** — similar to functional tests, checks the operation of certain actuators, such as solenoid valves and relays.
- **Memory Resets** — allows you to reprogram adaptive values for certain components after making repairs. Selecting opens a submenu. These options are found on the Functional Tests Menu for some models.
- **System Tests** — provides specific subsystem testing. Performing these tests is similar to functional tests.
- **Generic Functions** — lets you access certain available Generic OBD II functions from a proprietary menu (1996 and newer vehicles only).
- **Troubleshooter** — provides step-by-step procedures, integrating parameter data and retrieving trouble codes when appropriate, for specific symptoms of the identified vehicle.
Codes Menu

This selection may appear as Codes, Codes Menu, Codes Only, Codes (No Data), or something similar on the menu. Selecting opens a list of data parameter viewing options that may include:

Display Codes

Selecting opens either a list of diagnostic trouble codes (DTCs) stored in the selected electronic control module (ECM), or a submenu of DTC viewing options. Submenu options may include:

- **Trouble Code Information**—opens a list of codes in ECM memory.
- **History Codes**—opens a list of codes whose symptoms are not currently present. History codes indicate an intermittently occurring problem.
- **Failed This Ignition**—opens a list of codes that set during the current ignition cycle.
- **MiL SVS or Message Requested**—displays ECM requests to light the malfunction indicator lamp (MiL) or service vehicle soon (SVS) lamp, or display a driver information alert.
- **Last Test Failed**—displays a complete list of failed tests.
- **Test Failed Since Code Cleared**—displays a list of tests that failed since the last time codes were cleared from ECM memory.

If SureTrack® (optional) is active and data is available for a selected DTC, additional troubleshooting information from SureTrack (e.g. Common Replaced Parts data (Figure 4-20), Real Fix and Related Fixes) will also be available. For additional information about using SureTrack, see SureTrack on page 181.

A code list includes the DTC, a brief description, and a SureTrack **Fix It!** icon that opens a submenu allowing you additional information about the DTC (Figure 4-20).
**Clear Codes**

The Scanner clears trouble codes from the ECM memory on some vehicles. If this function is not available on the test vehicle, Clear Codes does not appear as a menu option.

**To clear codes:**
1. Select **Clear Codes** from the Codes Menu.
   - A confirmation message displays.
2. Make sure any conditions shown on the confirmation message are met, then select **Yes**.
   - A “codes cleared” message displays once the operation is complete.
3. Select **Continue** to return to the Codes Menu.

**Freeze Frame/Failure Records**

This selection displays the DTC that was set, along with corresponding data, when the ECM commanded the malfunction indicator lamp (MIL) to turn on.

**DTC Status**

This selection allows you to view the records of a particular DTC.

**To check DTC status**
1. Select **DTC Status** from the Codes Menu.
   - The DTC Status entry field displays and the virtual keyboard opens (Figure 4-21).
2. Use the virtual keyboard to enter the characters of the DTC.
3. Select the virtual keyboard **Backspace** icon if needed to erase a character.
4. Select the virtual keyboard **Return** key once all the code characters are entered.

![Figure 4-21 Sample DTC Status entry field](Image)
The DTC status report displays (Figure 4-22).

![Figure 4-22 Sample DTC status report](image)

5. Select **Exit** to return to the DTC status entry screen.
6. Select **Exit** again to return to the Codes menu.

**Data Display**

Depending upon the test vehicle, this selection may appear as Data, Data Display, Data Only, Data (No Codes), or something similar. All are similar. Selecting has one of the following results:

- A submenu of data viewing choices displays.
- Vehicle data displays.

A submenu displays when more than one data viewing mode is available on the identified vehicle. On some models, the engine must be started or cranked before data can be displayed. For these models, a “Waiting to Communicate” message displays if the engine was not cranked or started.

**Data Screens**

When a Data selection is made, the screen displays the data list for the selected module. The items available for any electronic control module vary from one vehicle to another.

Data is presented in a 2-column format. An abbreviated parameter name is at the left of each column and its value is at the right edge of the column. Parameters display in the order that they are transmitted by the ECM, so expect variation between vehicles.

Gesture scrolling allows you to quickly move through the data list. Simply touch the screen and drag your finger up or down to reposition the parameters being displayed. Position bars momentarily appear to the right of each column to indicate the position of the current screen in relation to the entire list as you scroll. Each column of parameters scrolls independently of the other column. **Figure 4-23** shows a typical data screen.
1— Graph icon
2— Parameter name
3— Parameter value

Figure 4-23 Sample data screen

Data Graphs
Select the Graph icon to open a data graph for that parameter (Figure 4-24). Selecting a parameter for graph view moves it to the top of the list. Select the Graph icon again to close the graph for that parameter and return to a data list view.

Figure 4-24 Sample graph view
The icons that display on each data graph allow you configure settings for the selected graph only:

**Table 4-3 Data graph icon operations**

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand/Collapse</td>
<td>![Icon]</td>
<td>Select to expand the graph to fill the entire screen, select again to collapse the graph to the standard view.</td>
</tr>
<tr>
<td>Graph Properties</td>
<td>![Icon]</td>
<td>Select to open the Graph Properties dialog box, which allows you to set triggers for recording a snapshot and to adjust the scale.</td>
</tr>
</tbody>
</table>

**Triggers**

Triggers establish threshold values, an upper limit and a lower limit, for recording a data snapshot. A snapshot allows you to closely evaluate conditions that caused the triggering event.

When a snapshot is taken, the Scanner captures additional data after the trigger point is detected, data collection pauses, and the buffered information is automatically saved as a movie. This gives you a complete picture of what was happening before the fact, what occurred at the trigger point, and what happened after the fact.

Data collection is paused following a trigger event. Select the **Play** icon to resume viewing live data. A vertical line now appears on each of the data graphs to indicate the triggering point. The trigger line on the parameter that triggered the snapshot is a different color than those on the other graphs. This makes it easy to determine which parameter caused the trigger when triggers are set for multiple parameters.

**To adjust the amount of data collected after a trigger:**

1. Select the **Properties** icon on the Scanner toolbar to open the dialog box.
2. Highlight one of the **Samples After Trigger** options:
3. Select the Accept icon to close the dialog box.

**NOTE:**

You can also adjust the amount of data collected after a triggering event using the Properties icon on the Scanner toolbar. See **Properties** on page 31 for additional information.

**To set triggers and record a snapshot:**

1. Select the Graph Properties icon on the parameter graph you wish to set triggers on.
   
   The Graph Properties dialog box opens.
2. From the Graph Properties dialog box, select **Triggers On**.
   
   A check mark appears in the box and the Min and Max fields activate (Figure 4-25).
3. Select either **Max**: (maximum) or **Min**: (minimum) to activate that field and open the keyboard.
4. Type the desired trigger value into the field.
5. Select the other field and enter a trigger value, then close the virtual keyboard.
6. Select **Save** to close the dialog box.

   Trigger lines (blue for upper and red for lower) display on the selected parameter graph.
The area between the upper and lower trigger lines establishes the triggering condition. Any data points that register outside of the set trigger conditions initiates a snapshot.

7. Select **Snapshot** on the Data Buffer Toolbar to arm the snapshot. The Snapshot icon changes color to indicate it has been armed (Figure 4-26).

Once all of the data is compiled, data collection pauses and the information is saved as a movie. A confirmation screen displays to let you know the name automatically assigned to the saved file and where to locate it.

![Sample Graph Properties dialog box](image)

**Figure 4-25** Sample Graph Properties dialog box

![Sample armed Snapshot icon](image)

**Figure 4-26** Sample armed Snapshot icon

![Sample saved movie confirmation screen](image)

**Figure 4-27** Sample saved movie confirmation screen
8. Select **OK** to close the confirmation screen.
9. Select the **Play** icon on the toolbar to resume viewing live data.

![Information Icon]

**NOTE:**
Selecting an armed Snapshot icon disarms it.

---

**Scale**

Scale adjusts the upper and lower values displayed on the vertical axis of a data graph. Two scale modes are available; auto scale and manual scale. Auto scale, which is the default setting, automatically adjusts the graph scale based upon the minimum and maximum values transmitted by the ECM. Manual scale allows you to set the minimum and maximum values.

**To manually set the scale on a graph:**
1. Select the Graph Properties icon to open the dialog box for the graph you wish to scale.
2. From the Graph Properties dialog box (Figure 4-28), select **Auto Scale On**.
   The check mark is cleared from the box and the minimum and maximum fields activate.
3. Select either **Max:** (maximum) or **Min:** (minimum) to activate that field and open the keyboard.
4. Type the desired scale value into the field.
5. Select the other field and enter a value, then close the virtual keyboard.
6. Select **Save** to close the dialog box.

![Figure 4-28 Sample manual scale selection]

The dialog box closes and the parameter scale is now at the set values.

**Using Zoom**

The zoom options on the Data Buffer toolbar allow you to change the magnification level of the sweep when viewing data graphs. Use the **Zoom In (+)** icon to increase magnification, and the **Zoom Out (−)** icon to decrease magnification.
Functional Tests

The **Functional Tests** selection is used to access vehicle-specific subsystem and guided component tests. Available tests vary by manufacturer, year, and model, and only the available tests display in the menu.

There are four general types of functional test operations:

- **Information Tests**—are read-only tests, like selecting “VIN” from a Functional Tests menu to display the VIN of the identified vehicle.
- **Toggle Tests**—switch a component, such as a solenoid, relay, or switch, between two operating states.
- **Variable Control Tests**—command a certain value for a system or component, such as varying the spark timing in 1° increments or the EGR valve duty cycle in 10% increments.
- **Reset Tests**—reset the adaptive, or learned, values that are stored in the electronic control module.

Selecting **Functional Tests** opens a menu of test options that varies by make and model. Selecting a menu option either activates the test or opens a submenu of additional choices. Follow all screen instructions while performing tests. How and what information is presented on the screen varies according to the type of test being performed.

**IMPORTANT:**
Do not enter any functional tests while driving on a road test. During some functional tests, the ECM makes changes to ignition timing, fuel delivery, and other engine functions, which may affect engine operation and vehicle control.

Some toggle and variable control tests display functional test controls at the top of the screen with data stream information below *(Figure 4-29)*.
Functional test controls allow you manipulate the test signal as shown in the table below.

Table 4-4 Functional test control icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td><img src="image" alt="Test Icon" /></td>
<td>Activates the test.</td>
</tr>
<tr>
<td>Return</td>
<td><img src="image" alt="Return Icon" /></td>
<td>Moves focus back to the data list.</td>
</tr>
<tr>
<td>Change List</td>
<td><img src="image" alt="Change List Icon" /></td>
<td>Allows you to switch data lists.</td>
</tr>
<tr>
<td>Custom</td>
<td><img src="image" alt="Custom Icon" /></td>
<td>Allows you to select which parameters display during the functional test.</td>
</tr>
<tr>
<td>Minus</td>
<td>-</td>
<td>Switches an item to low or off, or incrementally reduces a variable signal.</td>
</tr>
<tr>
<td>Plus</td>
<td>+</td>
<td>Switches an item to high or on, or incrementally increases a variable signal.</td>
</tr>
</tbody>
</table>

**Generic Functions**

The **Generic Functions** selection opens a menu of available OBD-II/EOBD functions on 1996 and newer vehicles. For additional information on generic functions refer to the *Global OBD Vehicle Communications Software Manual*. Menu options typically include:

- **MIL Status** - displays the ID and status of the Malfunction Indicator Lamp (MIL)
- **Fast Track® Troubleshooter** - displays a menu of available experience-based tests and tips
- **Readiness Monitors**—displays the status of the OBD-II/EOBD required monitors
- **($01) Display Current Data** - displays a screen containing Generic OBD PID data
- **($02) Freeze Frame**—displays data stored in ECM memory when a DTC is set
- **($05) Oxygen Sensor Monitoring**—displays on-board oxygen sensor monitoring test results
- **($06) On-Board Monitored Systems**—displays the status of system monitors
- **($08) Request Control of On-Board System**—establishes bidirectional ECM communication
- **($09) Calibration Identification**—displays the ECM calibration identification numbers
- **($09) Calibration Verification Number**—displays the ECM calibration
- **($09) In-Use Performance Tracking**—displays a monitoring conditions report
- **($09) Vehicle Identification Number**—displays the VIN
- **($0A) Emissions Related Fault with Permanent Status**—displays a record of permanent codes
Troubleshooter

Fast-Track® Troubleshooter is a database of experience-based information of validated real-world repair strategies that have been compiled by top-notch technicians. Troubleshooter simplifies the diagnosis process, as it contains information on virtually all common diagnostic trouble code (DTC) problems and driveability symptoms.

Troubleshooter information is organized into a series of diagnostic tips that are designed to quickly lead you to the root cause of a particular problem. The tips are vehicle-specific, which means only tips that relate to the identified vehicle are presented. Selecting opens a menu that may include:

- **Code Tips**—provides detailed information on setting conditions, testing, and interpreting test results for specific codes.
- **Symptom Tips**—provides diagnostic tests and procedures based on vehicle operation.
- **Time Savers**—provides supplemental information, such as firing order and #1 cylinder location, that may be needed to make a diagnosis.
- **Common Problems**—provides advice and remedies for certain “pattern failures” that have been experienced on vehicles of the same model.
- **Tests and Procedures**—explains how to perform certain tests on the specific test vehicle. Some tips provide specifications and installation information as well.
- **Fast-Track Data Scan (Normal Values)**—contains information and guidelines on how to validate data readings for certain sensors and actuators, live data values are provided.

**NOTE:**
Troubleshooter appears in a Scanner menu only if tips are available for the system selected on the identified vehicle.
Certain live data parameter values display directly within the tip when performing Troubleshooter tests and procedures. A tip may also contain a hyperlink to a Troubleshooter Reference, another test or procedure, or a supplemental operation, such as Clear Codes. Hyperlinks are shown in blue, and selecting them opens the link. Troubleshooter References open in a separate window. (Figure 4-30).

1— Live data values
2— Hyperlink

Figure 4-30 Sample data values within a Troubleshooter tip
4.4 Stopping Communication and Exiting the Scanner

The Scanner remains open as long as there is an active communication link with the vehicle. You must first stop communication with the vehicle in order to exit from the Scanner function. A warning message displays if you attempt to exit from the Scanner while it is communicating with the vehicle ECM.

**NOTE:**
Damage to the vehicle electronic control module (ECM) may occur if communication is disrupted. Make sure the data cable and the USB cable are properly connected at all times during testing. Exit all tests before disconnecting the test cable or turning off the tool.

**To exit Scanner and disconnect from a vehicle:**

When disconnecting the Diagnostic Tool from the vehicle, make sure the Scanner software is not communicating with the vehicle.

1. From a codes or data display screen, select the **Exit** icon on the upper toolbar.

![Exit icon](image)

Figure 4-31 Exit icon

The screen goes to the codes or data menu.

2. Select the **Back** icon on the upper toolbar.

![Back icon](image)

Figure 4-32 Back icon

The screen goes to the system menu.

3. Select the **Back** icon on the upper toolbar.
   
   A “stopping communication” message briefly displays followed by the systems menu.

4. Select the **Change Vehicle** icon on the Toolbar.

![Change Vehicle icon](image)

Figure 4-33 Change Vehicle icon

The vehicle description on the toolbar should now read “No Active Vehicle”.

5. Select the **Home** icon on the Toolbar.

![Home icon](image)

Figure 4-34 Home icon

The Home screen displays.

6. Disconnect the data cable from the vehicle diagnostic connector.
Chapter 5  
Scan Module Operation

This chapter describes the connection, operation, troubleshooting and updating of the Scan Module.

5.1  Overview

The Scan Module is a wireless device that is connected to the vehicle and transmits vehicle data to the diagnostic tool.

The Scan Module operates on 12 or 24VDC vehicle power, supplied through the vehicle’s data link connector (DLC).

![Scan Module Diagram]

1— Data cable connector  
2— Vehicle power LED (green)  
3— Communication issue LED (red)  
4— Bluetooth LED (green)  
5— Memory card port (remove protective hand grip for access)  
6— Universal serial bus (USB) jack (remove protective hand grip for access)

Figure 5-1  Scan Module
5.2 Pairing The Scan Module

To use the Scan Module with the Scanner or OBD-II/EOBD functions, it must first be paired with the diagnostic tool.

Pairing is the wireless connection (identification) process used to connect the Scan Module to your diagnostic tool.

The Scan Module only needs to be paired once before its initial use. The connection configuration should remain in memory for all future uses, unless the connection configuration is removed or lost.

NOTE:
Wireless devices shown in this section are used as reference. Not all devices shown may be applicable to your diagnostic tool.

To pair the Scan Module with the diagnostic tool:

1. Turn on the diagnostic tool.

IMPORTANT:
The Scan Module needs to be powered on during the pairing process. Connect the Scan Module to a vehicle or to the diagnostic tool using the USB cable. Make sure the diagnostic tool has a charged battery or is connected to the AC power supply.

2. Connect the 26-pin end of the data cable to the Scan Module data cable connector.
3. Connect the 16-pin end of the data cable to a vehicle data link connector (DLC).
   The green LED on the Scan Module is illuminated when power is being supplied to the Scan Module. For additional information on the Data Cable, see Data Cable Connection on page 62.
4. From the diagnostic tool select System Settings > Paired Devices.
5. Select Add from the toolbar, then OK when prompted.
   The diagnostic tool searches for compatible wireless devices, then displays the results. (Figure 5-2).

Figure 5-2 Sample Scan Module selection
NOTE:
Search results include all compatible wireless devices detected, and may include multiple Scan Modules if you are in a shop environment where more than one unit is powered on. Available module listings include a partial serial number. Make sure the screen listing matches the last six digits of the serial number of your Scan Module before continuing. Scan Module serial numbers are also printed on the back of the Scan Module (e.g. 123SMC-987654)

6. Select the Scan Module you wish to connect from the results list.
   A search in progress message displays during the pairing procedure (Figure 5-3), the Paired Devices screen (Figure 5-4) displays once the procedure completes.

7. Select the Home icon on the Toolbar.
8. Disconnect the data cable from the vehicle.
   The Scan Module and diagnostic tool are now paired for wireless communication and should automatically recognize each other when both are powered up.

5.3 Checking Scan Module Paired Status

To check if the Scan Module is paired to your diagnostic tool:
1. Select System Settings > Paired Devices.
   The paired devices screen opens (Figure 5-4).
   The Paired Devices screen lists all of the devices paired to the diagnostic tool, and also indicates whether or not there is active communication occurring.
2. Verify the Scan Module is in the list of paired devices.

5.4 Data Cable Connection

To use the Scan Module for Scanner and OBD-II/EOBD testing, it must first be connected to the vehicle’s data link connector (DLC).

Depending on the vehicle, the supplied DA-4 data cable may be used alone or may require optional adapters.

- **All OBD-II/EOBD compliant vehicles** - Use the supplied DA-4 data cable. The 26-pin end of the cable attaches to the data cable connector on the Scan Module. The 16-pin end connects to the vehicle DLC. The cable connectors are secured with captive screws.

- **All non-OBD-II/EOBD (OBD-I) compliant vehicles** - Use the supplied DA-4 data cable with the optional DA-5 adapter and a manufacturer specific adapter. The 26-pin end of the cable attaches to the data cable connector on the Scan Module. The 16-pin end connects to the DA-5 adapter, the DA-5 adapter connects to the manufacturer specific adapter and then connects to the vehicle DLC. The cable connectors are secured with captive screws.

While using the Scanner and OBD-II/EOBD functions, on-screen cable and adapter connection instructions are provided. The instructions may also include the location of the vehicle DLC (Figure 5-5). If required, additional connection information can be found in the appropriate vehicle communication software manual for the vehicle. Vehicle communication software manuals are available online, see the website information at the front of this manual.

Figure 5-5 Vehicle connection data cable message
To connect the data cable to the vehicle:
1. While using the Scanner or OBD-II/EOBD function, follow the on-screen instructions for connecting the cable and/or any adapters required to the vehicle (Figure 5-5).
2. Select Continue once the data cable is connected to the vehicle.

5.5 Troubleshooting

The Scan Module is a wireless communications device that uses Bluetooth technology to transmit vehicle data to the diagnostic tool without a physical connection. The working range of the transmitter is about 30 feet (9.14 m). Scan Module operations can be impacted when signal interference, or some other condition, disrupts or impairs the wireless communication network. These interruptions are usually temporary and easily repaired.

Indicators of wireless communication interference include:

- Slow Scan Module response accompanied by “Error 101” message.
- Slow Scan Module response accompanied by “Error 404” message.
- “Error Occurred” Message when trying to use the Scan Module.
- “Error Occurred” Message after 20 or more minutes sitting idle, particularly if the devices have been stationary.

5.5.1 No Communication Message

If the Scan Module is paired to the diagnostic tool and tries to communicate with the vehicle and the Scan Module is not connected to the vehicle, a “Connect Data Cable” or “no communication” message displays.

A signal lost due to moving out of range automatically restores itself when the diagnostic tool is brought closer to the Scan Module. The Scanner sounds a tone when the signal is lost.

The following conditions cause a “no communication” message to display:

- The Scanner is unable to establish a communication link with the vehicle.
- You selected a system for testing that the vehicle is not equipped with (such as ABS).
- There is a loose connection.
- There is a blown vehicle fuse.
- There is a wiring fault on the vehicle, or in the data cable or adapter.
- There is a circuit fault in the data cable, Personality Key, or adapter.
- Incorrect vehicle identification was entered.

Refer to the Vehicle Communication Software manuals for manufacturer-specific troubleshooting information.

5.5.2 Signal Loss / Out of Range Alarm

A signal lost due to moving the diagnostic tool out of range of the Scan Module will automatically restore itself when the diagnostic tool is brought closer to the Scan Module. The Scan Module will sound an audible tone when the signal is lost.
5.5.3 Checking Hardware Status

Verifying the Hardware Status is always the first step in troubleshooting a wireless connection issue.

The Hardware Status indicators in the lower-right corner of the Home screen provide a quick reference to wireless operations. The background color of the status indicator icon represents the condition of the wireless connectivity to that device. Icon status is shown in the table below:

<table>
<thead>
<tr>
<th>Hardware Icon</th>
<th>Background Color</th>
<th>Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Not Paired</td>
<td>Pair the Scan Module to the diagnostic tool. See Pairing The Scan Module on page 60 for instructions.</td>
<td></td>
</tr>
<tr>
<td>Grey</td>
<td>Paired, but Not Communicating</td>
<td>You may have moved out of range. Move the diagnostic tool closer to the Scan Module to reestablish communications. If connectivity is not restored, perform the Recovery Procedure on page 66.</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Paired and Communicating</td>
<td>Hardware status is good and Bluetooth should be functional. Verify that the green Bluetooth LED on the front of the Scan Module is flashing. If there is no connectivity, perform the Recovery Procedure on page 66.</td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>USB Cable Connected</td>
<td>Indicates the USB cable is connected.</td>
<td></td>
</tr>
<tr>
<td>Gray</td>
<td>USB Cable Not Connected</td>
<td>Indicates the USB cable is not connected or connected but not allowing communication</td>
<td></td>
</tr>
</tbody>
</table>

The three light emitting diodes (LEDs) on the faceplate of the Scan Module let you know at a glance whether or not there is an active connection between the two modules. The two green LEDs (Vehicle Power and Bluetooth) both flash on and off when the Scan Module and diagnostic tool are actively communicating through a wireless connection. The red Communication LED flashes on and off when the Scan Module is performing an internal self test, and is illuminated continuously if a failure is detected (Figure 5-6).
Scan Module Operation

Troubleshooting

1— Vehicle Power—green LED, flashes during wireless communications
2— Communication—red LED, illuminates if there is a communications failure
3— Bluetooth—green LED, flashes during wireless communications

Each LED can be in one of three states; off, lit solid, or flashing. Interpret as follows:

- **Vehicle Power**
  - Off, vehicle power is not being supplied to the Scan Module through the data cable
  - On Solid, the Scan Module is being powered by the vehicle, but not communicating with the Diagnostic Tool.
  - Flashing, the Scan Module is being powered by the vehicle and is communicating with the Diagnostic Tool.

- **Communication**
  - Off, normal state, no errors detected.
  - On Solid, communications error detected.
  - Flashing, internal self-test in process, will go out once the test completes.

- **Bluetooth**
  - Off, there is no connection between the Scan Module and Diagnostic Tool.
  - On Solid, the Scan Module and Diagnostic Tool are communicating through a solid (USB cable) connection.
  - Flashing, the Scan Module and Diagnostic Tool are communicating through a wireless connection.

Figure 5-6 Scan Module LEDs
5.5.4 Recovery Procedure

This is a quick and easy method that reestablishes connectivity between the diagnostic tool and the Scan Module in most instances. If bluetooth connectivity remains unavailable following recovery, use one of the alternate procedures to restart the system.

NOTE:
This product is intended to be used by professional technicians in a garage environment. Electrostatic discharges may happen occasionally and cause a loss of communication. To restore communication disconnect and reconnect the communication cables and follow screen prompts.

To recover wireless connectivity:
1. Disconnect the Scan Module from the vehicle.
2. Navigate to the Home Screen on the diagnostic tool.
3. Select Exit to close the ShopStream Diagnostic Suite.
4. Connect the Scan Module to the vehicle.
5. Select the ShopStream Diagnostic Suite icon on the desktop.

![Sample ShopStream Diagnostic Suite desktop icon](image)

NOTE:
The ShopStream Diagnostic Suite can also be started from the Windows Start menu.

Alternate Recovery Procedures

Use these methods as an option to the Recovery Procedure, or when recovery fails to restore the wireless connection.

**USB Procedure**

This method establishes a “hard-wired” USB cable connection between the modules.

To create a USB connection:
1. Carefully slip the ends of the handgrip off of the sides of the Scan Module housing.
2. Lift open the hinged cover on the base of the Scan Module.
3. Plug the small end of the USB cable into the USB jack on the Scan Module.
4. Plug the large end of the USB cable into a USB jack on the diagnostic tool.
   Scanner functionality should be restored immediately once the USB connection is complete.
   If not, suspect a hardware failure. The diagnostic tool and Scan Module are both fully functional, so you can complete your testing with the USB connection intact.

**ShopStream Diagnostic Suite Restart Procedure**

This method, which closes and restarts the ShopStream Diagnostic Suite software, takes about two minutes to complete.

醒目 To restart the ShopStream Diagnostic Suite:
1. Navigate to the Home Screen on the diagnostic tool.
2. Select **Exit** to close the ShopStream Diagnostic Suite.
3. Wait for the Scan Module Communication LED to stop flashing.
4. Select the ShopStream Diagnostic Suite icon on the desktop.
   The ShopStream Diagnostic Suite should open with connectivity restored.

**Windows Reboot Procedure**

This method, which completely shuts down the diagnostic tool, takes several minutes to complete.

醒目 To reboot the diagnostic tool:
1. Disconnect the Scan Module from the vehicle.
2. Navigate to the Home Screen on the diagnostic tool.
3. Select **Exit** to close the ShopStream Diagnostic Suite.
4. Select **Start** in the lower-left corner of the screen to open the menu.
5. Select **Turn Off Computer** from the menu.
6. Select **Turn Off** when the Confirmation window opens.
7. Wait for the tool to completely turn off, then press the **Power** button to restart the diagnostic tool.
8. Connect the Scan Module to the vehicle once the ShopStream Diagnostic Suite opens.
5.6 Updating Scan Module Firmware

The internal programming (firmware) of the Scan Module, may require periodic updates. These firmware updates (when available) are delivered with diagnostic software updates/upgrades. Firmware updates increase the Scan Module’s diagnostic capabilities, typically by adding support for new tests, vehicles and enhanced applications to the vehicle databases.

Scan Module Firmware Update Process:

Upon starting the Scanner function, initially after a software update or upgrade has been installed, a message may be displayed to inform you an update is available (Figure 5-9).

![Figure 5-9 Scan Module update available message]

IMPORTANT:
To supply power to the Scan Module, the data cable must be connected to the vehicle during the update process, with the vehicle ignition switch in the OFF position. To avoid damaging the Scan Module, never turn the ignition switch ON during the update process.

IMPORTANT:
To avoid damaging the diagnostic tool or scan module, it is highly recommended to connect the AC power supply to the diagnostic tool before starting the firmware update process. Damage can occur to the scan module if the diagnostic tool power is turned off or the power supply is disconnected during the firmware update process.

1. Select the desired update option:
   - **Update Now** begins the process immediately.
   - **Update Later** defers the operation, closes the message, and starts the Scanner function. If you choose not to perform the update, it will not affect diagnostic tool operation, however you will not benefit from the additional features available in the update.

NOTE:
Selecting Details in the upper-right corner opens a list of what is included in the update.

Once the update process has been started, the update is performed wirelessly, and the installation progress is tracked on the screen (Figure 5-10).
A “successfully updated” message displays once the installation process is complete (Figure 5-11).

2. Select OK to close the message and return to Scanner operations.

The updated Scan Module, is ready to use.

Alternate Scan Module Firmware Update Process (USB cable):
If necessary, this alternate firmware update procedure may be used to update the Scan Module firmware.

IMPORTANT:
The diagnostic tool must be connected and powered by the AC power supply during the Scan Module firmware update process. Damage can occur to the Scan Module if the diagnostic tool power is turned off or the power supply is disconnected during the firmware update process.

1. Connect the AC power supply to the diagnostic tool.
2. Turn on the diagnostic tool.
3. Connect the Scan Module to the diagnostic tool as follows:
Scan Module Operation

Updating Scan Module Firmware

IMPORTANT:
The Scan Module data cable must be disconnected from the vehicle during the update process.

a. From the bottom of the Scan Module, gently lift up and out on the sides of the handgrip to free it from housing (Figure 5-12).
b. Open the hinged cover on the base of the Scan Module to expose the USB jack.
c. Plug the small end of the USB cable into the USB jack on the Scan Module.
d. Plug the large end of the USB cable into one of the USB jacks on the side of the diagnostic tool.

NOTE:
When connected, the scan module USB connection status icon background color will change from gray to green.

1— Hinged cover
2— USB jack

Figure 5-12 Scan Module USB jack

4. Select **Scanner** from the diagnostic tool Home screen.
5. Select **OK** when the update available message displays.
   The update begins and installation progress is tracked on the screen (Figure 5-13).

Figure 5-13 Sample update in progress screen
A “successfully updated” message displays once the installation process is complete (Figure 5-14).

![Firmware update complete message](image)

**Figure 5-14** Firmware update complete message

6. Select **OK** to close the message and return to the Scanner function. The updated Scan Module, is ready to use.
This Home screen option allows you to access Generic OBD-II/EOBD Scanner tests without completing a vehicle identification. OBD Direct presents a quick way to check for diagnostic trouble codes (DTCs), isolate the cause of an illuminated malfunction indicator lamp (MIL), check monitor status prior to emissions certification testing, verify repairs, and perform a number of other services that are emissions-related. This mode is also used for testing OBD-II/EOBD compliant vehicles that are not included in the Scanner databases.

OBD Direct is a Scanner function, and the Scan Module must be connected to the test vehicle and communicating with the diagnostic tool. This function only provides generic OBD-II/EOBD information. To access enhanced OBD-II/EOBD functions, select Scanner from the Home screen.

Options for the Menu icon on the Toolbar at the base of the screen are the same as those available for the Scanner module.

Selecting OBD Direct on the Home screen opens a menu with two options (Figure 6-1):

![Figure 6-1 Sample OBD Direct main menu](image)
6.1 OBD Health Check

The OBD Health Check offers a way to quickly check for and clear generic diagnostic trouble codes (DTCs) and to check readiness monitors. Selecting OBD Health Check opens a submenu of options (Figure 6-2).

![Sample OBD Health Check menu](image)

Figure 6-2 Sample OBD Health Check menu

6.1.1 Global OBD II Code Check

This option displays any stored emission related generic DTCs reported by the ECM. Selecting opens a submenu with two choices:

- Codes
- Pending Codes

Codes

Codes displays a list of current emission related DTCs. OBD-II/EOBD Codes have a priority according to their emission severity, with higher priority codes overwriting lower priority codes. The priority of the code determines the illumination of the MIL and the code erase procedure. Manufacturers rank codes differently, so expect to see differences between makes.
Pending Codes

The purpose of this service is to enable the scan tool to obtain “pending” or maturing diagnostic trouble codes. These are codes whose setting conditions were met during the last drive cycle, but need to be met on two or more consecutive drive cycles before the DTC actually sets.

The intended use of this service is to assist the service technician after a vehicle repair and after clearing diagnostic information, by reporting test results after a single driving cycle.

• If a test failed during the driving cycle, the DTC associated with that test is reported. If the pending fault does not occur again within 40 to 80 warm-up cycles, the fault is automatically cleared from memory.

• Test results reported by this service do not necessarily indicate a faulty component or system. If test results indicate another failure after additional driving, then a DTC is set to indicate a faulty component or system, and the MIL is illuminated.

6.1.2 Global OBD II Clear Codes

This option is used to clear all emission related diagnostic data such as, DTC records, freeze frame data, and test results, from ECM memory. Although OBD Direct only displays generic OBD-II data, clearing codes erases all of the stored data including any enhanced codes.

A confirmation screen displays when the clear codes option is selected to prevent accidental loss of data. Select Yes on the confirmation screen to continue.

6.1.3 Readiness Monitors

Use this menu option to check the readiness of the monitoring system. An OBD-II/EOBD system checks the status of emission-related subsystems by running continuous or periodic tests. Test results are shown in the data viewer (Figure 6-3).

Figure 6-3 Sample readiness monitor test report

Gesture sweep to view the entire list of Readiness Monitors to ensure that all tests are complete. It is possible to print the readiness test status or save it as part of a Vehicle history.
6.1.4 MIL Status

This item is used to check the current condition of the malfunction indicator lamp (MIL). Additional information, such as which ECM commanded the MIL on and the distance driven while the MIL is on (if supported), can also be displayed. It is also possible to print the MIL Status.

6.2 OBD Diagnose

Selecting OBD Diagnose opens a menu with the following options:

- Start Communication—begins the test session
- Connector Information—provides data link connector (DLC) location details for most models
- Manual Protocol Selection—allows you to select which protocol to use

6.2.1 Start Communication

Use the following procedure to conduct an OBD Direct test session:

To perform an OBD Direct Test:
1. Select Start Communications from the OBD Direct menu.
   A generic connection message displays (Figure 6-4), connect the Scan Module to the test vehicle as instructed.

![Figure 6-4 Sample generic connection message](image-url)
2. Select **Continue**.
   A communications message that shows how many ECMs were detected, which ECM is communicating, and which communication protocol is being used displays (Figure 6-5).

![Figure 6-5 Sample communication message](image)

3. Select **Continue** and a menu of available tests displays (Figure 6-6).

![Figure 6-6 Sample Start Communication menu](image)

4. Select a test to continue.
Readiness Monitors

Use this menu item to check the status of the monitored system. If a monitored system is not supported, it is not displayed. Scroll, if needed, to view the entire list of monitors. Selecting Readiness Monitors opens a submenu with two choices:

- **Monitors Complete Since DTC Cleared**—displays the results of all monitor tests that have run since the last time the electronic control module (ECM) memory was cleared.
- **Monitors Complete This Cycle**—displays only the results of monitor tests that ran during the current drive cycle, they reset when the ignition is switched off.

MIL Status

This item is used to check the current condition of the malfunction indicator lamp (MIL). Additional information, such as which ECM commanded the MIL on and also the distance traveled while the MIL is on (if supported), can also be displayed. It is also possible to print the MIL Status.

Fast-Track Troubleshooter

Fast-Track® Troubleshooter is a database of experience-based information of validated real-world repair strategies that have been compiled by top-notch technicians since 1988. The Troubleshooter system simplifies the diagnosis process, as it contains information on virtually all common diagnostic trouble code (DTC) problems and driveability symptoms for most vehicles covered by the vehicle communication software.

($01) Display Current Data

Use this item to display the current emission related data from the selected electronic control module (ECM) of the vehicle. Displayed data includes analog inputs and outputs, digital inputs and outputs, and system status information broadcast on the vehicle data stream. OBD Direct data displays similar to Scanner data, refer to Data Display on page 49 for details.

($02) Display Freeze Frame Data

This item is used to display freeze frame data for any stored emission related diagnostic trouble codes (DTC). In most cases the stored frame is the last DTC that occurred. Certain DTCs, those that have a greater impact on vehicle emission, have a higher priority. In these cases, the highest priority DTC is the one for which the freeze frame records are retained.

Freeze frame data includes a “snapshot” of critical parameter values at the time the DTC set.

($03) Display Trouble Codes

This option displays any stored emission related DTCs reported by the various ECMs. The OBD Direct code report is similar to a Scanner module code report, and includes the Fix It! icon with hyperlinks to Information details. See Display Codes on page 47 for additional information.
($04) Clear Emissions Related Data
This item is used to clear all emission related diagnostic data such as, DTCs, freeze frame data, and test results from the memory of the selected ECM.

($05, 06, 07) Display Test param./Results
This option opens a submenu of test parameters and test results from various sensors, monitor test results, and a record of DTCs detected during the last drive cycle. The menu includes:
- Oxygen Sensor Monitoring ($05)
- On-Board Monitored Systems ($06)
- DTCs Detected During Last Drive ($07)

($08) Request Control of On-board System
This service enables bidirectional control of the ECM so that the Scanner is able to transmit control commands to operate the vehicle system. This function is useful in determining how well the ECM responds to a command.
Available options vary by make, model, and year of the test vehicle. Select a test and follow the on-screen instructions.

($09) Read Vehicle Identification
This selection displays the vehicle identification number (VIN), the calibration identification, and the calibration verification number (CVN) of the test vehicle.

($09) In-use Performance Tracking
This selection displays the "In-use Performance Tracking" of monitored data. It is basically a record of the number of times each of the monitor tests have been completed.

($0A) Emission Related DTC with Permanent Status
This service displays a record of any “permanent” codes on late-model vehicles if the vehicle supports Service $0A. A permanent status DTC is one that was severe enough to illuminate the MIL at some point, but the MIL may not be on at the present time.
Whether the MIL was switched off by clearing codes or because the setting conditions did not repeat after a specified number of drive cycles, a record of the DTC is retained by the ECM. Permanent status codes automatically clear after repairs have been made and the related system monitor runs successfully.
6.2.2 Connector Information

This option opens a database of vehicle diagnostic connector locations that includes most makes and models.

To locate a vehicle diagnostic connector:
1. Select Connector Information from the System menu.
2. Select a manufacturer from the list presented.
3. Select a model from the list presented. Instructions for which, if any, cable adapter or pin to use displays.
4. Select Continue.
5. Information on where to locate the vehicle diagnostic connector displays.
6. Select Continue to return to the System menu.

6.2.3 Manual Protocol Selection

A communication protocol is a standardized way of data communication between an ECM and a scan tool. Global OBD may use several different communication protocols. The scan tool automatically connects to an available protocol, which displays on the connection message (Figure 6-5). Some vehicles communicate on more than one protocol. Use the Manual Protocol Selection option to switch to a different protocol.

Select Manual Protocol Selection and message displays advising you to make sure you know the correct protocol for the test vehicle. An incorrect selection may activate warning lamps and set CAN related faults on the vehicle. Select OK and a menu of options displays (Figure 6-7).

Figure 6-7 Sample communication protocol menu
Chapter 7  Guided Component Test Operations

The Guided Component Test software is a component-testing powerhouse, providing you with a robust diagnostic database for use with scopes and meters. It is like having access to a complete library of shop manuals for testing engine-management components, transmission sensors and components, and ABS systems.

Guided Component Test helps you with everything from selecting the appropriate test for a specific component to showing the hook-up location and correct pin configuration. This software thoroughly guides and instructs you on proper testing procedures and offers tips from the internal troubleshooter database. The Guided Component Test procedures, tips, and meter settings reduce your overall set-up and diagnostic testing time. Vehicle-specific Guided Component Tests are provided for engine, transmission, ABS, charging, transfer case and suspension systems.

**WARNING**

Risk of electrical shock.

- Read the **Important Safety Instructions** document provided separately for messages on the safe use of this product.
- This product is intended for Measurement Category I (for example, automotive 12V systems), do not use this product for Measurement Categories II, III, and IV.
- Measurement Category I is for performing measurements on circuits not directly connected to MAINS or MAINS circuits (an example of a MAINS circuit is 120V AC or 240V AC household or industrial electricity), do not connect this product to MAINS or MAINS circuits.
- Do not apply the Black Ground Lead to test points other than ground/system return/vehicle chassis.

*Electrical shock can cause personal injury, equipment damage, or circuit damage.*

***IMPORTANT:***

Maximum rated transient over voltage impulse is 500 volts, do not exceed the rated transient over voltage.

---

7.1 Vehicle Identification

The Guided Component Test information presented is specific to the vehicle being tested. Therefore, certain attributes of the test vehicle must be entered into the diagnostic tool so that the correct data can be retrieved. Vehicle identification information is carried over if you enter the Guided Component Test module either from the Scan Module or from one of the records stored in the Vehicle History module. However, you may need to enter additional attributes in some instances.

The vehicle identification sequence is menu driven, you simply follow the screen prompts and make a series of choices. Each selection you make advances you to the next screen.
7.1.1 Menu Options, Guided Component Test

Selecting the Toolbar Menu icon at the base of the screen offers the following options:

- **Safety Information**—opens the *Important Safety Instructions* document. See Safety Information on page v for additional information.
- **File**—allows you to print, save and set page settings of the data being viewed.
- **Help**—allows you to view supporting documentation. See Help Operations on page 173 for additional information.

**File**

Selecting **File** opens a menu of print options:

- **Print Article**—selecting has one of two results: (see Printing / Printer Setup on page 24)
  - If a printer is connected, the file is sent to the printer.
  - If a printer is not connected, the article is saved as a (.xps) file, which can be retrieved, moved, or copied and printed at a later time.
- **Print Preview**—opens a representation of what the printed file will look like.
- **Page Setup**—allows you to adjust margins and paper orientation.

7.1.2 Creating a Favorites List

Once a Guided Component Test database is loaded, a list of manufacturers displays. This list is often long and includes makes that are not frequently used. A toolbar at the top of the screen allows you to custom configure the manufacturer list to display only the makes you frequently service.

![Sample manufacturer list](image)

*Figure 7-1 Sample manufacturer list*
To configure a favorites list:

1. Select **Configure Favorites** on the toolbar.
   A list of selectable manufacturers displays.

2. Select each manufacturer you want to include, selected manufacturers are highlighted.

**NOTE:**
Manufacturers appear on the favorites list in the order in which they are selected. Therefore, if you select the makes you work on most frequently first, they will appear at the top of the list.

3. Select **Finished** on the toolbar once your selections have been made.
   The screen returns to the manufacturer list, but only the makes you selected display. Note the “Favorites” toolbar selection now reads “Full list”.

4. Select **Full List** on the toolbar to view the complete list of manufacturers.
5. Select **Back** on the toolbar at any time to return to the previous screen.

Your favorites list is what will display whenever a Guided Component Test database is started in the future. The list can be modified at any time by selecting Configure Favorites from the toolbar.

### 7.1.3 Identifying a Test Vehicle

Exact procedures to identify the test vehicle may vary somewhat by vehicle and market. The following procedure, which identifies a 2008 Ford Focus for testing the fuel injection system, is typical of what to expect.

To identify a vehicle for Guided Component Test:

1. Select the **Guided Component Test** Function icon from the Home screen.
2. Select which database to load for the test vehicle if requested (optional).
   After the database loads, a list of manufacturers displays.
3. Select **FORD** and a model year menu displays.
4. Select **2008** from the year menu and a list of available models displays. 
5. Select **FOCUS** from the model list and a list of available engines displays.
6. Select **2.0L** from the engine list and a confirmation dialog box displays (Figure 7-3).

![Figure 7-3 Sample confirmation dialog box](image)

7. From the confirmation dialog box, select **OK** to continue, or **Cancel** to return to the engine list. A list of tests available for the identified vehicle displays (Figure 7-4).

![Figure 7-4 Sample available tests list](image)

8. Select **FUEL INJECTION** and a fuel injection component test menu displays (Figure 7-5).
Guided Component Test Operations

Training and Classes

9. Select a test to continue.
   The identification sequence is now complete, refer to the Operations section that follows for
details on how to navigate through the Guided Component Test information and perform tests.

   **NOTE:**
   If you return to the Home screen and select **Scanner** or **Vehicle History** the vehicle identification
entered here is carried over. However, additional information may be needed for some modules.

### 7.2 Training and Classes

Training and Classes is a companion feature to the Guided Component Tests function, and can be
selected from the vehicle make menu.

This resource includes a wide collection of common (non-vehicle specific) reference information
and tests, such as measuring fuel pump current ramp, and monitoring CKP and CMP signals
simultaneously. Also included are; basic component operation and theory information, testing
procedures, tips, definitions, illustrations, diagnostic tool feature descriptions, and accessory
information.

Selecting **Training and Classes** (Figure 7-6) opens a list of the following options:

- **Features Benefits**
- **Power User Tests**
- **How To**
- **Snap-on Automotive Theory**
7.2.1 Features Benefits

Selecting Features Benefits opens a menu page that includes:

- **5-Minute Walk Thru With Demo Board**—explains how to use the optional demonstration board to generate sample signals.
- **Accessories**—opens a menu of optional equipment available.
- **Product Description**—provides descriptions and a brief overview of meter operations.

The demonstration board not only helps you learn how to use the Guided Component Test software, it allows you to hone your skills and diagnostic technique without an actual test vehicle.

7.2.2 Power User Tests

The Power User Tests option gives you quick access to a pre-configured meter for conducting a number of control system tests. Tests are available with or without on-screen help. Help typically provides a description of the test along with expected results and a link to the pre-set meter.

7.2.3 How To

The How To option provides a list of available on-screen instructions for performing tasks. Scroll to view the entire list. Typical topics include:

- **10-Minute Electronic Classes**—provides brief instruction in basic electronics and circuit connections.
- **15-Minute Ignition Classes**—provides an introduction to basic ignition testing.
- **Illustrated Terms & Definitions**—provides definitions of terms, drawings and tips associated with Guided Component Testing.
- **No-start Basics**—provides a guideline for diagnosing a no-start condition.
- **O2 Sensor & Feedback System Analysis**—displays the Guided Component Test meter in the “live” graphing mode with O2S test tips to help you understand the fundamental concepts of O2S diagnostics.
• Test Tips—gives on-screen instructions for performing specific Guided Component Tests along with drawings and tips.
• 20-Minute Current Ramp Classes—provides an introduction to current ramp testing.
• Minute Current Ramp Classes—provides an introduction to current ramp testing.
• Theory And Operation—provides basic theory and operation information for related components.

7.2.4 Snap-on Automotive Theory
Selecting the Snap-on Automotive Theory option provides you basic operation, theory and testing information on various systems such as:

• Air Conditioning
• Diesel Particulate Filters
• High-Intensity Discharge Headlights
• Supplemental Restraint Systems
• Diagnosing Battery Draws
• Electronic Parking Assistance Class
• LIN-Bus
• Tire Pressure Monitoring

7.3 Operations
The Guided Component Test software provides vehicle specific Guided Component Test procedures and information that aid in setting up scopes and meters. Once a test vehicle is identified, you can select a Guided Component Test from the list of available tests. For most selections two main choices are available on the component menu:

1. COMPONENT INFORMATION—provides information on the selected component and connector pin details that assists you in understanding the components prior to diagnosis.
2. TESTS—provides a pre-configured list of tests, guides you through performing the tests, and offers tips and resources to reduce setup and testing time.

7.3.1 Component Information
Component Information provides details on specific vehicle components to provide a better understanding of the components prior to diagnosis.

The Component Information screens contain information to assist you with testing. The screens are divided in sections to help quickly guide you to the correct information (Figure 7-7):

• Operation—provides a general description of normal component operation.
• Connector—displays the component connector and lists pin assignments.
• Location—identifies the component location and the best place for testing it.
• Tech note—provides Guided Component Test-related tips (for example, common failures or faults) as well as update or recall information.
To view component information:
1. Select a component from the tests list.
2. Select COMPONENT INFORMATION from the component menu.

NOTE:
An additional selection, such as front or rear for an oxygen sensor (O2S), may be required before advancing to the component information screen.

The component information screen displays (Figure 7-7).
3. Always Gesture sweep to view any additional information below what is visible.
4. Select Back at any time to return to the previous screen.

7.3.2 Tests

The Tests section guides you through the process of performing tests on a specific component. It also provides specifications, tips on how and where to connect the test meter leads, and also automatically configures the multimeter or lab scope to perform the selected test.

Once a test vehicle is identified, you can select a component from the available tests list.

To select a test:
1. Select a component from the list.
2. Select TEST to open the list.

NOTE:
More than one selection is available in some instances. For example, select Ignition Tests and a menu offering Primary Tests and Secondary Tests displays.

The list shows all of the tests available for the selected component, choices vary by make, model, and year.
Selecting opens an additional submenu similar to the one shown in Figure 7-8 when more than one option is available.

3. Select a test option and the test screen displays (Figure 7-9).

4. Gesture sweep to view any additional information.

5. Select Back at any time to return to the previous screen, or select Exit to return to the main component menu.
Hyperlinks

Guided component test screens contain hyperlinks that can either take you to another page containing additional information or open an additional window on top of the current screen. Hyperlinks display as icons. Common hyperlinks are:

- **View Meter**—opens a live meter set up to perform the test in the lower portion of the screen (Figure 7-10). Once the meter view is open, the Guided Component Test toolbar at the top of the screen is replaced by the Scope Multimeter toolbar, which allows you to make adjustments to the settings. See Scope Multimeter Toolbar on page 125 for details.
- **Show More Information**—advances to a new screen with more detailed information about a particular test, select **Back** to return to the test screen.

**View Meter**

A Meter icon, which is only available in the Guided Component Test view meter mode, appears on the upper toolbar (Figure 7-10).

![Sample view meter window](image)

Figure 7-10 Sample view meter window

Three view meter options are available:

1. With View Meter active (Figure 7-10), select the **Meter** icon on the toolbar once and the meter expands to fill the entire screen.
2. Select the **Meter** icon a second time and the meter open as a separate window (Figure 7-11). This window can remain open if you switch to the Scan Module and can be accessed from the Windows toolbar at the bottom of the screen. You can also resize and reposition the meter window on the screen.
Guided Component Test Operations

Operations

Figure 7-11 Sample meter view in a separate window

Selecting the Close icon (red box with an X) when viewing the meter in a separate window closes the meter and returns you to the Guided Component Test screen.

3. Select the Meter icon a third time to close the separate window and return to the standard meter view as shown in Figure 7-10.

Select Exit from the toolbar to close meter view and return to the Guided Component Test screen.

Connecting to a Test Vehicle

Before performing a test, you must connect the meter test leads to the vehicle. Certain Guided Component Tests require the use of specific leads. Information on specific leads and other connecting information displays on the initial test screen. Follow the on-screen connection instructions in the test procedure to connect the test leads.

Performing a Test

Once you connect the test leads to the vehicle, you can proceed with testing.

To perform Guided Component Tests:

1. Follow the instructions displayed in the test procedure section.
2. Gesture sweep to view all of the instructions and follow the on-screen procedures.
3. Select the View Meter hyperlink to display test results.
4. Refer to the on-screen information to verify test results.
This chapter describes the controls, basic operation and the remote wireless setup of the M2 Scope/Meter.

8.1 Overview

The M2 Scope/Meter is a digital graphing multimeter and wireless communications device. The unit can be used as a stand-alone meter, or configured to transmit data to the VERDICT D7 Diagnostic Tool without a physical connection.

The M2 Scope/Meter is powered by its internal battery pack, or can be powered using the supplied AC power supply.

1— DC Power Supply Input Jack
2— Color Graphic Display Screen
3— Soft Keys for Selecting Additional Functions
4— Rotary Switch for Selecting Primary Functions
5— Common (Ground) Lead Input Jack
6— Channel 1 (Red) Lead Input Jack
7— Channel 2 (Green) Lead Input Jack

Figure 8-1 Model M2 Scope/Meter
8.2 M2 Scope/Meter Controls, and Features

There are two sets of controls for the M2 Scope/Meter:

1. **Soft Keys**—select test functions, which vary depending upon the Rotary Switch position
2. **Rotary Switch**—establishes the primary operation of the unit

![M2 Scope/Meter Controls Diagram](image)

The following sections describe the external controls and features of the M2 Scope/Meter.
8.2.1 Rotary Selector Switch

The M2 Scope/Meter is a combination digital-multimeter (DMM) and waveform viewer, capable of reading volts (AC and DC), resistance (ohms), capacitance (farads), continuity, diode forward voltages, and external auxiliary probes, as well as viewing dynamic voltage graphs (waveforms). The Rotary Selector Switch on the front panel determines which measurements are taken.

The available functions are represented by graphics on the face of the tool. Descriptions of the functions are given in the following table:

<table>
<thead>
<tr>
<th>Table 8-1 M2 Scope/Meter rotary switch settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Off</td>
</tr>
<tr>
<td>Volts DC</td>
</tr>
<tr>
<td>Volts AC</td>
</tr>
<tr>
<td>Resistance</td>
</tr>
<tr>
<td>Continuity/ Diode Check</td>
</tr>
<tr>
<td>Auxiliary</td>
</tr>
<tr>
<td>Capacitance</td>
</tr>
<tr>
<td>Oscilloscope (Waveform Viewer)</td>
</tr>
<tr>
<td>Remote Functions</td>
</tr>
</tbody>
</table>
8.2.2 M2 Scope/Meter Soft Keys

The eight soft keys located above the rotary dial on the M2 Scope/Meter are used to initiate a variety of additional functions while performing meter tests. The functionality of the soft keys varies according to what type of tests are being performed, as determined by the position of the rotary switch. Some of the soft keys do not function for certain test modes.

The table below gives a brief general description of soft key operations, the “Mode” column lists the tests during which the key is active. More detailed information is found in the categorical sections that follow.

Table 8-2 M2 Scope/Meter Soft Key functions

<table>
<thead>
<tr>
<th>Name</th>
<th>Key</th>
<th>Description</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>F1</td>
<td>Switches the displayed value between a “normal” and relative reading.</td>
<td>Volts DC, Volts AC, Resistance, Auxiliary</td>
</tr>
<tr>
<td>F2</td>
<td>F2</td>
<td>Freezes, or pauses, the data being displayed. A second push returns the display to live data.</td>
<td>All except Continuity and Diode Check</td>
</tr>
<tr>
<td>F3</td>
<td>F3</td>
<td>Changes the measurement range when operating in the Volts DC, Volts AC, Resistance, Auxiliary, or capacitance range. Changes the time base when operating in the graph mode.</td>
<td>Volts DC, Volts AC, Resistance, Capacitance</td>
</tr>
<tr>
<td>F4</td>
<td>F4</td>
<td>Select special functions when operating in oscilloscope mode.</td>
<td>Waveform Viewer</td>
</tr>
<tr>
<td>S</td>
<td>S</td>
<td>The Special Functions key switches the displayed value between frequency, duty cycle, and pulse width, and selects a continuity or diode test. Also selects submenus when operating in oscilloscope mode.</td>
<td>Volts DC, Volts AC, Waveform Viewer</td>
</tr>
<tr>
<td>Min/Max</td>
<td>Min Max</td>
<td>The Min/Max key displays the minimum and maximum sampled signal values along with the current value.</td>
<td>All except Continuity and Diode Check, Capacitance</td>
</tr>
<tr>
<td>Range</td>
<td>Range</td>
<td>The Range key switches between the precision of the displayed value between the four available ranges.</td>
<td>All</td>
</tr>
<tr>
<td>Graph</td>
<td>Graph</td>
<td>The Graph key switches the display from a digital readout to a histogram, or graph.</td>
<td>Volts DC, Volts AC, Auxiliary</td>
</tr>
</tbody>
</table>

In general, a short or momentary push of a soft key activates the assigned function, a long push returns to the normal display.
8.3 M2 Scope/Meter Operations

This section details the digital multi-meter (DMM) features available based on the Rotary Selector Switch position.

8.3.1 Volts DC

The Volts DC setting is used for measuring direct current (DC) voltages within a range of zero to 1000 volts, frequency, duty cycle, and pulse width.

A typical Volts DC screen with Min/Max active is shown in Figure 8-4. Note the functions of the F1, F2, and F3 soft keys are shown at the bottom of the display screen. The F4 soft key is not operational in the Volts DC mode, although the beeper does sound if the key is pressed.
**F1 Key, Relative**

The lower numbers shown in Figure 8-4 do not display when you first select the Volts DC function. The DMM takes a “snapshot” of the current reading and holds it on the display when the F1 key is momentarily pressed. A “relative” value, which is continuously updated and shows the relationship between the initial reading and the most current reading, now displays as well. Additional momentary presses of the F1 key record new snapshots that replace the previous base reading. Press and hold the F1 key to cancel the relative function.

**Alternate F1 Menu**

There is a special alternate menu that is available by pressing and holding the F1 key for several seconds while in Volts DC mode (Figure 8-5). This menu allows you to modify three settings:

- Beeper functions
- Display backlighting
- Display screen colors

![Figure 8-5 Sample active menu select mode screen](image)

Each of these operations are explained below, a second long press of the F1 key returns the display to the normal mode. The F4 key is nonfunctional in the alternate menu mode.

Pressing **F1** from the alternate menu switches the internal beeper used for the continuity test and to indicate soft key pushes on and off. The beeper function remains “on” to indicate low battery conditions and other special functions like loss of contact with the remote device.

Pressing **F2** from the alternate menu changes the intensity of the LCD display backlight. Each key push advances to the next level of intensity, then returns to the lowest level once maximum brightness is reached. The backlight never turns completely off. There are five intensity levels for the backlight.

Pressing **F3** from the alternate menu switches between the two available combinations of screen background and character colors. One is light characters on a dark background and the other is dark on light.
F2 Key, Freeze
A press of the F2 key freezes, or so that the displayed value remains static. A second press of the F2 key returns to unit to normal operation. This function is available in normal and relative modes.

F3 Key and Range Key
Pressing the F3 and Range keys changes the measuring range. Measuring ranges vary by which function (Volts DC, Volts AC, Resistance, Auxiliary) is selected. A long press of the F3 or Range key returns to unit to auto-range operation. This function is available in normal and relative modes.

Min/Max Key
Press the Min/Max key and the display shows both the instantaneous voltage reading and the minimum and maximum voltages that occurred since the last time the key was pressed. See Sample active menu select mode screen on page 96.

The displayed values continue to update until the Min/Max key is pressed again, then:
- A short press of the Min/Max key resets the readings
- A long press of the Min/Max key returns to normal Volts DC mode.

S Key, Special Functions
The S key is used to activate special time measurement functions available when sampling voltage. Each press of the S key advances to the next function in the following order:
1. The screen changes to show the frequency, period, and duty cycle of the test signal.
2. The screen changes to show the frequency, period, and pulse width of the test signal.

When displaying frequency, the period (abbreviated PRD on the screen) represents the percentage of the duty cycle, or the “on time” of the signal. Readings are displayed in milliseconds. The Freeze (F2) and Range (F3) soft keys remain active in this mode. Figure 8-6 shows a typical frequency display following a single press of the S Key. Press the S Key a second time and the duty cycle (DTY) reading changes to show the pulse-width (PWD) of the signal in milliseconds.

Figure 8-6 Sample Frequency display
NOTE:
Press and hold the S key at any time to instantly return the display to a voltage reading.

In this special time measurement mode, the readings shown on the screen are integrated, or filtered. This means that the displayed values show average time-based measurements with great accuracy, but do not capture fast signal anomalies such as instantaneous “glitches” or timing shifts. However, these types of fast signal changes can be seen using the Graph key.

**Graphing Voltage Measurement Screens**

The M2 Scope/Meter can generate a graphical history of a voltage signal over time, which is called a histogram. Pressing the Graph button when operating in Volts DC or Volts AC range causes the display to change from a digital reading to a graphical display.

While viewing a histogram, the function keys operate as follows:

- **F1**—switches peak detection on and off
- **F2**—freezes and unfreezes the histogram (pauses and resumes data collection).
- **F3**—incrementally increases the measurement range. The **Range** key incrementally decreases the measurement range.
- **F4**—incrementally increases the timescale of the histogram. The **Graph** key incrementally decreases the timescale.

A digital value of the signal displays in the upper-right corner of the display while operating in graphing mode.

**Graphing with Min/Max Function**

In the Volts DC graphing function you can capture and store the minimum and maximum voltages by pressing the Min/Max soft key. The readings appear in the upper-left portion of the LCD. The M2 Scope/Meter captures and reports very fast events (as fast as 50 microseconds) in this mode, which is only available in Volts DC.

Press the Min/Max key and the display shows both the instantaneous voltage reading (large characters) and the minimum and maximum voltages that occurred since the last time the key was pressed. The displayed values continue to update until the “Min/Max” key is pressed again. Then the values reset the readings on the display begin the process again. Press and hold the Min/Max key to cancel this function, and return to the normal volts DC mode.

**To exit graph mode:**

- Press and hold the **Graph** key for two seconds.
Graphing Time-Based Measurement Screens

To access time-based measurement graphs:

1. Press the Graph key.
2. Press the S key.

The M2 Scope/Meter is now in time-based measurement mode.

In this mode, the M2 Scope/Meter uses a specialized strategy called "cycle-by-cycle" (C-B-C) time-based measurements to capture signal glitches. To do this, the M2 Scope/Meter examines each cycle of the signal under test, calculates its period, duty cycle and pulse width, and generates a graphical history of that signal (called a histogram). Any significant variation of the signal is visible on the histogram.

When you initially enter this mode, the system shows frequency histograms (the default setting). A press of the S key switches the display from frequency to duty cycle. A second press of the S key switches the display from duty cycle for pulse width.

There three items displayed on the LCD in the graph mode:

- A histogram of the signal being measured displays across the screen
- The averaged result of the timing measurement appears on the upper-right side of the screen
- The minimum and maximum value readings display on the upper-left side of the screen (after first pressing the Min/Max key).

Range

A press of either the Range or F3 key takes the meter out of the automatic voltage scale function and allows you to change the voltage scale or resolution. Subsequent key presses switches the display between the available ranges. Press and hold the Range key to cancel this function and return to automatic range operation.

8.3.2 Volts AC

When sampling AC voltage the soft keys function the much the same as for DC voltage. However, there are some differences. Brief explanations are provided below, refer to Volts DC on page 95 for more detailed descriptions.
F1 Key
The F1 key switches between normal and relative readings. A short push of the key resets the reading, a long push opens the alternate menu.

F2 Key
A single press of the F2 key pauses, or freezes, the displayed voltage. A second press returns the display to normal mode.

F3 Key
Short pushes of the F3 and Range keys incrementally increase and decrease the selected measurement range respectively. These keys are active in both the standard Volts AC and histogram modes.

F4 Key
The F4 key is nonfunctional in this mode.

S Key
Pressing the S key activates the time management functions to display frequency, duty cycle, and pulse width. A long press of the key returns to the normal display mode.

Min/Max Key
Pressing the Min/Max key causes minimum and maximum readings to display along with the current value. A long press of the key returns to the normal display mode.

Range Key
A press of the F3 or Range keys changes the voltage scale or resolution of the display. Each key press incrementally advances through the available settings. A long press of the Range key returns to display to the automatic range.

Graph Key
Pushing the Graph key generates a histogram that graphically shows the various values of the voltage measurements taken.

The Range and F3 keys can be used to change the measurement range. When Range is pressed, the current histogram erases and a new graph starts building from zero.

Pressing the F4 and Graph keys while in Graph mode changes the sweep rate, or the time represented by the width of the screen.

A “long press” of the “Graph” key returns the unit to the normal “Volts AC” function.
8.3.3 Resistance

This setting allows you to measure the DC resistance to current in Ohms. When sampling resistance the soft keys function much the same as for DC or AC voltage. Brief explanations are provided below, refer to Volts DC on page 95 for more detailed descriptions.

![Figure 8-8 Resistance selected](image)

**F1 Key**
The F1 key switches between normal and relative readings. A short push of the key resets the reading, a long push opens the alternate menu.

**F2 Key**
A single press of the F2 key pauses, or freezes, the displayed value. A second press returns the display to normal mode.

**F3 Key and Range Key**
A short push of the F3 or Range key changes the selected measurement range.

**F4 Key and S Key**
The F4 and S Keys are nonfunctional in this mode.

**Min/Max Key**
Pressing the Min/Max key causes minimum and maximum readings to display along with the current value. A long press of the key returns to the normal display mode.
8.3.4 Continuity and Diode Check

This setting allows you to perform circuit continuity tests, and perform a forward drop test to check the operation of a diode.

![Continuity and diode check selected](image)

The S key is the only soft key that is operational in continuity and diode mode. Pressing the S key switches between the continuity test and diode test settings. Continuity is the default setting.

When testing continuity, the M2 Scope/Meter sounds a beep if a short circuit is detected (continuity between the two test leads).

When testing a diode, the M2 Scope/Meter induces a current to the device under test and measures the resultant voltage drop across the device.

8.3.5 Auxiliary

This selection allows you to select between three auxiliary tests; current (amperes), temperature, and pressure. Approved probes, sensors, and transducers must be used in order to obtain valid measurements.

![Sample auxiliary selected](image)
Brief explanations of the soft key functions are provided below, refer to Volts DC on page 95 for more detailed descriptions.

**F1 Key**
The F1 key switches between normal and relative readings. A short push of the key resets the reading, a long push opens the alternate menu.

**F2 Key**
A single press of the F2 key pauses, or freezes, the displayed value. A second press returns the display to normal mode.

**F3 Key and Range Key**
The F3 and Range keys select the measurement range, which varies with the selected function:
- **Current**—switches the scale between available settings for AC Amp and DC Amp probes.
- **Temperature**—switches between displaying degrees Celsius and degrees Fahrenheit.
- **Pressure**—switches between displaying pressure as pounds-per-square-inch (PSI) and vacuum as inches-of-mercury (inHg).

**F4 Key**
The F4 key is nonfunctional in this mode.

**S Key**
The S key is used to switch between the three different test modes (amperage, temperature, and pressure) available in the auxiliary setting. Each key press advances to the next available mode.

**Min/Max Key**
Pressing the Min/Max key causes minimum and maximum readings to display along with the current value. A long press of the key returns to the normal display mode.

**Graph Key**
Pushing the Graph key generates a histogram that graphically shows the various values of the measurements taken.

The Range and F3 keys can be used to change the measurement range. When Range is pressed, the current histogram erases and a new graph starts building from zero.

Pressing the F4 and Graph keys while in Graph mode changes the sweep rate, or the time represented by the width of the screen.

A “long press” of the “Graph” key returns the unit to the normal “Auxiliary” function.
8.3.6 Capacitance

This selection is used to measure capacitance.

![Figure 8-11 Sample capacitance selected](image)

**F1 Key**

Relative readings are not available in this mode. A short push of the F1 key does cause a beep to sound, but the display remains unchanged. A long push of the F1 key opens the alternate menu.

**F2 Key**

A single press of the F2 key pauses, or freezes, the displayed value. A second press returns the display to normal mode.

**F3 Key and Range Key**

The F3 and Range keys select the measurement range.

**F4 Key, S Key, Min/Max Key, and Graph Key**

The F4, S, Min/Max, and Graph keys are nonfunctional in this mode.
8.3.7 Oscilloscope

The M2 Scope/Meter has the ability to provide a two-channel oscilloscope, or waveform viewer. The viewer becomes active when the rotary switch is turned to the “scope” position.

![Sample oscilloscope rotary switch icon](image1)

![Sample scope setting](image2)

Soft key functions are unique when performing oscilloscope tests. In this mode there are seven available setting ranges for the F2, F3, and F4 keys. Pressing the F1 key scrolls up through the list of settings, and pressing the S key scrolls down through the list. The F1 area on the screen shows which of the six settings is currently active (Figure 8-14). Available scope functions are shown in the table below:

<table>
<thead>
<tr>
<th>Setting</th>
<th>F1 Key</th>
<th>S Key</th>
<th>F2 Key</th>
<th>F3 Key</th>
<th>F4 Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td></td>
<td>Scroll up</td>
<td>Freeze</td>
<td>Scale</td>
<td>Time</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td>Slope</td>
<td>Level</td>
<td>Channel</td>
</tr>
<tr>
<td>Preset A</td>
<td>Scroll up</td>
<td>Scroll down</td>
<td>GCi&amp;S†</td>
<td>LF AC†</td>
<td>HF AC†</td>
</tr>
<tr>
<td>Preset B</td>
<td></td>
<td></td>
<td>PCI&amp;S†</td>
<td>LF DS†</td>
<td>HF DS†</td>
</tr>
<tr>
<td>Special</td>
<td></td>
<td></td>
<td>Peak</td>
<td>Invert</td>
<td>Coupling</td>
</tr>
<tr>
<td>Position</td>
<td></td>
<td></td>
<td>Move Ch1 Trace</td>
<td>Move Ch2 Trace</td>
<td>Not Used</td>
</tr>
<tr>
<td>Channel</td>
<td></td>
<td></td>
<td>Display Ch1</td>
<td>Display Ch2</td>
<td>Check scales</td>
</tr>
</tbody>
</table>

† See page 108 for acronym definitions
Display Selections

With the scope in the display mode the soft keys perform the following functions:

- **F2**—the first press pauses data collection to allow closer examination of the waveform, the second press restores data collection.

- **F3 and Range**—each press of the F3 key advances up to the next available scale, which is the value of the voltage displayed vertically on the screen. The currently selected scale is shown at the top of the screen. The Range key moves incrementally down through the list of available scales.

- **F4 and Graph**—each press of the F4 key advances to the next timebase, or sweep rate, which is the time represented on the width of the display. The currently selected timebase is shown at the top of the screen. Use the Graph key to move incrementally down through the list of available time bases. Press and hold the F4 key to return to the default setting.

![Sample display screen](image_url)

1 — Mode
2 — Scale
3 — Timebase

*Figure 8-14 Sample display screen*
Trigger Selections

Triggering allows you to set the scope so that it begins sampling and displaying a trace once predetermined signal conditions, or triggers, are met. Triggering produces a much more stable waveform. The trace always begins at the trigger point, so the image does not appear to flicker or drift as it updates.

1— Mode
2— Trigger channel
3— Trigger slope
4— Trigger level

With the scope in the trigger mode the soft keys perform the following functions:

- **F2 Slope**—pressing the F2 key switches triggering back and forth between the rising (positive) edge and trailing (negative) edge of the waveform. A graphic in the upper-right corner of the display screen shows the currently selected slope.

- **F3 Level**—short presses of the F3 key incrementally increase the trigger voltage level. An indicator to the right of the screen graph shows the current trigger voltage level. Short presses of the Range key incrementally decrease the trigger voltage level. Press and hold either key (F3 or Range) to return to the default setting.

- **F4 Channel**—a press of the F4 key switches triggering between channel 1 (CH1) and channel 2 (CH2). The channel currently selected for triggering is shown at the top of the screen.

**NOTE:**
Triggering is not available when the timebase setting is between 1 second and 10 seconds.
Preset Selections

These options allow you to select from already configured scope setups for commonly tested items. Six preset configurations are available; three for Preset A and three for Preset B. These preset conditions are permanent and cannot be erased or modified. However, you can construct and store additional presets within the D7 Diagnostic Tool as explained in the Scope and Multimeter chapter of this manual.

To select a preset:
1. Use the F1 or S key to navigate to either Preset A or Preset B.
2. Press F2, F3, or F4 to load the desired preset.

The selected preset loads and the meter is ready for testing.

The F2, F3, and F4 fields on the screen are acronyms for the type of test the preset is configured to perform. Interpret as follows:

- **Preset A:**
  - CGI&S—ground controlled injectors and solenoids
  - LF AC—low frequency alternating current signals
  - HF AC—high frequency alternating current signals

- **Preset B:**
  - PCI&S—power controlled injectors and solenoids
  - LF DS—low frequency digital signals
  - HF DS—high frequency digital signals

Values for the available presets are shown in the table below.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Position</th>
<th>Timebase</th>
<th>Scale</th>
<th>Trigger</th>
<th>Coupling</th>
<th>Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset A</td>
<td>F2 (CGIS)</td>
<td>10 mS</td>
<td>50 Volts</td>
<td>8 Volts</td>
<td>DC</td>
<td>Negative</td>
</tr>
<tr>
<td></td>
<td>F3 (LF AC)</td>
<td>50 mS</td>
<td>20 Volts</td>
<td>0 Volt</td>
<td>AC</td>
<td>Positive</td>
</tr>
<tr>
<td></td>
<td>F4 (HF AC)</td>
<td>10 mS</td>
<td>20 Volts</td>
<td>0 Volt</td>
<td>AC</td>
<td>Positive</td>
</tr>
</tbody>
</table>
Special Selections

The Special settings allow you to alter the way the trace is displayed in order to readily spot signal anomalies and to compare signals. A short push of the F2, F3, or F4 key activates the indicated special mode, a long push of the key cancels the special mode.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Position</th>
<th>Timebase</th>
<th>Scale</th>
<th>Trigger</th>
<th>Coupling</th>
<th>Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset B</td>
<td>F2 (PCI&amp;S)</td>
<td>10 mS</td>
<td>50 Volts</td>
<td>8 Volt</td>
<td>DC</td>
<td>Positive</td>
</tr>
<tr>
<td></td>
<td>F3 (LF DS)</td>
<td>50 mS</td>
<td>20 Volts</td>
<td>3 Volt</td>
<td>DC</td>
<td>Positive</td>
</tr>
<tr>
<td></td>
<td>F4 (HFDS)</td>
<td>10 mS</td>
<td>20 Volts</td>
<td>3 Volt</td>
<td>DC</td>
<td>Positive</td>
</tr>
</tbody>
</table>

**Peak**

Pressing the F2 key switches on the peak capture function, which allows you to see very fast signal transitions or glitches. When peak capture is active, “P1” displays at the top of the screen. During normal operation, the scope collects just enough data samples to plot a waveform across the screen. When peak is active the scope samples data at the maximum highest rate, which collects more data than what is needed to simply construct a waveform across the screen. Therefore, any signal glitches or fast events are captured.

**Invert**

Pressing the F3 key inverts, or switches, the polarity of the signal trace so that it appears upsidedown on the screen. This is typically used to sample amperage or high-voltage signals.

**Coupling**

Pressing the F4 key switches the input to the meter from DC coupling (default) to AC coupling. In this mode the average value of the waveform is subtracted so that small signal variations become apparent. AC coupling blocks the DC portions of an input signal in order to amplify the AC portions without driving them off of the screen. Use for viewing alternator ripple or fuel pump amperage.
Position Selections

The Position selections allow you to reposition the baselines of the channel 1 and channel 2 traces vertically on the screen.

![Sample screen with both traces repositioned](image)

**Channel 1 Trace**

Use the F2 and Min/Max keys to reposition the channel 1 trace as follows:

- Short pushes of the F2 key moves the trace incrementally up.
- A long push of the F2 key places the trace at the midpoint of the scale.
- Short pushes of the Min/Max key moves the trace incrementally down.
- A long push of the Min/Max key places the trace at 10% of the scale.

**Channel 2 Trace**

Use the F3 and Range keys to reposition the channel 2 trace as follows:

- Short pushes of the F3 key moves the trace incrementally up.
- A long push of the F3 key places the trace at the midpoint of the scale.
- Short pushes of the Range key moves the trace incrementally down.
- A long push of the Range key places the trace at 10% of the scale.
Channel Selections

The channel selection mode allows you to switch the trace on and off. The F2 key controls the channel 1 trace and the F3 key controls the channel 2 trace. Pressing the key the first time turns this channel "off" and the sweep signal is removed from the display. Pressing the key a second time puts this channel back onto the display. The previous characteristics for this channel are saved during this process. The indicator at the base of the screen appears as inverse video (white lettering on a black background) when a channel is on.

Figure 8-19 Sample screen with channel 1 on and channel 2 off

8.4 M2 Scope/Meter Remote Operation

The M2 Scope/Meter can be used remotely (wireless connection), allowing you to operate your M2 Scope/Meter using your Diagnostic Tool.

The M2 Scope/Meter needs to be paired (connected) to the Diagnostic Tool for remote operation. The following procedures describe the configuration and setup of the M2 Scope/Meter for remote use with a Diagnostic Tool.

8.4.1 Remote Functions Setting

The Remote Functions setting is used to setup and connect the M2 Scope/Meter to the Diagnostic Tool (Figure 8-20).

The rotary switch Remote Functions setting is used:

• To pair the M2 Scope/Meter to the Diagnostic Tool, see M2 Scope/Meter Remote Operation on page 111.
• To remotely connect the M2 Scope/Meter to the Diagnostic Tool, see M2 Scope/Meter Remote Operation on page 111.
8.4.2 Pairing the M2 Scope/Meter

Pairing is the wireless connection (identification) process used to connect the M2 Scope/Meter to your Diagnostic Tool. The M2 Scope/Meter needs to be paired (connected) to the Diagnostic Tool for remote operation.

The M2 Scope/Meter only needs to be paired once before its initial use. The connection configuration should remain in memory for all future uses. If the connection configuration is removed or lost the pairing procedure will need to be repeated.

Before pairing, make sure the M2 Scope/Meter and the Diagnostic Tool have fully charged batteries, or are connected to their AC power supplies. It is highly recommended that both devices be powered by their respective AC power supplies during the pairing operation. The two devices to be paired should also be in close proximity to each other, and in an area that is relatively free of radio frequency interference.

NOTE:

The M2 Scope/Meter can only be paired with one Diagnostic Tool at a time.

To pair the M2 Scope/Meter with the Diagnostic Tool:

1. Turn on the Diagnostic Tool and M2 Scope/Meter.
2. Set the M2 Scope/Meter Rotary Switch to the oscilloscope position.
3. Press and hold the F1 key of the M2 Scope/Meter to open the alternate menu. An alternate menu option for the F4 key is now displayed.
4. Press the F4 key (once) to enable Bluetooth Discovery. Enabling Bluetooth Discovery allows the M2 Scope/Meter to be identified and paired to the Diagnostic Tool.

The F4 field on the screen switches to inverse video (white on black) when the Bluetooth Discovery mode becomes enabled (Figure 8-21).
5. With Bluetooth Discovery enabled, turn the M2 Scope/Meter Rotary Switch to the Remote Functions position (Figure 8-22).

6. Select the **System Settings** icon on the Home screen of the Diagnostic Tool.
7. Select **Paired Devices** from the menu.
8. From the Paired Devices menu select **Add** from the toolbar.
9. When prompted select **OK** from the toolbar.

The Diagnostic Tool searches for compatible wireless devices, then displays the results. The M2 Scope/Meter is typically listed as "VERDICT M2-" plus six digits of the unit’s serial number.
10. Select the **M2 Scope/Meter** from the search results list (Figure 8-23).

![Typical Device selection](image1)

**Figure 8-23 Typical Device selection**

A “in progress” message displays during the pairing procedure, which takes several seconds. The Paired Devices screen displays once the procedure completes (Figure 8-24).

![Typical Paired Devices screen](image2)

**Figure 8-24 Typical Paired Devices screen**

11. Select the **Home** icon on the toolbar to return to the Home screen.

12. After the M2 Scope/Meter has been successfully paired, turn the M2 Scope/Meter **Rotary Switch** to the oscilloscope position.

13. Press and hold the **F1** key to open the alternate menu.

14. Press the **F4** key (once) to turn off (disable) Bluetooth Discovery mode.

   The F4 field on the screen switches to normal video (black on white) when the Bluetooth Discovery mode is inactive (Figure 8-25).
Once the M2 Scope/Meter is initially paired with the Diagnostic Tool, additional pairing is not necessary. Although the discovery mode has been disabled, the two-paired devices automatically seek and find each other when they are both powered on. The M2 Scope/Meter becomes “invisible” to other Bluetooth devices whenever Bluetooth Discovery is disabled.

8.4.3 Remote Operation (Once paired)

Once the M2 Scope/Meter has been paired to the Diagnostic Tool, the M2 Scope/Meter can be remotely connected and operated at anytime using your Diagnostic Tool. This allows you to use the M2 Scope/Meter in stand-alone mode and quickly switch to remote mode as needed.

The M2 Scope/Meter transmits data wirelessly to your Diagnostic Tool, allowing you to use your Diagnostic Tool display to view and control the M2 Scope/Meter.

To remotely operate the M2 Scope/Meter with the Diagnostic Tool:

1. Set the M2 Scope/Meter Rotary Switch to the Remote Functions position (Figure 8-26). When the Rotary Switch is set to the Remote Functions position the M2 Scope/Meter will attempt to communicate with a paired Diagnostic Tool. If the M2 Scope/Meter is paired with a Diagnostic Tool, it will automatically connect to it, if within range.
When the M2 Scope/Meter is connected to the Diagnostic Tool, all soft key controls on the M2 Scope/Meter are inoperative, as all controls of the M2 Scope/Meter are transferred to the Diagnostic Tool. Turning the Rotary Switch off of the Remote Functions position returns control to the M2 Scope/Meter and the soft keys regain their functionality.

2. Select **Scope Multimeter** on the Diagnostic Tool.

3. Select the desired **Scope Multimeter** function, (Lab Scope, Digital Multimeter, etc.).

The M2 Scope/Meter screen will change to indicate the devices are communicating, see **Remote Working Range / Communication Screens** on page 117.

The M2 Scope/Meter Diagnostic Tool Hardware Status indicators in the lower-right corner of the Home screen also provide a quick reference to device status. The background color of the status indicator icon represents the condition of the wireless connectivity. Icon status is shown in the table below:

<table>
<thead>
<tr>
<th>Hardware Icon</th>
<th>Background Color</th>
<th>Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Red" /></td>
<td>Red</td>
<td>Not Paired</td>
<td>Pair the M2 to the Diagnostic Tool. See <strong>Pairing the M2 Scope/Meter</strong> on page 112 for instructions.</td>
</tr>
<tr>
<td><img src="image" alt="Grey" /></td>
<td>Grey</td>
<td>Paired, but Not Communicating</td>
<td>You may have moved out of range. Move the M2 closer to the Diagnostic Tool to reestablish communications.</td>
</tr>
<tr>
<td><img src="image" alt="Blue" /></td>
<td>Blue</td>
<td>Paired, and Communicating</td>
<td>Hardware status is good and Bluetooth is communicating.</td>
</tr>
</tbody>
</table>

4. Connect the M2 Scope/Meter leads as needed. For M2 Scope/Meter operation, see **M2 Scope/Meter Operations** on page 95 and for Diagnostic Tool Scope Multimeter operation, see **Scope Multimeter Operations** on page 118.
Remote Working Range / Communication Screens

When the M2 Scope/Meter Rotary Switch is positioned in the Remote Functions position and the Diagnostic Tool is turned on, a communication indicator screen is displayed. One of two screens are used to indicate the current communication status of the M2 Scope/Meter:

The working range of the transmitter is about 30 feet (9.14 m). A signal lost due to moving out of range automatically restores itself when the Diagnostic Tool is brought closer to the M2 Scope/Meter. The M2 Scope/Meter will sound an audible alarm “beep” and the Diagnostic Tool will display a warning message when the signal is lost.

A red graphic image indicates that the devices are paired, but not communicating (Figure 8-27).

If the two devices are out of range of each other, the paired, not communicating screen displays on the M2 Scope/Meter and a message displays on the Diagnostic Tool. This is a self-correcting condition, simply bring the two units closer together and the communications link will reestablish itself momentarily.

A blue graphic image indicates that the devices are paired, and communicating (Figure 8-28).

When the M2 Scope/Meter function is selected on the Diagnostic Tool, the M2 screen changes to indicate the devices are communicating. A screen with a blue graphic image indicates the two paired devices are connected and capable of communicating with each other.
Chapter 9

Scope Multimeter Operations

When used in conjunction with the M2 Scope/Meter the Scope Multimeter module provides all the tools needed for performing electrical and electronic circuit tests and for monitoring signals and circuit activity. The Scope Multimeter works interactively with other modules. Selecting “View Meter” from a Guided Component Test or Scanner Test starts the Scope Multimeter module.

The M2 Scope/Meter is designed to work with the high-voltage hybrid vehicle batteries and circuits, which makes it a Measurement Category III and IV meter and raises additional safety concerns. For your safety, adhere to the safety messages posted below and those in the accompanying Important Safety Information.

**WARNING**

Risk of electrical shock.
- This product is intended for Measurement Category III (1000V) and IV (600V).
- Do not exceed voltage limits between inputs as indicated on the rating label.
- Use extreme caution when working with circuits that have greater than 40 volts DC or 24 volts AC.
- Do not connect Inductive RPM Pickup, Secondary Ignition Clip-on Wire Adapter, or any other probe to a damaged or un-insulated conductors.
- Always wear properly rated rubber insulated gloves when required or appropriate, particularly when working with voltages exceeding 40 volts DC or 24 volts AC.
- Use only appropriate (Category III or IV) Snap-on components, such as test leads, scope leads and auxiliary components with meter and scope products. Do not use aftermarket “equivalents” or alternate leads of unknown origin.
- Use only Snap-on suggested components that are in good working order. Do not use components that show extreme wear or are visibly damaged. Make sure the components are properly rated for the task.
- Always examine the instrument for signs of damage before use. Do not use devices that show cracks or other defects that may allow for high voltage exposure.

*Electrical shock can cause personal injury, equipment damage, or circuit damage.*

**CAUTION**

Risk of equipment or circuit damage.
- **Read the Safety Information provided for important warnings on the use of this product**
- Disconnect test leads from any circuit being tested before changing functions. Always disconnect the live test lead before disconnecting the common test lead.
- Never perform resistance, diode, or polarity tests on a live circuit.
- Unless specifically directed by the test procedure, make sure the ignition is off before connecting or disconnecting connectors or any vehicle electrical terminals.
- Remove the amp probe when not in use.
- Do not create an electrical connection between battery terminals with a jumper wire, or your scopes and/or meters.
- Do not ground any electrical terminal that has or may have power.
- Do not allow battery gases or acid to contact tester housing.

*Improper use can cause equipment or circuit damage.*
9.1 Getting Started

The Scope and Multimeter module enables the VERDICT to function as a digital multimeter (DMM), a graphing multimeter, and a 2-channel oscilloscope when the Diagnostic Tool is wirelessly linked to the M2 Scope/Meter.

9.1.1 Capabilities

The following tables detail the software and hardware capabilities.

Table 9-1 Multimeter (sheet 1 of 2)

<table>
<thead>
<tr>
<th>Function</th>
<th>Range</th>
<th>Resolution</th>
<th>Accuracy</th>
<th>Impedance/Protection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volts DC</td>
<td>40mV</td>
<td>0.01mV</td>
<td>±(1.0% of reading + 3 digits)</td>
<td>10M Ohm</td>
</tr>
<tr>
<td></td>
<td>400mV</td>
<td>0.1mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4V</td>
<td>0.001V</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>40V</td>
<td>0.01V</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>400V</td>
<td>0.1V</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1000V</td>
<td>1V</td>
<td>±(1.5% of reading + 3 digits)</td>
<td>10M Ohm</td>
</tr>
<tr>
<td>Volts AC</td>
<td>400mV</td>
<td>0.1mV</td>
<td>±(1.5% of reading + 4 digits)</td>
<td>10M Ohm</td>
</tr>
<tr>
<td></td>
<td>4V</td>
<td>0.001V</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>40V</td>
<td>0.01V</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>400V</td>
<td>0.1V</td>
<td>±(2.0% of reading + 4 digits)</td>
<td>10M Ohm</td>
</tr>
<tr>
<td></td>
<td>1000V</td>
<td>1V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resistance</td>
<td>40 Ohm</td>
<td>0.01 Ohm</td>
<td>±(0.75% of reading + 5 digits)</td>
<td>600V DC or Peak AC</td>
</tr>
<tr>
<td></td>
<td>400 Ohm</td>
<td>0.1 Ohm</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4k Ohm</td>
<td>0.001k Ohm</td>
<td>±(0.5% of reading + 3 digits)</td>
<td>600V DC or Peak AC</td>
</tr>
<tr>
<td></td>
<td>40k Ohm</td>
<td>0.01k Ohm</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>400k Ohm</td>
<td>0.1k Ohm</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4M Ohm</td>
<td>0.001M Ohm</td>
<td>±(0.75% of reading + 5 digits)</td>
<td>600V DC or Peak AC</td>
</tr>
<tr>
<td></td>
<td>40M Ohm</td>
<td>0.01M Ohm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capacitance</td>
<td>40nF</td>
<td>0.01nF</td>
<td>±(3.0% of reading + 15 digits)</td>
<td>600V DC or Peak AC</td>
</tr>
<tr>
<td></td>
<td>400nF</td>
<td>0.1nF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4uF</td>
<td>0.001uF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>40uF</td>
<td>0.01uF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>400uF</td>
<td>0.1uF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4mF</td>
<td>0.001mF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>40mF</td>
<td>0.01mF</td>
<td>±(5.0% of reading + 15 digits)</td>
<td>600V DC or Peak AC</td>
</tr>
</tbody>
</table>

* Test voltage.
9.1.2 Leads and Adapters

The Scope Multimeter uses standard safety banana plugs that are compatible with many accessories. The various leads, clips, and adapters that are supplied with or available for the VERDICT M2 unit explained in this section.

IMPORTANT:
When removing leads from their sockets, do not pull on the wire because it can damage the leads. Pull on the plug.

Channel 1 Lead

The shielded red lead with an integrated probe is used for Channel 1 (Figure 9-1). The lead color matches the color of socket 1 on the Scope Multimeter and of trace 1 on the test screens.
Channel 2 Lead

The shielded green lead (Figure 9-2) with an integrated probe is used for Channel 2. The lead color matches the color of socket 2 on the Scope Multimeter and the color of trace 2 on the test screens.

Common Lead

The black lead (Figure 9-3) with an integrated probe is used when a separate common, or ground, connection is needed. The lead color matches the color of the GND socket on the Scope Multimeter.

Alligator Clips

Three insulated alligator clips that attach to the test leads are included. The insulator boots are colored to match each test lead. Alligator clips attach to the probe end of the test lead.

To install an alligator clip:

1. Remove the collar from the probe by threading it counterclockwise off of the tip (Figure 9-4). Store the collar in a safe place while not in use.

2. Fit the tip of the probe into the alligator clip and thread the clip onto the probe.
Secondary Coil Adapter Lead (optional)

The optional Secondary Coil Adapter lead (Figure 9-5) connects to the clip-on secondary wire adapter, coil-in-cap adapter or coil-on-plug adapter to display secondary waveforms.

![Figure 9-5 Secondary Coil Adapter lead](image)

Secondary Ignition Clip-on Wire Adapter (optional)

The optional Secondary Ignition Clip-on Wire Adapter (Figure 9-6) connects the Secondary Coil Adapter lead to the vehicle Secondary wire to display ignition patterns.

![Figure 9-6 Secondary Ignition Clip-on Wire Adapter](image)

Low Amp Current Probe (optional)

The optional Low Amp Current Probe (Figure 9-7) provides accurate and reliable non-intrusive testing of ignition coils, fuel injectors, fuel pumps, relays, electric motors, and parasitic draw. The optional Low Amp Current Probe measures current from 10 mA to 60 Amps.

![Figure 9-7 Low Amp Current Probe](image)
9.1.3 Menu Options, Scope Multimeter

The Menu icon on the Toolbar at the base of the screen opens a menu with the following options:

- **Safety Information**—opens the *Important Safety Instructions* document.
- **File**—allows you to print or save the data or meter setup being viewed.
- **Setup**—allows you to adjust certain tool settings once a test has been selected.
- **Help**—allows you to view supporting documentation.

**File**

Use to print or save a copy of the data currently being viewed. Selecting opens a submenu:

- **Save Multimeter**—opens an additional submenu with these options:
  - **Save Configuration**—saves the current screen setup as a preset for quick access.
  - **Save Single Frame**—saves a recording of the current screen.
  - **Save All Frames**—saves a recording of the current screen plus all the data in the buffer.
- **Print**—opens a standard Windows Print dialog box for printing the current screen, see *Printing / Printer Setup* on page 24..

**Setup**

This option allows you to adjust tool settings to your personal preferences. Selecting opens a menu of the following:

- **Unit Setup**—opens the Unit Setup dialog box to adjust trace and display settings
- **Snapshot**—opens the Snapshot dialog box for selecting how triggered data is saved.

**Help**

A variety of utilities and additional resources are available through the Help menu:

- **User Manual**
- **Version Info**
- **Activation Status**
- **Scope About**

**Scope About**

This option opens a dialog box that contains the software version and other specific details about the Scope module.
9.2 Navigation

The following section describes how to navigate the screen interface when viewing on the Diagnostic Tool. When using the M2 Scope/Meter as a stand-alone test meter refer to M2 Scope/Meter Controls, and Features on page 92 for navigation instructions.

9.2.1 Screen Layout

The scope multimeter screens typically include the following sections (Figure 9-8):

1— **Scope Multimeter Toolbar**—allows you to configure the tool for the type of test and to adjust the settings for each channel, or trace.

2— **Main Body**—displays test results. Options on the toolbar let you select how tests display on the screen.

3— **Trace Details**—displays trace settings, which can be adjusted or switched through the touch screen.

4— **Record/Playback Control Toolbar**—allows you to record and navigate paused data

*Figure 9-8 Scope Multimeter screen layout*
Scope Multimeter Toolbar

The Scope Multimeter toolbar is used to set up the tool for testing and to configure the settings for each trace. The table below gives brief descriptions of the control icons on the toolbar.

Table 9-3 Scope Multimeter toolbar icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>![Back Icon]</td>
<td>Returns to the previously viewed screen.</td>
</tr>
<tr>
<td>Setup</td>
<td>![Setup Icon]</td>
<td>Opens a dialog box that allows you to select personal preferences for viewing and saving data.</td>
</tr>
<tr>
<td>Data</td>
<td>![Data Icon]</td>
<td>Switches the trace information displayed at the base of the screen between three available states.</td>
</tr>
<tr>
<td>Cursors</td>
<td>![Cursors Icon]</td>
<td>Opens a dialog box that allows you to switch cursors on and off, and to reposition them on the screen.</td>
</tr>
<tr>
<td>Refresh</td>
<td>![Refresh Icon]</td>
<td>Clears the minimum and maximum digital values and updates the viewing screen.</td>
</tr>
<tr>
<td>File</td>
<td>![File Icon]</td>
<td>Opens a dialog box that allows you to select options for saving data.</td>
</tr>
<tr>
<td>Print</td>
<td>![Print Icon]</td>
<td>Opens a dialog box that allows you to configure and print data. See Printing / Printer Setup on page 24.</td>
</tr>
</tbody>
</table>

Main Body of the Screen

The main body of the screen varies depending on what display options have been selected. Two traces, along with digital readouts of current signal values, signal status and triggering conditions, can be displayed simultaneously on the main body of the screen. Adjustments to the display are made through the scope toolbar as explained above.

Each trace is displayed as voltage over time on a standard oscilloscope screen. Voltage level is recorded on the vertical, or "y", axis and time is presented on the horizontal, or "x", axis of the screen. Values are shown for each graduation on the scales.

When using the pressure transducers, the pressure the transducer senses is converted into a voltage signal. However, the values are shown as pressure on the screen rather than voltage. Similarly, when using the optional Low Amp Current Probe the amperage sensed is converted to a voltage signal for processing, but displayed as amperage on the screen.
Trace Details

The Trace Details section displayed at the base of the screen can be used to quickly adjust settings for capturing the trace. The Trace details are accessed using either the Data icon on the upper toolbar or the Touch and Grow icon (fingerprint) icon on the Playback toolbar. Both icons function the same and cycle the Trace Details selection through three states:

- **Displayed**—trace settings are displayed in this mode
- **Expanded**—trace settings are displayed in a larger format in this mode
- **Off**—trace settings are not displayed in this mode

Adjustments are made by selecting the item to be changed on the touch screen. A dash (–) indicates a function that is not selected, and an icon displays to indicate an active function.

![Sample Touch and Grow display](image)

1— Peak Detect on  
2— Inverted trace  
3— Coupling AC on  
4— Sweep setting  
5— Trigger set on the rising edge  
6— Trigger setup

*Figure 9-9 Sample Touch and Grow display*
The following trace adjustments and settings are available:

- **Profile**—switches the trace for the selected channel on and off.
- **Channel**—opens a dialog box that allows you to configure the trace setup (see Trace Controls on page 132 for details).
- **Probe**—opens a dialog box that allows you to select the type of test probe being used.
- **Peak Detect**—maximizes the signal sampling rate in order to capture fast events, such as spikes, glitches and other anomalies, that may normally be undetected.
- **Inverted**—switches the polarity of the displayed signal.
- **Coupling AC**—subtracts the average value of the waveform by blocking the DC portion of an input signal in order to amplify the AC portion. This makes small variations in the trace visible.
- **Scale**—opens a dialog box that allows you to select the scale, which is the total value displayed on the vertical axis of the display.
- **Sweep**—the current sweep setting is shown in white at the end of the scale list, selecting opens a dialog box adjusts the sweep (see Sweep Controls on page 133 for details).
- **Slope**—only active when a trigger is set, indicates whether the trigger is set to activate on the rising or falling slope of the trace. Selecting the slope icon switches the slope. The white dash at the bottom of the slope column is used to set the trigger, selecting it opens the trigger setup dialog box (see Trigger Controls on page 134 for details).
Record/Playback Control Toolbar

The record/playback control toolbar at the base of the screen is used for recording data and for reviewing paused data. Use the stylus or your finger tip to activate the icons. A position counter in the toolbar displays a numerical value of where the current screen is in relation to the entire recorded file. Use the toolbar icons (Table 9-4) to navigate the data.

Table 9-4 Data buffer toolbar icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot</td>
<td>![Camera Icon]</td>
<td>Arms the software to take a snapshot of the sampled data</td>
</tr>
<tr>
<td>Step Back</td>
<td>![Backward Icon]</td>
<td>Moves to the previous point in the recorded data</td>
</tr>
<tr>
<td>Back 1 Frame</td>
<td>![Backward Icon]</td>
<td>Moves to the previous frame in the recorded buffer</td>
</tr>
<tr>
<td>Stop</td>
<td>![Stop Icon]</td>
<td>Stops recording data</td>
</tr>
<tr>
<td>Record</td>
<td>![Record Icon]</td>
<td>Begins recording data</td>
</tr>
<tr>
<td>Play Recording</td>
<td>![Play Icon]</td>
<td>Plays the data recording in a continuous loop at actual speed</td>
</tr>
<tr>
<td>Forward 1 Frame</td>
<td>![Forward Icon]</td>
<td>Moves to the next frame in the recorded buffer</td>
</tr>
<tr>
<td>Step Forward</td>
<td>![Forward Icon]</td>
<td>Moves to the next point in the recorded buffer</td>
</tr>
<tr>
<td>Position Indicator</td>
<td>![Position Icon]</td>
<td>In record mode, indicates how much data is collected. In playback mode; shows the position of the buffered data currently displayed as minutes:seconds:milliseconds of elapsed time.</td>
</tr>
<tr>
<td>Touch and Grow</td>
<td>![Touch and Grow Icon]</td>
<td>Expands and collapses the Trace Detail area on the display screen to allow for easier finger tip control</td>
</tr>
<tr>
<td>Zoom</td>
<td>![Zoom Icon]</td>
<td>Increase or decrease the magnification of the graph</td>
</tr>
</tbody>
</table>

Use the slider in the middle of the toolbar to quickly move through paused data.
9.2.2 Making Selections

Most selections for setting up and operating the scope are made using a finger or the stylus and the scope toolbar. The cursor lines, the trace zero line, and the trigger point indicator (+) can be repositioned by selecting and dragging them in the main body of the screen.

There are two basic types of controls on the toolbar:

- **Switches**
- **Dialog boxes**

A Switch changes states when tapped with a finger or the stylus. Changes happen immediately as the selection is made.

A dialog box opens as a separate window on the screen and typically includes a number of choices. Changes happen immediately, however, the dialog box must be closed to return to the main window and continue. Make a selection to close the dialog box.

9.3 Operations

This section describes configuring the scope or meter and performing tests.

9.3.1 Starting the Scope and Multimeter

Use the following procedure to set up the scope multimeter for performing tests.

**To start the scope multimeter:**

1. Select the **Scope Multimeter** icon on the VERDICT Home screen.
   The Scope Multimeter main menu, a list of setup options, displays;
   - Lab Scope
   - Graphing Multimeter
   - Digital Multimeter
   - Presets
2. Select the correct main menu option for the tests to be performed.
   A submenu of scope or meter configuration displays, see below for additional information.
3. Select the correct configuration for the tests to be performed.
   The Scope Multimeter displays configured for the selected test.
Lab Scope Options
The following options are available for testing:

- 2 Channel Lab Scope
- Volts DC
- Low Amps (20)
- Low Amps (40)
- Low Amps (60)
- Ignition Probe
- 100 PSI Vacuum
- 100 PSI Pressure
- 500 PSI Pressure
- 5000 PSI Pressure
- MT5030 Vacuum
- MT5030 Pressure
- EEDM506D Temperature

Graphing Multimeter Options
The following options are available for testing:

- Single Graphing Meter
- Volts DC
- Frequency
- Pulse Width
- Duty Cycle
- Low Amps (20)
- Low Amps (40)
- Low Amps (60)
- 100 PSI Vacuum
- 100 PSI Pressure
- 500 PSI Pressure
- 5000 PSI Pressure
- MT5030 Vacuum
- MT5030 Pressure
- EEDM506D Temperature
Digital Multimeter Options

The following options are available for testing:

- Volts DC
- Volts AC RMS
- Ohms
- Diode/Continuity
- Capacitance
- Low Amps (20)
- Low Amps (40)
- Low Amps (60)

Presets

Presets are factory configured meter settings for common component tests. Selecting opens a list of available setups. Selecting from the list opens the scope multimeter configured to perform the selected test. In addition to the factory presets, you can create your own custom meter configurations and save them as presets.

9.3.2 Measurement Out of Range

A group of arrows display when a measurement is out of range for the scale selected:

- Arrows pointing UP—measurement over maximum range
- Arrows pointing DOWN—measurement under minimum range

Voltage measurements also display arrows in place of live values when the voltage exceeds the input rating of the meter.

⚠️ WARNING

Risk of electrical shock.

- Do not exceed voltage limits between inputs as indicated on the rating label.
- Use extreme caution when working with circuits that have greater than 40 volts AC or 24 volts DC.

*Electrical shock can cause personal injury, equipment damage, or circuit damage.*

**IMPORTANT:**

If arrows are displayed in the live voltage values, discontinue circuit testing.

Correct an out-of-range condition by selecting a scale setting appropriate for the signal being sampled. See "Trace Controls" on page 132 for more information.
9.3.3 Scope and Multimeter Setup

The following sections explain how to adjust the scope and multimeter for the specific type of signal being sampled. Most of these setup operations are available from the toolbar.

Trace Controls

The Traces controls are used to adjust individual characteristics of how the signal is sampled and displayed for each trace. The more commonly used trace settings can also be made from the Trace Details area of the touch screen (see Trace Details on page 126). Trace Details offers a shortcut to some of the operations described in the following sections.

To adjust trace controls:
1. Select Setup from the Scope Multimeter toolbar. The Scope Multimeter Preferences dialog box opens.
2. Double tap Traces to open the submenu.
3. Select the tab for the trace to be configured from the submenu.
   The traces dialog box displays (Figure 9-11).

![Figure 9-11 Traces dialog box]

1— Trace tabs
2— Trace Probe icon
3— Trace Scale icon
4— Trace characteristics check boxes
5— Auto Find icon
6— Baseline position
7— Back icon
8— Exit icon
4. Select the **Trace Probe** icon to open the menu.
5. Highlight a probe on the list and select **OK** to close the window.
6. Select the **Trace Scale** icon to adjust the vertical scale, of the display.
   A dropdown menu opens, menu options vary depending upon which test lead is selected.
7. Select a trace scale option, then close the window.
8. Select or deselect the trace characteristic items as needed:
   - **Displayed**—this trace is on screen when checked, and not visible when not checked.
   - **Inverted**—signal polarity is reversed when checked, normal when not checked.
   - **Coupling AC**—check when sampling an AC signal, do not check for DC signals.
   - **Peak Detect**—use when trying to capture a fast event or signal glitch.
9. The scope samples the signal and internally calculates the best way to display it when **Auto Find** is selected. A scale and the vertical position for the zero line of the trace that allows the whole waveform to fit on the screen is established when Auto Find is selected. If Auto Find is selected on the trigger channel, it also sets the trigger level halfway between the minimum and maximum value of the sampled signal to provide a stable waveform.
10. The baseline position is the zero line of the trace, use the slider and arrows to adjust it.
11. Select **Back** to return to the Preferences dialog box, or select **Exit** to close the dialog box and return to the scope.

**Sweep Controls**

Sweep is the amount of time represented by the screen, or the horizontal scale of the display.

**To adjust Sweep controls:**
1. Select **Setup** from the Scope Multimeter toolbar.
   The Scope Multimeter Preferences dialog box opens.
2. Select **Sweep** to open the sweep dialog box (Figure 9-12)
3. Choose an option from the list.
4. Select **Back** to return to the Preferences dialog box, or select **Exit** to close the dialog box and return to the scope.
Trigger Controls

Triggering allows you to set the scope so that it begins displaying a trace once predetermined signal conditions, or triggers, are met. Triggering produces a much more stable waveform. The trace always begins at the trigger point, so the image does not appear to flicker or drift as it updates. There are three modes of triggering:

- **Auto**—this automatic triggering mode is the default setting that either constructs the trace independently of the trigger point or begins the trace as it crosses the trigger.
- **Manual**—often called normal mode, this option allows the user to set a triggering point and the trace does not begin to display until the signal reaches the trigger point.
- **None**—often called Histogram, this is a “no triggering” mode that is automatically engaged whenever a timebase, or sweep, between 2 seconds and 20 seconds is selected. Triggering is prevented at slower sweep rates to eliminate screen update delays caused by the way VERDICT buffers data in order to capture rapidly occurring signal glitches.

The trigger point is indicated by a plus sign (+) on the scope grid. The plus sign can be dragged across the grid with your finger or the stylus to roughly position it. The trigger controls allow you to precisely position the trigger.
To adjust trigger controls:
1. Select **Setup** from the Scope Multimeter toolbar.
   The Scope Multimeter Preferences dialog box opens
2. Select **Trigger** to open the Trigger Setup dialog box (Figure 9-13).
3. Use the dialog box controls to establish the position for triggering.
4. Select **Back** to return to the Preferences dialog box, or select **Exit** to close the dialog box and return to the scope.

1— **Source**—selects the triggering event:
   - Trace 1—sets the trigger to channel 1.
   - Trace 2—sets the trigger to channel 2.
   - None—switches triggering off.
2— **Mode**—sets the method of triggering:
   - Auto (automatic)—if a trigger is found, the waveform displays. If a trigger is not found after about a half second, the waveform and a “trigger not found” message displays.
   - Manual—if a trigger is found, the waveform displays. If a trigger is not found nothing displays (no waveform and no message).
3— **Slope**—sets triggering to the rising or falling edge of the signal.
4— **Vertical position**—moves the trigger position up and down on the grid.
5— **Horizontal position**—moves the trigger timing left and right on the grid
6— Select **Back** to return to the Preferences dialog box, or select **Exit** to close the dialog box and return to the scope.

*Figure 9-13 Trigger controls*
View Controls

Use the view controls to set display attributes.

To adjust view controls:
1. Select Setup from the Scope Multimeter toolbar.
   The Scope Multimeter Preferences dialog box opens.
2. Select View to open a submenu.
3. Select an option from the submenu dialog box. Option details are explained below.
   Four options are available on the submenu:
   - Display—use to adjust what information displays and how it appears
   - Layout—use to set how many traces display and how they display on the screen
   - Units—use to adjust time and voltage interval settings
   - Back—use to return to the Preferences dialog box, or select Exit to close the dialog box and return to the scope.

Display Settings

Selecting Display from the View submenu opens the Display dialog box (Figure 9-14).

![Sample Display dialog box](image)

**NOTE:**
The tabs on the view setup dialog box allow you to quickly switch between the three available settings without exiting back to the preferences menu.

The following options are available from the Display dialog box:

- Show Grid—switches grid lines on the screen off and on.
- Invert Colors—switches the screen background to white.
**Layout Settings**

The selected radio knob on the Layout dialog box shows which setting is active:

- **1 window**—shows all traces on the same screen.
- **2 windows**—shows two separate horizontal traces, one below the other.
- **2 windows**—shows two separate vertical traces, side-by-side.

**Unit Settings**

The Units dialog box allows you to switch between Full Scale or Per Division settings for the trace setup and the display settings. Selecting Full Scale configures the units to the full viewing area of the screen, while Per Division adjusts the units to a single division (one tenth) of the screen.

![Sample View Units dialog box](image)

**Figure 9-15 Sample View Units dialog box**

A radio knob shows which setting is active on the Units dialog box, select to change (Figure 9-15).

**Setup Controls**

Basic tool settings are adjusted here.

**To adjust setup controls:**

1. Select **Setup** from the Scope Multimeter toolbar.
2. When the Scope Multimeter Preferences dialog box opens, select **Setup**.
   - A submenu of options displays. Selecting from the submenu opens a dialog box for that item.
3. Make dialog box selections as needed.
4. Select **Back** to return to Preferences, or select **Exit** to return to the scope.
**Unit Setup**

The units of measurement can be changed between US standard or metric units of measure for pressure and vacuum readings. Selecting Units opens the Setup dialog box (Figure 9-16).

![Sample Setup Units dialog box](image)

**Figure 9-16 Sample Setup Units dialog box**

**Snapshot**

The Snapshot tab of the Setup dialog box opens a window that allows you to select how much data is captured after a snapshot is triggered (Figure 9-17).

Selections range from ten to ninety percent in increments of ten, the current setting is highlighted. Select a icon, then select **OK** to close the dialog box.

![Sample Snapshot dialog box](image)

**Figure 9-17 Sample Snapshot dialog box**

Refer to **Trigger Controls** on page 134 for information on how to setup a trigger.
Cursor Controls

The cursor controls include a Show Cursors check box plus a slide control and arrows for moving the cursor position left or right. Select Cursors from the toolbar to open the Cursors dialog box (Figure 9-18).

1— Cursor 1 controls
2— Cursor 2 controls
3— Hide icon
4— Back icon

Figure 9-18 Cursor controls

Cursor 1, the top slider and arrows, is the left-hand cursor on the screen. Cursor 2, the lower set of controls, is the right-hand cursor on the screen. Drag the slider or select the arrows to position the cursors. Each tap of the stylus moves the cursor incrementally in the direction of the arrow.

Select Back to apply the changes and close the dialog box.

Select Hide to conceal the cursors and close the dialog box.

Refresh Controls

Selecting the Refresh icon from the Scope Multimeter Toolbar clears the minimum and maximum digital values and updates the viewing screen.

File Controls

Selecting File from the toolbar opens a window with a menu of save options:

- **Save Configuration**—saves the current setup values as a preset.
- **Save Single Frame**—saves the data currently on the screen only.
- **Save All Frames**—saves the current screen plus all the data stored in the buffer.

Selecting a menu option opens the Save As dialog box and the virtual keyboard. Follow the screen prompts to name and describe the file you are saving. Basic information from the Vehicle ID, such as year, make, and model, is saved along with the file. Select OK to close the dialog box.

Once a configuration is saved, it becomes available as a preset. Files are saved to the Scope Multimeter Data Folder and can be retrieved through the **Data Manager**.

Print Controls

Selecting Print from the toolbar opens a standard Windows Print dialog box set up to print the current screen. See Printing / Printer Setup on page 24.
The Repair Information icon (Figure 10-1) can be used to:

- Access the SureTrack® Community within ShopKey® Pro that is included with current diagnostic tool software, see SureTrack on page 181 for additional information.
- Access optional online repair resources (e.g. ShopKey® Pro)

As an example, after using the Scanner, Guided Component Test, or Scope Multimeter to diagnose and locate the source of a problem, you can select the Repair Information icon on the Home screen to link to online repair resources that can help you further research and diagnose the vehicle specific problem, to get the vehicle back in service quickly.

**Figure 10-1 Repair Information icon**

### 10.1 About ShopKey Pro

ShopKey Pro is an optional online service that can provide you with OEM repair, estimating, maintenance, and real-world experience-based information to help you efficiently and accurately perform repairs. It allows you access to OEM TSB’s, recall, repair, campaign, and diagnostic information, as well as wiring diagrams, maintenance schedules, expert information and more all from one source!

Searching for repair information is easy, as the search process is based on vehicle components, so it matches the repair process. Simply look up a component and ShopKey Pro returns only the relevant repair information, including TSBs, component location, specifications, operating values, removal and installation procedures, wiring diagrams, and more.

Listed below are a few of the main features that ShopKey Pro has to offer:

- **Safety Recalls, OEM Campaigns and TSBs**—This information is automatically displayed based on the identified vehicle and component search, so you don't have to perform separate searches.
- **Wiring Diagrams**—Full-color diagrams are easy to follow, and the circuit trace feature allows you to highlight a complete circuit from end-to-end to quickly identify the specific circuit you are testing.
- **Diagnostics**—Enter a DTC to find the information needed to diagnose and fix the problem, including code descriptions, setting conditions, component illustrations and test procedures.
- **Maintenance**—The maintenance schedules are straightforward so anyone in the shop can sell services and grow a profitable maintenance business. You get lifetime service schedules, procedures, specifications; and a unique component locator tab shows exactly where to begin the maintenance procedure.
• **SureTrack**—SureTrack is a comprehensive source of expert knowledge for professional technicians, combining diagnostic experience and detailed parts replacement records, all wrapped in an interactive community.

• **ShopKey Pro Vintage**—ShopKey Pro Vintage includes an extensive library of engine and chassis repair information, along with wiring diagrams, and other information for vehicles back to 1960.

Contact your Snap-on representative to learn more about ShopKey® Pro or visit the following web pages:

- [Snap-on Diagnostics ShopKeyPro Page](#)
- [ShopKeyPro.com](#)
- [ShopKey Pro Training (sktraining.net)](#)
Vehicle History allows you to manage and retrieve vehicle records, for vehicles that have been scanned or identified previously. You can also activate a vehicle, so there is no need to go through the complete vehicle identification sequence when performing a retest after repairs have been made.

11.1 Screen Layout

There are two main parts to the vehicle records list screen:

1. Vehicle History Toolbar
2. Main Body (Records List)

![Vehicle History Toolbar and Main Body](image.png)

**Figure 11-1 Vehicle records list screen**

11.1.1 Vehicle History Main Body (Records List)

The main body of the screen lists all of the available vehicle records. By default, records are shown in the order in which they are entered. However, you can resort them by any of the categories shown as column headings. You can also resize the individual columns.

**To sort records:**

1. Select a category heading.
   The listed items resort according to the selected category. A triangle appears alongside the name of the column that was used for the sort.

2. Select the triangle in the heading to reverse the sort order.
To resize a column:
1. Select the line separating two columns.
   A line with arrowheads appears to show the column is ready for resizing.
2. Drag the line left or right to increase or decrease the column width.

11.1.2 Vehicle History Toolbar

The table below gives brief descriptions of the control icons on the toolbar:

Table 11-1 Toolbar icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td><img src="image" alt="Back Icon" /></td>
<td>Returns to the previously viewed screen.</td>
</tr>
<tr>
<td>Activate</td>
<td><img src="image" alt="Activate Icon" /></td>
<td>Activates the selected vehicle, for use with other functions (e.g. Scanner, Guided Component Tests, etc).</td>
</tr>
<tr>
<td>View</td>
<td><img src="image" alt="View Icon" /></td>
<td>Opens the selected vehicle record.</td>
</tr>
<tr>
<td>Delete</td>
<td><img src="image" alt="Delete Icon" /></td>
<td>Deletes the selected vehicle record from memory.</td>
</tr>
<tr>
<td>Manage</td>
<td><img src="image" alt="Manage Icon" /></td>
<td>Opens the vehicle Manage Records screen.</td>
</tr>
<tr>
<td>Search</td>
<td><img src="image" alt="Search Icon" /></td>
<td>Opens a window that allows you to locate a particular vehicle record.</td>
</tr>
<tr>
<td>Show All</td>
<td><img src="image" alt="Show All Icon" /></td>
<td>Available only after a search, use to return to a complete vehicle records list.</td>
</tr>
<tr>
<td>Settings</td>
<td><img src="image" alt="Settings Icon" /></td>
<td>Opens a window that allows you to configure which fields display on main records list screen.</td>
</tr>
</tbody>
</table>

**Activate**

Use this icon to activate a vehicle for use in other functions (e.g. Scanner, Guided Component Tests, etc.). The diagnostic tool will use the identification information stored in the vehicle history record to load the correct vehicle database, so there is no need to identify the test vehicle again.

To activate a vehicle:
1. Locate and highlight the desired vehicle record on the records list screen.
2. Select Activate from the toolbar.
   The Activate icon is removed from the toolbar once a vehicle has been selected.
3. Select the Home icon.
   The Home screen displays with the activated vehicle shown on the toolbar.
4. Select any Function icon on the Home screen to begin testing.
View

Select View to open, edit, add notes, and print a vehicle record.

**To open and/or modify a vehicle record:**

1. Highlight the desired vehicle record from the vehicle records list screen, then double click it, or select View from the toolbar.

The record for the selected vehicle opens (Figure 11-2).

The vehicle record includes vehicle ID information, DTC data, and other data entry fields for owner and vehicle information, and technician notes. Depending on the vehicle information that was used to identify the vehicle, some data may be already entered. The example below shows, DTC scan results from the last code scan performed, and an attachment “Vehicle System Report Data” PDF file.

Vehicle ID information is captured slightly different across the different functions (e.g. Scanner, Guided Component Tests, etc.), as some functions may capture more/less information during the process. Selecting the Other Vehicle ID button, opens a listing of the captured vehicle ID fields from each applicable function. If more than one function was used to ID the vehicle, you are given the option to use that vehicle ID set as the default ID for the vehicle record.

NOTE:
The virtual keyboard automatically opens the first time you select within one of the data fields.

2. Use the virtual keyboard to enter information in the data fields. The data is automatically saved.

3. Select Back to return to the vehicle records list screen.

Delete

Select Delete to remove unwanted items from the vehicle records list. Highlight the record to remove, then select Delete.
Manage

Select **Manage** to quickly remove individual records, or all the vehicle records from the vehicle records list. Highlight the record to remove, then select **Delete**, or use the Select All or Deselect All options to remove all records (Figure 11-3).

![Figure 11-3](image)

Search and Show All

Selecting Search opens a dialog box that allows you to search vehicle records by category. You can search for data in the following categories:

- Year
- Make
- Model
- Color
- Customer
- License
- State
- Technician
To search:
1. Select **Search** from the toolbar.
2. Enter the search criteria in the text field (**Figure 11-4**).

![Sample Search dialog box](image)

**Figure 11-4 Sample Search dialog box**

3. Select **Search** twice. The first tap closes the keyboard, the second tap starts the search.
   The display returns to the vehicle records list screen with only the records found in the search criteria showing.
4. Select **Show All** on the toolbar to restore the complete vehicle records list.
**Settings**

Use Settings to determine which categories display on the vehicle records list screen. Selecting the Settings icon opens a vehicle history category display menu.

**To change Settings:**

1. Select **Settings** to open the menu.

2. Select or deselect the desired categories:
   - Highlighted items - do not display
   - Non-highlighted items - display

3. Select **OK** on the toolbar to accept the changes, and return to the previous screen.
Chapter 12 Data Manager Operations

The Data Manager is used to store, sort, and review saved files. Most operations are controlled through the toolbar.

12.1 Screen Layout

Select Data Manager on the Module toolbar to open the file system. Use the toolbar at the top of the screen to navigate through the data. The folders panel below the toolbar displays the contents of the Windows My Documents > ShopStream folder, which is the Data Manager main screen. The information panel on the lower-left portion of the screen shows a summary of the saved file when available, and the preview panel on the lower right displays an image if the selected file is a graphic.

The main screen includes folders for saved files from the various modules:

- Camera Folder—contains photographs taken with the built-in camera. See Image Viewer on page 172.
- CTM Data Folder—contains files saved while working in the Guided Component Test module. See Scope Viewer on page 171.
- Sample Files—contains an assortment of example saved data files.
- Scanner Data Folder—contains files saved while working in the Scanner function. See Scanner DataViewer Operation on page 161.
• Scope Multimeter Data Folder—contains files saved while working with the Scope Multimeter. See Scope Viewer on page 171.
• Screenshots—contains images saved by pressing the Shortcut (S) button. See Image Viewer on page 172.

12.2 Navigation

Use the toolbar icons as shown in the table below to navigate through the Data Manager:

Table 12-1 Data Manager toolbar icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Data</td>
<td><img src="image" alt="My Data Icon" /></td>
<td>Returns to the Data Manager main screen.</td>
</tr>
<tr>
<td>Up</td>
<td><img src="image" alt="Up Icon" /></td>
<td>Moves the items displayed in the folders panel up one level in the file structure.</td>
</tr>
<tr>
<td>Open</td>
<td><img src="image" alt="Open Icon" /></td>
<td>Opens the highlighted folder or file.</td>
</tr>
<tr>
<td>New</td>
<td><img src="image" alt="New Icon" /></td>
<td>Creates a new folder.</td>
</tr>
<tr>
<td>Delete</td>
<td><img src="image" alt="Delete Icon" /></td>
<td>Moves the highlighted file or folder to the recycling bin.</td>
</tr>
<tr>
<td>Rename</td>
<td><img src="image" alt="Rename Icon" /></td>
<td>Opens a dialog box and the virtual keyboard for renaming the selected file or folder.</td>
</tr>
<tr>
<td>Save</td>
<td><img src="image" alt="Save Icon" /></td>
<td>The Save function is not implemented at this time.</td>
</tr>
<tr>
<td>Properties</td>
<td><img src="image" alt="Properties Icon" /></td>
<td>Opens a dialog box and the virtual keyboard for renaming the selected file or folder.</td>
</tr>
<tr>
<td>Shortcut</td>
<td><img src="image" alt="Shortcut Icon" /></td>
<td>Creates a shortcut to the highlighted item on the Data Manager main screen. See Shortcut on page 154 for information.</td>
</tr>
<tr>
<td>Email</td>
<td><img src="image" alt="Email Icon" /></td>
<td>Send data files as attachments, using Email. See Email on page 155 for information.</td>
</tr>
<tr>
<td>More (optional)</td>
<td><img src="image" alt="More Icon" /></td>
<td>Opens hidden menu options</td>
</tr>
</tbody>
</table>
12.3 Operations

Data Manager operations based on toolbar selections are explained in the following sections.

12.3.1 My Data

The My Data icon is a shortcut that quickly returns you to the main Data Manager screen. Select the icon at any time to instantly return. Note the location of the page being viewed is shown near the top of the screen just above the toolbar.

12.3.2 Up

This icon reflects the items shown in the folders panel of the screen up in the file structure one level at a time. For example; one tap of the Up icon when viewing the contents of the Scanner Data Folder returns you to the main screen. A second tap would display the contents of the "My Documents" folder.

12.3.3 Open

The Open icon is only active (displays in color) when an item in the folders panel is highlighted.

To open a folder:
1. Highlight the file to open in the folders panel.
2. Select the Open icon to load the highlighted file.

Figure 12-2 Sample open folder showing information
The screen advances and the contents of the open folder are shown in the folders panel. Highlight an item in the folders panel and the information or preview displays, if available, in the lower portion of the screen (Figure 12-2).

3. To exit the current folder:
   - Select **My Data** on the toolbar to return to the main Data Manager screen.
   - Select **Up** on the toolbar to return to the previous page.

12.3.4 New

The New icon allows you to create a new folder. This option is only available when the icon displays in color.

To create a new folder:
1. Select the **New** icon on the toolbar. The New Folder Name dialog box opens (Figure 12-3).
2. Select the entry field on the dialog box to open the virtual keyboard.
3. Type a name for the new folder using the virtual keyboard.
4. Select the **OK** icon to create the new folder and return to the previous page. The **Cancel** icon returns you to the previous page without creating a new folder.

Figure 12-3 Sample New Folder name dialog box
12.3.5 Delete

The Delete icon moves folders or items within folders to the Recycling bin. A confirmation displays when a file is selected for deletion. Select Yes to delete the file or Cancel to exit.

▶ To delete an item:
1. Select to highlight the item or folder to be deleted.
2. Select the Delete icon on the toolbar.
   A confirmation message displays (Figure 12-4).

3. Select OK to delete the selected item and return to the previous page. The Cancel icon returns you to the previous page without deleting the selected item.
12.3.6 Rename

The Rename icon allows you to change the name of a folder or items within a folder.

To rename an item:
1. Highlight the item or folder to be renamed.
2. Select the Rename icon on the toolbar.
   The New Name dialog box opens (Figure 12-3).

3. Select the entry field on the dialog box to open the virtual keyboard.
4. Type the new name into the entry field using the virtual keyboard.
5. Select the OK icon to change the name and return to the previous page. The Cancel icon returns you to the previous page without changing the name.
12.3.7 Properties

The Properties icon function allows you to change the name and assign identifying attributes to saved Scope Multimeter files. Operation is similar to renaming a file as discussed above, except there are additional fields for entering descriptive information.

To assign properties to an item:

1. Highlight the item or folder.
2. Select the Properties icon on the toolbar.
   
   The Properties dialog box and the virtual keyboard open (Figure 12-3).

3. Type a new name into the field using the virtual keyboard if you want to rename the file.
4. Use either the virtual keyboard or the dropdown menus to fill in the Year, Make, Component, and Condition fields.
5. Select the OK icon to change the name and return to the previous page. The Cancel icon returns you to the previous page without changing the name.

12.3.8 Shortcut

Selecting the Shortcut icon creates a shortcut to the highlighted item on the Data Manager main screen. A confirmation message "A shortcut has been created in the default folder for ***sample file name***" displays when this option is selected.
12.3.9 Email

Selecting the Email icon from the Data Manager toolbar allows you to send a saved data or image file as an attachment using e-mail. To use this feature, you must install an e-mail client, and then either link your existing e-mail address to the client, or create a new address. The following instructions are intended as a guide only.

To attach a file from a Data Manager folder to an e-mail:

NOTE:
The Email feature uses your system default email client. Refer to Windows Help for instructions on setting your default e-mail client. For an example on how to setup an e-mail client, see E-mail client installation and setup (Example): on page 156.

NOTE:
This diagnostic tool is equipped with Microsoft Outlook Express e-mail client. To use this client, open the Microsoft Outlook Express program and run the New Connection Wizard following the screen prompts, and then either create an e-mail account or use your existing account to complete the setup. You may be required to enter setup information (e.g. incoming and outgoing server names, types, and port values), contact your ISP and/or e-mail provider for additional information.

1. From the Data Manager main screen, select a file from within one of the folders (e.g. Camera, Scanner Data, Scope Multimeter, etc). In this example (Figure 12-7). a Scope data file was chosen.
2. With the file highlighted, select Email from the toolbar.
3. A new e-mail message window displays with the selected file attached (Figure 12-8).

NOTE:
If the e-mail message window does not appear, check the Windows taskbar.
4. Enter the e-mail address of the recipient, and any other information needed.
5. Select the **Send** icon to send the e-mail.

**NOTE:**
You must have an Internet connection to send e-mail.

**E-mail client installation and setup (Example):**
The following instructions are intended as a guide only, as e-mail client setup procedures vary.
1. Download an email client (e.g. Mozilla Thunderbird) (**Figure 12-9**).
2. Install the software following the screen prompts (Figure 12-10).

![Figure 12-10](image)

3. Continue through the setup. If available choose “set as my default mail application” (Figure 12-11).

![Figure 12-11](image)
4. Choose to use your existing email address, or create a new email address with the email client (Figure 12-12).

5. Enter your e-mail information as required (Figure 12-13).

NOTE:
E-mail client configuration settings should automatically be set during installation. If problems arise with the setup and manual configuration is needed, refer to the e-mail client help information and the Windows help information.
6. If your existing email provider login screen displays, enter your email address and password to allow the client to continue the setup with your provider (Figure 12-14).

![Google Account Login](image1.png)

**Figure 12-14**

7. Follow the screen prompts to allow the client to link to your email address.

8. Once the client has successfully linked to your address, you can begin using the new e-mail client software on the diagnostic tool (Figure 12-15).

![Thunderbird](image2.png)

**Figure 12-15**
12.4 Viewing Saved Files

As mentioned in the beginning of this section, the data and image files in the Data Manager folders are also accessible from the Windows My Documents > ShopStream folder. You may access, copy or move the files you save in the ShopStream Diagnostic Suite program from the folder at anytime.

The files may also be transferred to portable USB drives and then transferred to your PC. All copy, move and save functions are accomplished using standard Windows operations.

Camera images and screenshots are saved as JPEG files and are viewable on most PCs. Data files are saved using proprietary file extensions and are not viewable on a PC without the use of ShopStream Connect. See ShopStream Connect™ on page 160 for additional information.

12.4.1 ShopStream Connect™

Data files saved on your diagnostic tool are designed and intended to be reviewed using the Data Manager functions as described earlier. An alternative method can be used to review select data files on a PC using ShopStream Connect.

ShopStream Connect is PC-based program that allows you to manage, view and print data files using a PC. ShopStream Connect is a free program available for download from our website. See the contact information at the front of this manual for website information.

12.5 Saved File Structure

The Diagnostic Suite automatically creates folders to manage saved files. Whenever 60 files are saved into any of the Data Manager menu option folders, a new folder is created. Folders may contain files for a day, week, month, or a year. An older folder, when available, goes to the next higher level in the files structure menu (Figure 12-16).

![Figure 12-16 Sample saved file folder structure](image)
12.6 Scanner DataViewer Operation

The Scanner DataViewer allows you to review saved scanner data files (Figure 12-17). To open saved Scanner data files, select the Scanner Data Folder menu option from the Data Manager main menu.

Scanner DataViewer - Opens .pids, .scm, .scs, .scp and .spm file extensions

Figure 12-17 Scanner Data Viewer

1— Menu bar
2— Display toolbar
3— Graph display
4— Properties icon
5— Vertical Scroll bar
6— Zoom controls
7— Slider bar
8— Navigation toolbar
9— Parameter text list
10—Parameter configuration tabs
12.6.1 Menu Bar

The menu bar at the top of the screen contains the File, View, Tools, and Help menus.

File Menu
The File menu offers the following selections:

- **Load**—locate and open data files, launches a navigation window
- **Print**—print selected pids (See Printing / Printer Setup on page 24.)
- **Print Preview**—preview pids before printing
- **Exit**—closes Scanner DataViewer

When Print or Print Preview is selected, a dialog box opens and allows you to define the printed output. Print settings include, print as graphs or text, which pids to include, number of pids per page, display colors, and the text font (Figure 12-18).

![Figure 12-18 Pids print settings](image)

**To print:**

1. Select the desired pids. A checked box indicates the pid will be printed. Select again to deselect the pid.
2. Select Change to modify the font, this opens a standard Windows font dialog box.
   a. Modify the font as desired.
   b. Select **OK** to close the font dialog box.
3. Once all selections are made, select **OK**.
   A print dialog box opens.
4. Select **OK**.
   a. If Print was selected, the file is sent to the printer.
   b. If Print Preview was selected, a preview window opens. Select the printer icon (Figure 12-19) to send the file to the printer.
View Menu

The View menu allows you to change how data is displayed on the screen (Figure 12-20).

Select from the following menu options:

- **Text Only**—shows all parameters and their values as text only
- **Graphs Only**—shows all parameters as graphs only
- **Text and Graphs**—shows all parameters and their values as text in the left panel of the screen, and shows them as graphs in the right panel of the screen
Tools Menu

The Tools menu opens the Properties dialog box.

The Properties dialog box has two sections (Figure 12-21); Shared Graph Properties and Individual Properties. Shared Graph Properties apply to all graphs and Individual Properties apply to the selected graph only.

![Properties dialog box](image)

Figure 12-21 Properties dialog box

Properties dialog box selections include:

- **Grid Lines**—when selected, a line displays at each major division of the graphs.
- **Display Item**—use to view the display color of the listed items. Highlight an item and the current color appears in the Color box.
- **Change**—use to change the color of the highlighted item, select to open a color palate.
- **Sweep**—use to adjust the number of data frames that appear on the screen (zoom in or out), highlight and type in the desired number.
- **Reset Colors**—use to restore the default color settings.
- **Data Item**—use this pulldown menu to select individual graphs for modification.
- **Auto Scale**—minimum and maximum (Y axis) values automatically adjust to the signal when the box is checked, uncheck the box if you want to custom set the values.
- **Y Axis Range**—use to type desired minimum (from) and maximum (to) values in the selection boxes. This field is only active when Auto Scale is deselected.
- **OK**—applies the changes and closes the properties dialog box.
- **Cancel**—closes the properties dialog box without making changes.
- **Apply**—applies the changes and leaves the properties dialog box open.

**NOTE:**
The Properties icon on each graph also opens the Properties dialog box (Figure 12-17).
Help Menu

The Help menu provides Scanner Viewer software version information.

12.6.2 Display Toolbar

The Display toolbar provides the following controls (Figure 12-22).

- **Exit**—closes Scanner DataViewer.
- **Hide PID List**—toggles display between parameter text and graph views.
- **Display Views (1 to 16)**—determines how many graphs display at a time.
- **Scale**—switches the scale values shown to the left of the graph off and on.
- **Sweep**—switches the sweep values shown below the graph off and on.

![Display toolbar](image)

**Figure 12-22 Display toolbar**
12.6.3 Navigation Tools

Playback Controls

The playback controls allow you to navigate through saved data (Figure 12-23).

1—Skip Back—Allows backward movement in multiple steps.
2—Step Back—Allows backward movement in singular steps.
3—Play—Select to play.
4—Step Forward—Allows forward movement in singular steps.
5—Skip Forward—Allows forward movement in multiple steps.
6—Pause—Select to pause playback.

Figure 12-23 Playback controls

Zoom Controls

The zoom controls allow you to incrementally increase or decrease the screen magnification (Figure 12-24).

Figure 12-24 Zoom controls
**Slider / Scroll Bars and Cursor**

Use the slider bar to quickly navigate through the data (Figure 12-25). During playback the number displayed on the left side of the slider bar indicates the current position of the cursor in the data file. The cursor can be repositioned during playback or when paused, by selecting and dragging.

Use the scroll bar (right side) to vertically scroll through the parameter list and graphs.

1 — Cursor
2 — Scroll bar
3 — Slider bar

Figure 12-25
12.6.4 Customizing the Display

The parameter text list (left side) displays parameter names and current values.

The display can be customized by selecting and dragging parameters from the text list or graph display to a different location in the text list or in the graph display (Figure 12-26). The highlighted parameters in the text list indicate which parameters are displayed as graphs.

NOTE:
The parameter text list is sortable by name and value. Select Name or Value at the top of the list to change the sorted view.
12.6.5 Customizing the Parameter List

1. The parameter configuration tabs allow you to choose between displaying all available parameters (Complete List), or only those from a (Custom List) (Figure 12-27).

To customize the parameter list:
1. Select the **Custom List** tab (Figure 12-27).
2. Select **Edit List** in the custom window.
A list of available parameters displays (Figure 12-28).

3. Select the parameters to include in your custom list. Select All and Deselect All controls are also available to assist in the selection process.

![Figure 12-28 Creating a custom parameter list](image)

4. Select **Save & Exit** to close the window.
   
   Only the parameters selected in your custom list are displayed.
12.7 **Scope Viewer**

This section is intended as an introduction of the Scope Viewer, as many features are similar to the Scope module features. The Scope Viewer allows you to print and playback recorded trace signals captured on your diagnostic tool. When a scope file is selected, it opens and displays in the Scope File Viewer.

The Scope Viewer allows you to print and playback recorded trace signals captured on your diagnostic tool. When a scope file is selected, it opens and displays in the Scope File Viewer.

The Scope File Viewer is intended to be used to review scope and meter files originally captured on a diagnostic tool. Some features (control icons) of the Scope File Viewer may not be available "grayed out". This is normal as those features are only applicable when viewing live data on a diagnostic tool.

The Scope File Viewer screen includes the following sections:

1— Toolbar - contains control icons
2— Main Body - displays recorded trace results
3— Profile Controls Window - displays profile control icons and trace display settings
4— Playback Control Toolbar - contains playback and display controls

![Figure 12-29](image-url)
12.8 Image Viewer

The Image Viewer allows you to open and view image files and screenshots.

1 — Exit - closes the Image Viewer
2 — Print - prints the image
3 — Captured Screen Image

Figure 12-30
Chapter 13  Help Operations

Selecting Help from the Home screen opens this manual in a dedicated screen viewer. Navigate through the file either by gesture scrolling on the touch screen, or with the scroll bar along the right edge of the viewing screen. A left-to-right scroll bar appears at the bottom of the screen when magnification is increased.

All listings in the Contents and Index are active links. Select an entry with the stylus to go directly to that point of the document. Additional links within the text, shown in blue-colored type, also take you to the referenced section of the manual.

13.1 Using the Help Toolbar

A simple toolbar at the top of the screen is used to adjust screen magnification and to exit Help:

Table 13-1  Help toolbar icons

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td><img src="image" alt="Back" /></td>
<td>Closes the help file and returns you to the previously viewed screen.</td>
</tr>
<tr>
<td>Zoom +</td>
<td><img src="image" alt="Zoom+" /></td>
<td>Incrementally increases the screen magnification.</td>
</tr>
<tr>
<td>Zoom –</td>
<td><img src="image" alt="Zoom-" /></td>
<td>Incrementally decreases the screen magnification.</td>
</tr>
<tr>
<td>Reset</td>
<td><img src="image" alt="Reset" /></td>
<td>Restores the default screen magnification.</td>
</tr>
<tr>
<td>Previous Page</td>
<td><img src="image" alt="Previous Page" /></td>
<td>Moves back one page in the document.</td>
</tr>
<tr>
<td>Page Counter</td>
<td><img src="image" alt="Page Counter" /></td>
<td>Shows the current page over the total number of pages in the document.</td>
</tr>
<tr>
<td>Next Page</td>
<td><img src="image" alt="Next Page" /></td>
<td>Moves forward one page in the document.</td>
</tr>
<tr>
<td>More</td>
<td><img src="image" alt="More" /></td>
<td>Opens a menu of the additional options (Hide TOC or Show TOC) shown below.</td>
</tr>
<tr>
<td>Hide TOC</td>
<td><img src="image" alt="Hide TOC" /></td>
<td>Closes the contents and search column so the document fills the screen.</td>
</tr>
<tr>
<td>Show TOC</td>
<td><img src="image" alt="Show TOC" /></td>
<td>Opens the contents and search column if they have been hidden.</td>
</tr>
<tr>
<td>Exit</td>
<td><img src="image" alt="Exit" /></td>
<td>Closes the help file, and any other open modules, and returns you to the Home screen.</td>
</tr>
</tbody>
</table>
Selecting System Settings from the Home screen opens a menu with two options:

- **Paired Devices** - Paired Devices allows you to check the status and pair wireless devices to the Diagnostic Tool.
- **Shop Information** - Shop Information allows you to create and edit a personalized header that is included on printed documents.
- **Data Backup** - Data Backup provides two options, backup and restore.

### 14.1 Paired Devices

Wireless devices communicate with the Diagnostic Tool to allow you work and access data remotely while working on a vehicle. Wireless devices such as the Scan Module and M2 Scope/Meter need to be paired, or synchronized, the first time they are used together.

To check the devices paired to your Diagnostic Tool:

1. Select **System Settings > Paired Devices**.
   
   The paired devices screen opens (Figure 14-1).

The Paired Devices screen lists all of the devices paired to the Diagnostic Tool, and also indicates whether or not there is active communication occurring.

![Typical Paired Devices screen](image.png)
The Hardware Status indicators in the lower-right corner of the Home screen provide a quick reference to wireless device operations. The background color of the status indicator icon represents the condition of the wireless connectivity to that device. Icon status is shown in the table below:

<table>
<thead>
<tr>
<th>Hardware Icon</th>
<th>Background Color</th>
<th>Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Module</strong></td>
<td>Red</td>
<td>Not Paired</td>
<td>Pair the Scan Module to the Diagnostic Tool. See &quot;Pairing The Scan Module,&quot; on page 60 for instructions.</td>
</tr>
<tr>
<td></td>
<td>Grey</td>
<td>Paired, but Not Communicating</td>
<td>You may have moved out of range. Move the Diagnostic Tool closer to the Scan Module to reestablish communications. If connectivity is not restored, perform the &quot;Recovery Procedure,&quot; on page 66.</td>
</tr>
<tr>
<td></td>
<td>Blue</td>
<td>Paired and Communicating</td>
<td>Hardware status is good and Bluetooth should be functional. Verify that the green Bluetooth LED on the front of the Scan Module is flashing. If there is no connectivity, perform the &quot;Recovery Procedure,&quot; on page 66.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>USB Cable Connected</td>
<td>Indicates the USB cable is connected.</td>
</tr>
<tr>
<td></td>
<td>Gray</td>
<td>USB Cable Not Connected</td>
<td>Indicates the USB cable is not connected or connected but not allowing communication</td>
</tr>
</tbody>
</table>

| **M2 Scope/Meter** | Red              | Not Paired                          | Pair the M2 to the Diagnostic Tool. See "M2 Scope/Meter Pairing," on page 175 for instructions. |
|                   | Grey             | Paired, but Not Communicating       | You may have moved out of range. Move the M2 closer to the Diagnostic Tool to reestablish communications. |
|                   | Blue             | Paired, and Communicating           | Hardware status is good and Bluetooth is communicating. |

### 14.1.1 Scan Module Pairing

For detailed information on the use and pairing of the Scan Module, see "Pairing The Scan Module," on page 60.

### 14.1.2 M2 Scope/Meter Pairing

For detailed information on the use and pairing of the Scan Module, see "M2 Scope/Meter Pairing," on page 175.
14.2 Shop Information

This option allows you to add personalized shop information that can be included on printed data files. Selecting opens a form that can be filled in using the virtual keyboard. Select OK when the form is complete and the information is saved.

To add Shop Information:
1. From the Home screen select System Settings.
2. From the System Settings menu select Shop Information.
   The Shop Information dialog box opens (Figure 14-2).
3. Select within any of the information fields and the virtual keyboard opens.
4. Use the virtual keyboard to fill in the Shop Information form.
   As an alternative, you can connect a USB keyboard to a USB jack on the Diagnostic Tool and use it to enter information into the form.

NOTE:
The screen does not scroll. Use the Top and Bottom icons on the right side of the virtual keyboard relocate the keyboard on the screen so that you can complete the form (Figure 14-3).
5. Close the virtual keyboard and review the information once all the fields have been filled in.
6. Select **OK** from the toolbar to save the Shop Information, or **Cancel** to close the Shop Information dialog box without saving.

The Shop Information screen closes and the screen returns to the System Settings menu.

### 14.3 Code Scan (Timestamp)

Selecting **Code Scan** from the Systems Settings main menu allows you to hide/show the timestamp (time of day) on the Vehicle System Report.

Select the **On/Off** checkbox, then select **OK** from the toolbar to confirm the setting (**Figure 14-4**).
14.4 Data Backup

Selecting Data Backup from the Systems Settings main menu provides the following options:

14.4.1 Backup Settings (message)

Backup Setting allows you to choose the interval for displaying the backup reminder message, or turn the reminder off. Message options are:

- Every Week
- Every 2 Weeks
- Every 4 Weeks
- Never

14.4.2 Backup

The Backup option allows you to back up your saved data to a file on the internal hard drive, or to an external drive (e.g. USB flash drive). This option can be used as general maintenance to ensure you have a safe backup of your saved data, or if an issue occurs where a system restore is necessary and you need to retain your saved data. The following types of data are backed up:

- ShopStream Data (saved movie/data files)
- Lab Scope Settings (presets)
- Vehicle History Records and Favorites

To Backup Information:

1. From the Home screen select System Settings.
2. From the System Settings main menu select Data Backup > Backup.
   The destination drive dialog box opens (Figure 14-5).
3. Select a drive destination.

NOTE:

Drive designations (e.g. E:/, F:/ etc.), are only visible when external drives are connected to the diagnostic tool.
A progress screen is displayed as the backup file is saved to the root of the drive selected with a file extension of .sna. Then a confirmation screen is displayed.

4. Select **OK** to complete the procedure.
14.4.3 Restore

The Restore option is used to restore your backed up data, in the event that the data is lost or if a system restore (recovery) has been performed.

This function is only applicable when a backup file has been previously saved (file extension .sna). See "Backup," on page 178 for additional information.

To perform a data Restore:

1. From the Home screen select System Settings.
2. From the System Settings main menu select Data Backup > Restore.
   The restore file confirmation dialog box opens (Figure 14-6).
3. Select Continue.

4. Select the backup file (file extension .sna) from your backup file location.
5. Select Open to restore the backup file.

Once the file has been restored a confirmation message is displayed.
6. Select OK, then close and restart the Diagnostic application.
Chapter 15  SureTrack

Designed to help you improve diagnostic accuracy and reduce repair time, SureTrack is a comprehensive source of expert knowledge for professional technicians, combining diagnostic experience and detailed parts replacement records.

Your access to SureTrack includes:

- A Common Replaced Parts (CRP) graph, showing which parts are most frequently replaced to successfully complete the repair for the selected diagnostic trouble codes (DTC), components or symptom.
- Real Fixes for trouble codes, with complaint, cause and corrective supporting information
- Repair Tips from other professional technicians
- Up-to-the-minute intelligence
- Access to the SureTrack Community (within ShopKey Pro)

For more information see Suretrack FAQ's at: http://mitchell1.com/support/suretrack-faqs/

15.1 Getting Started Using SureTrack

NOTE:
You must have the current software version installed on the diagnostic tool, and a Wi-Fi Internet connection to use SureTrack.

SureTrack information is accessible in two ways:

- **From within the Scanner Function**
  The SureTrack CRP graph, along with Real Fixes and Tips are provided when viewing codes from within the Scanner function, see Using SureTrack in the Scanner Function on page 182.

- **From the SureTrack Community (within ShopKey Pro)**
  The SureTrack Community gives you access to even more information, than what is provided in the Scanner function
  The SureTrack Community is accessible in two ways:
  - Selecting the Repair Information icon from the Home screen. Vehicle identification may be required, enter (identify) any vehicle, or
  - Visit shopkeypro.com using a web browser.

For additional information, see Using the SureTrack Community (within ShopKey Pro) on page 185.

NOTE:
The SureTrack icon has been removed from the Home screen as of software version 17.2, and has been disabled on previous versions (e.g. 16.4, 16.2, 15.4, etc).
15.2 Using SureTrack in the Scanner Function

To access SureTrack information from within the Scanner function you must:

- Have a Wi-Fi Internet connection
- Have the current software version installed on the diagnostic tool

If the conditions listed above are met, SureTrack information displays automatically when viewing codes.

SureTrack provides you with specific diagnostic information on the DTC selected. Available DTCs are displayed in a list that includes the DTC, a brief description, and a Fix It! icon (Figure 15-1).

Selecting the Fix It! icon displays the following SureTrack menu options:

- Common Replaced Parts Graph
- Dashboard Feature Information

15.2.1 Common Replaced Parts Graph

The Common Replaced Parts graph (Figure 15-1) shows the percentage of verified fixes (using the parts listed) derived from the total number of repairs by mileage. The example below indicates that based on 41 repairs (intake airflow sensor replacement) involving vehicles with up to 200k miles, approximately 33% of the repairs occurred at 125k miles.

![Common Replaced Parts Graph](image)

Figure 15-1 Common Replaced Parts Graph

1— Common Replaced Part Graph icon—toggles Common Replaced Parts graph display on/off.
2— Common Replaced Part Graph
3— Fix It! icon—opens Dashboard Feature Information
15.2.2 Dashboard Feature Information

Dashboard Feature Information includes:

- Detailed DTC Information
- Related Tips, Real Fixes and Repair Information

SureTrack will display detailed information about the current DTC describing code setting conditions, possible symptoms, system operation and possible solutions (Figure 15-2). In addition, other reference links may be provided such as schematics and illustrations.

![Figure 15-2 “Fix It!” DTC Information](image)

Menu options are also provided for the following:

Related Tips—opens a list of tips that may include information that is related to the current DTC (Figure 15-3).

![Figure 15-3 Related Tips Screen](image)
Real Fixes—opens a list of tips related to the current DTC that have been gathered from actual shop repair orders and presented in a Complaint, Cause, Correction format (Figure 15-4).

![Figure 15-4 Real Fixes Screen](image)

Repair Information—opens the ShopKey Pro website, or login screen, See “Repair Information” on page 140 for additional information.

15.2.3 SureTrack Status Messages

Depending on your software version and connection status the following messages may appear in the SureTrack status bar:

- **SureTrack Content May Be Available!** - indicates SureTrack content may be available, however you are not currently connected to the SureTrack database. This message may be caused by a Wi-Fi connection issue or if you do not have the current software upgrade installed.

- **Loading content from SureTrack** - indicates SureTrack information is being updated from the SureTrack database.

- **A new diagnostic software upgrade is available. See your sales representative for details** - indicates your access to SureTrack will be expiring soon and you should contact your sales representative to purchase the current software upgrade.

- **Your SureTrack access has expired. See your Snap-on representative to renew.** - indicates your access to SureTrack has expired and you should contact your sales representative to purchase the current software upgrade.

- **Verified parts replacement data not available.** - indicates repair and/or diagnostic information is not available at this time for the identified vehicle.

- **Network not available.** - indicates that you have a connection problem with your wireless network.
15.3 Using the SureTrack Community (within ShopKey Pro)

The SureTrack Community includes access to the following features on the ShopKey Pro website:

- **1Search™ Limited** - SureTrack Real Fixes, Related Tips, Common Replaced Parts, and ProView Information
- **SureTrack Community** - A library and forum filled with expert information from fellow professional technicians in the SureTrack community
- **Safety Recalls, OEM Campaigns, and TSB’s**

15.3.1 Getting Started

Use Requirements

To use the SureTrack Community you must:

- Have the current software version installed on the diagnostic tool
- Create a SureTrack Account, see Creating a SureTrack Account on page 185
- Have a current SureTrack Authorization Code, see Finding your SureTrack Authorization Code on page 187
- Have a Wi-Fi Internet connection
- Have the current Firefox web browser installed on the desktop

Creating a SureTrack Account

In order to use the SureTrack Community, you will need to complete the online registration, and create an account before you can use it.

1. Download and install the current Firefox web browser. Installation and support information are available on the Firefox website: [www.mozilla.org](http://www.mozilla.org)
2. Open the Firefox browser and navigate to shopkeypro.com
3. To create an account, follow the illustrated instructions in Figures 15-5 to 15-7.
Choose 3 security questions.

Success
Congratulations! Your account has been created.
This account can be used to contribute to the community and manage your profile.
To link this account to your shop, have your shop add you in Profile Manager.

Find the SureTrack Authorization Code on your sales receipt.
12 digit alpha-numeric code (e.g. 123ABCAP4-US)
Finding your SureTrack Authorization Code

When you purchase a software upgrade, or qualifying platform from your Snap-on Representative, you will receive a SureTrack authorization code. The authorization code is printed on your sales receipt. Authorization codes are 12 digit alpha-numeric codes (e.g. 123ABCAP4-US).

**NOTE:**

If you have purchase a software upgrade, contact your sales representative for your SureTrack authorization code. Software upgrades can be installed using the Software Upgrade Manager program installed on your diagnostic tool.
Each time you purchase an analytics software upgrade you will be provided a new SureTrack authorization code. The authorization code will expire shortly after the release of the next concurrent software upgrade. To log in with a new authorization code, see Logging In (existing expired account) on page 189.

15.3.2 Logging In (existing active account)

Use these instructions after you have created your SureTrack account. See Creating a SureTrack Account on page 185.

To log in to your active existing account:
1. Navigate to the login page on shopkeypro.com, by:
   - Selecting the Repair Information icon from the Home screen. If required, enter vehicle identification information as prompted, any vehicle can be used if a vehicle is not active.
   Or
   - Visit shopkeypro.com using a web browser.
2. Enter your username and password (Figure 15-9).
3. (Optional) Select the Remember Me check box to save your login information (Figure 15-9).
15.3.3 Logging In (existing expired account)

Use these instructions, if your existing SureTrack account has expired, and you have purchased a current diagnostic tool software upgrade.

To log in to your existing account using a new authorization code:
1. Navigate to the login page on shopkeypro.com, by:
   - Selecting the Repair Information icon from the Home screen. If required, enter vehicle identification information as prompted, any vehicle can be used if a vehicle is not active. Or
   - Visit shopkeypro.com using a web browser.
2. Enter your username and password (Figure 15-9).

If your existing account has expired, you will be automatically redirected to the renewal login screen.

3. On the renewal login screen, enter the NEW SureTrack authorization code found on your software upgrade sales receipt. See Finding your SureTrack Authorization Code on page 187 for additional information.
4. Follow the screen prompts to complete the login.

15.4 About Upgrade Reminder Messages

As a reminder to keep your software current and retain your access to SureTrack, software upgrade reminder messages will display periodically on the diagnostic tool when new software upgrades are available (Figure 15-10). To purchase software upgrades, or join the software subscription program, see your Snap-on Representative.

Selecting OK will close the message box until the beginning of the next month when it will appear to remind you again. Selecting Snooze 1 Week will close the message box for approximately one week and then it will re-appear.

Figure 15-10 Software Upgrade Reminder Message
Chapter 16  ShopStream Update Tool (SST)

The ShopStream Update Tool (SST) is a maintenance program that automatically keeps your diagnostic software up-to-date.

The following terms are used in this section and throughout this manual as described below:

- **Software Upgrade** - a new diagnostic software version. Software upgrades include new and enhanced coverage and features.
- **Software Update** - a service release “update” for an existing diagnostic software version

For clarity, throughout this document the term “software update(s)” will be used to collectively describe “software updates, upgrades and SST program updates” using the SST, except where noted.

The ShopStream Update Tool program downloads and installs:

- Diagnostic software upgrades
- Diagnostic software updates
- SST program updates

When connected to the Internet, the SST automatically checks for new software updates. This automatic check also occurs every time the diagnostic tool is turned on. If a software update is available, the SST will download it.

The SST is a low priority program that only downloads software updates when unused bandwidth is available. If other programs are running that communicate over the Wi-Fi network, such as a browser or instant messaging, the download may be temporarily suspended. This allows you to continue normal diagnostic tool operation, without interruptions or loss of performance.

**NOTE:**
As an alternative to downloading software in the background, you can select the Fast Download from the update status window, see Step 3 in Manual Software Download for details.

16.1  Basic Operation

The SST program is normally running in the Windows background and available from the Windows system tray. The program can be accessed as follows:

- **SST icon in the Windows system tray** - opens the SST program menu
- **SST program selection from the Windows “All Programs” or “Startup” menus** - starts the SST program and adds the SST icon to the Windows system tray

**NOTE:**
If necessary, select the expand arrow to see the SST icon in the system tray.
Selecting the SST icon from the system tray provides the following menu choices:

- **Check for Updates** - Allows you to manually check for software updates anytime. See *Manual Software Download* on page 193.
- **Show Progress** - allows you to check the status of an active download
- **Settings** - provides SST program options:
  - Turn on/off automatic software installation. *Applies only for SST program updates.* The default setting is “on” (box checked).
  - Set the hourly interval for the SST to check for software updates (choose number 2 to 168). *Applies to SST program updates, and diagnostic tool software upgrades/updates.* The default interval is 4 hours.
- **About** - displays the SST program software version number
- **Exit** - closes the SST program
16.2 End User License Agreement

Before software installation at initial purchase, and before all subsequent software updates/upgrades installations End User License Agreement (EULA) acceptance is required.

**IMPORTANT:**
Use of Software is governed by the terms and conditions of the End User License Agreement. The diagnostic tool should not be initially operated until the End User License Agreement is read. Use of the device acknowledges your acceptance of the End User License Agreement. The Snap-on Incorporated Software End User License Agreement is available at: https://eula.snapon.com/diagnostics

To Accept: at the screen prompt (Figure 16-3) click the checkbox on the left side of the window, and then select **Agree and Continue**. The software will be installed automatically.

Figure 16-3 below represents a typical EULA acceptance agreement screen.

![Figure 16-3 Typical EULA acceptance screen](image)

To Decline: at the screen prompt (Figure 16-3) select **I Decline**. A confirmation message is displayed providing options to Go Back or Exit the software installation (Figure 16-4).

![Figure 16-4 Typical EULA acceptance screen](image)
16.3 Manual Software Download

This section describes the basic procedures for manually downloading software updates and upgrades.

Normally, the SST will automatically detect and download software. If necessary, use the following procedure to manually check for and download software.

**NOTE:**
It is recommend that you download software upgrades when not actively using the diagnostic tool. Download times will vary as they are dependent on the file size of the upgrade (some upgrades may exceed 3Gb) and your connection speed. It is suggested that you start the download at the end of your day and let it run overnight. It is also suggested that you ensure a download of this size is within the available data allowance of the Internet connection or data plan being used. For software upgrade installation instructions, see Installing Software Upgrades on page 197.

To manually download software:
1. Select the SST icon in the system tray to open the menu (Figure 16-5).

---

**Figure 16-5 ShopStream Update Tool icon and menu**
2. Select **Check for Updates** from the menu.
   A series of message boxes will display as the SST searches for updates (Figure 16-6).

   ![Figure 16-6 Typical - Checking for Updates message](image1)

   Once the search is complete, one of two results are expected:
   - If no updates are found, the message box closes and a “No updates available” message displays. Select the message to close it.
   - If updates are found, they will automatically begin to download (Figure 16-7).

   To view the update status window (Figure 16-7), select **Show Progress** from the SST icon menu (Figure 16-2).

   ![Figure 16-7 Typical - Update status window](image2)

   **NOTE:**
   The percentage status bar may not always be displayed while downloading (Figure 16-7).

3. During an active download, the following options are available:
   - **Fast Download**—selecting Fast Download provides the option to either initiate a faster download, or continue downloading the background. If Fast Download is selected, it may
adversely affect diagnostic tool performance, only choose if you are not actively using the Diagnostic Suite.

- **Minimize**—closes the message box. The download continues as a background task and the diagnostic tool can be used normally. Select **Show Progress** from the SST icon menu at any time to reopen the message box and check the status of the download.

- **Cancel**—stops and cancels the download and closes the message box. If you select Cancel, and choose to re-start the download again, the download will start from the beginning.

4. Once the download completes, it must be installed. See the applicable instructions for Installing Software Updates on page 195 or Installing Software Upgrades on page 197.

   For SST program updates (only) - if you have the Automatic Update setting "on", the update will be installed automatically. See Automatic Update setting in Basic Operation on page 190 for additional information.

   If you have the Automatic Update setting “off”, the SST program must be manually installed. See Installing Software Updates on page 195.

**NOTE:**

If the Internet connection is interrupted during a download, the download is suspended and a "network unavailable" message displays. The message disappears and the download resumes automatically once the Internet connection is restored.

### 16.4 Installing Software Updates

When a software update is ready for installation, an installation update message will appear (Figure 16-8). You can select the message or the SST icon from the system tray at anytime to start the software update installation process.

**NOTE:**

If applicable, before installing a software update, have your Scan Module and USB cable available. The software update may include Scan Module firmware updates that need to be installed.

**To install a software update:**

1. Select the software update available message (Figure 16-8), or the SST icon from the system tray.
   
   A software update installation window will display (Figure 16-9).
2. Select an installation option to continue:
   - **Install Now**—starts the software update installation. Proceed to step 3.
   - **Install Later**—closes the message. The message will reappear at a later time as a reminder.

**NOTE:**
If **Install Later** is chosen, you can select the SST icon from the system tray to restart the installation at anytime.

3. Close the **ShopStream Diagnostic Suite** application. The ShopStream Diagnostic Suite should remain closed until the software installation has completed.
4. Follow the on-screen instructions to complete the installation.
5. After the installation is complete, open the **ShopStream Diagnostic Suite** application.
6. If applicable, select **Scanner** from the Home Screen. If a Scan Module firmware update has been received, a "Scan Module firmware update" message will display. Proceed to Updating Scan Module Firmware on page 68.
   - If the Scanner opens normally and no update message is displayed, proceed to step 7.
7. Turn the diagnostic tool off, then turn it on (re-boot).
8. From the toolbar, select **Menu > HELP > Version Info** to confirm the new version number is installed.
16.5 Installing Software Upgrades

**NOTE:**
It is recommended that you perform software upgrade installations Monday – Friday, during business hours to ensure customer care representatives are available for support. The installation will take approximately 30 minutes. If the installation is interrupted, Contact Snap-on Diagnostics Customer Care for assistance. See the Snap-on contact information at the front of this manual.

**NOTE:**
If applicable, before installing a software upgrade, have your Scan Module and USB cable available. The software upgrade may include firmware updates that need to be installed to the Scan Module.

**To install a software upgrade:**
1. Select the software upgrade available message (*Figure 16-10*), or the SST icon from the system tray.

![Figure 16-10 Typical upgrade installation message](image1)

An upgrade installation window will display (*Figure 16-11*).

![Figure 16-11 Typical upgrade installation window](image2)
2. Select an installation option to continue:
   - **Upgrade Detail**—opens a PDF file describing the details of the software upgrade, including any accessories that may be required.
   - **Install Now**—starts the software upgrade installation. Proceed to step 3.
   - **Install Later**—closes the upgrade message. The upgrade available message reappears at a later time as a reminder.

**NOTE:**
If **Install Later** is chosen, you can select the SST icon from the system tray to restart the installation at anytime.

3. Close the **ShopStream Diagnostic Suite** application. The ShopStream Diagnostic Suite should remain closed until the software installation has completed.
4. Follow the on-screen instructions to complete the installation.
5. After the installation is complete, open the **ShopStream Diagnostic Suite** application.
6. If applicable, select **Scanner** from the Home Screen, if a Scan Module firmware update has been received, a “Scan Module firmware update” message will display, proceed to **Updating Scan Module Firmware** on page 68
   - If the Scanner opens normally and no update message is displayed, proceed to step 7.
7. Turn the diagnostic tool off, then turn it on (re-boot).
8. From the toolbar, select **Menu > HELP > Version Info** to confirm the new version number is installed.
9. To activate your SureTrack access that comes with your new software upgrade, see **ShopStream Update Tool (SST)** on page 190.
This section covers how to care for your Diagnostic Tool components.

17.1 Diagnostic Tool

This section covers how to care for your Diagnostic Tool.

17.1.1 Cleaning the Touch Screen

The touch screen can be cleaned with a soft cloth and alcohol or a mild window cleaner.

**IMPORTANT:**
Do not use any abrasive cleansers or automotive chemicals on the touch screen.

17.1.2 Calibrating the Touch Screen

The touch screen can be calibrated for accuracy using the PenMount (PM) utility of the Diagnostic Tool.

**To calibrate the touch screen:**
1. From the Windows toolbar select **Start > PenMount Control Panel**.

![Figure 17-1 Starting the calibration program](image)

2. In the PM Control Panel; highlight the **PenMount 6000 RS232** and select **Configure**.
3. Select one of two calibration options:
4. Select and hold the center of each red box that displays in sequence.

5. Select **OK** to close the dialog boxes once the calibration is complete.
Extended Desktop Touch Screen Calibration

Special consideration must be given to calibrating the touch screen when the Extended Desktop feature of the Diagnostic Tool is used with an external monitor and the optional docking cradle. If the standard calibration method does not restore touch screen accuracy to a Diagnostic Tool with extended desktop, use one of the procedures that follow.

To calibrate the touch screen without the Diagnostic Tool installed in docking cradle:

1. From the Windows toolbar select **Start > Control Panel > Display**. The Display Properties dialog box opens.
2. From the dialog box select **Settings > Advanced**. The Default Monitor and Intel Driver dialog box opens.
3. From the dialog box select the **Display Config** tab.
4. From the Display Config tab, select LVDS (clone) CRT from the Display Configuration dropdown menu (Figure 17-4).

![Sample Display Config tab](image)

5. Select **Apply**.
6. Close the dialog boxes and the Control Panel window.
7. Calibrate the touch screen using the standard procedure.

**NOTE:**

This method disables the extended desktop. The same calibration issue arises if the extended desktop is used again.
To calibrate the touch screen with the Diagnostic Tool installed in docking cradle:

1. With the Diagnostic Tool installed in the docking cradle, connect a USB keyboard and an external monitor.

**IMPORTANT:**
The Intel Graphics Display Config should be set to "LVDS (extended) CRT", refer to the procedure above to verify or reset the configuration.

2. From the Windows toolbar select **Start > PenMount Control Panel** to open the dialog box.
3. From the dialog box, select the **Multiple Monitors** tab.
4. With the **Multiple Monitor Support** box checked, select the **Map Touch Screens** icon (Figure 17-5).

![Figure 17-5 Sample Multiple Monitors tab](image)

5. Follow the screen prompts and touch the screen of the Diagnostic Tool as requested.
6. Type "S" on the USB keyboard to skip for extended display as requested.
7. Select **OK** from the Multiple Monitors tab to close the PenMount Control Panel dialog box.
8. Calibrate the touch screen using the standard procedure.

### 17.1.3 Cleaning and Inspecting the Diagnostic Tool

When using the VERDICT Diagnostic Tool, make sure to do the following:

- Check the housing, wiring, and connectors for dirt and damage before and after each use.
- At the end of each work day, wipe the VERDICT Diagnostic Tool housing, wiring, and connectors clean with a damp cloth.

**IMPORTANT:**
Do not use any abrasive cleansers or automotive chemicals on the VERDICT Diagnostic Tool.
17.1.4 Battery Service

Follow all safety guidelines when handling the battery pack.

**WARNING**
Risk of electric shock.
- Prior to recycling the battery pack, protect exposed terminals with heavy insulating tape to prevent shorting.
- Disconnect all test leads and turn diagnostic tools off before removing the battery pack.
- Do not attempt to disassemble the battery or remove any component projecting from or protecting the battery terminals.
- Do not expose the unit or battery pack to rain, snow, or wet conditions.
- Do not short circuit the battery terminals.

*Electric shock can cause injury.*

**WARNING**
Risk of explosion.
- The Lithium battery is factory replaceable only, incorrect replacement or tampering with the battery pack may cause an explosion.

*Explosion can cause death or serious injury.*

**Battery Safety Guidelines**

**IMPORTANT:**
The battery pack contains no user serviceable components. Tampering with the battery pack terminals or housing will void the product warranty.

Keep the following in mind when using and handling the VERDICT battery pack:
- Do not short circuit battery pack terminals.
- Do not immerse the VERDICT Diagnostic Tool or battery pack in water, or allow water to enter the Diagnostic Tool or battery pack.
- Do not crush, disassemble, or tamper with the battery pack.
- Do not heat the battery pack to over 100°C (212°F), or dispose of it in a fire.
- Do not expose the battery pack to excessive physical shock or vibration.
- Keep the battery pack out of reach of children.
- Do not use a battery pack that appears to have suffered abuse or damage.
- Charge the battery pack in the appropriate charger only.
- Do not use a battery charger that has been modified or damaged.
- Use the battery pack for the specified product only.
- Store the battery pack in a cool, dry, well ventilated area.

**NOTE:**
The battery pack should be used within a short period of time (about 30 days) after charging to prevent loss of capacity due to self-discharging.
If long-term storage of the battery pack is necessary, it should be stored in a cool, dry, well-ventilated place with a 30 to 75 percent state of charge to prevent loss of characteristics.

To prolong the life of your battery, turn off the Diagnostic Tool when not in use. The VERDICT Diagnostic Tool has a built-in charger that recharges the battery on demand whenever it is connected to a power source.

**Replacing the Battery Pack**

If the battery pack no longer holds a charge, contact your sales representative to order a new one.

**IMPORTANT:**
Replace the battery pack with original Snap-on replacement parts only.

To replace the battery pack:

1. Loosen the two captive screws that secure the battery pack to the back of the Diagnostic Tool.
2. Insert a fingernail into the recess at the mid point of the top of the battery pack, then gently raise the battery pack up to release the electrical connector.
3. Lift the battery pack clear of the Diagnostic Tool.
4. Fit the three tabs on the bottom of the new battery pack into the slots, then rotate the assembly into position.
5. Make sure the battery pack is fully seated.
6. Tighten the two captive screws.
Disposing of the Battery Pack

Always dispose of a lithium-ion battery pack according to local regulations, which vary for different countries and regions. The battery pack, while non-hazardous waste, does contain recyclable materials. If shipping is required, ship the battery pack to a recycling facility in accordance with local, national, and international regulations. For additional information contact:

- **United States of America**— Rechargeable Battery Recycling Corporation (RBRC) at http://www.rbrc.org or http://www.call2recycle.org, or call 1(800) 822-8837 (USA)
- **Canada**— Rechargeable Battery Recycling Corporation (RBRC) at www.call2recycle.ca

Products bearing the WEEE logo (Figure 17-7) are subject to European Union regulations.

![Figure 17-7 sample WEEE logo](image)

**NOTE:**
Always dispose of materials according to local regulations.

Contact your sales representative for details.

Battery Pack Calibration

The internal battery pack contains a micro controller that monitors the battery pack characteristics and maintains an internal “fuel gauge”. The internal fuel gauge may lose some accuracy after many cycles of partial discharge and charge. Should this happen, the fuel gauge can be calibrated with the following procedure:

1. Fully charge the battery pack.
2. Fully discharge the battery pack at a steady rate.

**IMPORTANT:**
The battery must be completely discharged! Operate the Diagnostic Tool until it shuts down by itself due to a lack of power. Continue operating the tool when the “low battery” warning displays, do not begin charging until after the tool has automatically shut down.

3. Fully charge the battery pack.

**NOTE:**
It is not recommended to perform the calibration procedure more than once within 30 days.
17.1.5 Operating System Restore

Snap-on System Restore is a hard disk drive recovery program that allows you to recover the hard disk drive files in the event of a failure. Running the program replaces all of the C drive data with the original factory data. Be aware, all new or modified files on the C drive will be lost.

The directional arrow icons on the Diagnostic Tool are used to navigate when performing a system restore. Use the Enter icon to make selections.

To restore the operating system
1. Turn on the Diagnostic Tool.
2. Wait for the “Press Up Arrow to run Snap-on System Restore” message to display, then select the Up Arrow icon.
   A progress indicator displays while the program loads.
3. Select OK from the confirmation message.
   A progress indicator displays while the files are being restored.
4. Select OK from the confirmation message.
   The Diagnostic Tool shuts down, then reboots and the system recovery portion of the operation begins. Follow any on-screen prompts.
   The Diagnostic Tool shuts down and reboots a second time. When the VERDICT Home screen displays, the procedure is complete and the Diagnostic Tool is ready for use.

17.2 Scan Module

This section covers how to care for your Scan Module.

17.2.1 Cleaning and Inspecting the Scan Module

When using the Scan Module, make sure to do the following:

- Check the housing, wiring, and connectors for dirt and damage before and after each use.
- At the end of each work day, wipe the housing, wiring, and connectors clean with a slightly damp cloth.

IMPORTANT:
Do not use any abrasive cleansers or automotive chemicals on the Scan Module.
17.2.2 Replacing the Protective Handgrip

The soft protective handgrip that covers the outer edges of the Scanner is easily replaced should it become worn or damaged. Contact your sales representative for replacement parts.

To replace the protective handgrip:
1. Disconnect the data cable, and any other cables, if attached to the Scanner.
2. From the bottom of the Scanner, gently lift up and out on one side of the handgrip to free it from Scanner housing.
3. Repeat step 2 to loosen the other side of the handgrip.
4. Lift the handgrip off of the Scanner housing.

NOTE:
The handgrip tapers toward the front of the Scanner housing. Make sure the replacement handgrip is correctly oriented before attempting to install it.

5. Fit the new handgrip over the top, data cable end, of the Scanner housing.
6. With your fingers, work the new handgrip onto the Scanner housing from top to bottom. Make sure the tabs on the handgrip fit into the grooves on the housing.

17.3 M2 Scope/Meter

This section covers how to care for your M2 Scope/Meter.

17.3.1 M2 Scope/Meter Cleaning and Inspecting the M2 Scope/Meter

When using the M2 Scope/Meter, make sure to do the following:

- Check the housing, wiring, and connectors for dirt and damage before and after each use.
- At the end of each work day, wipe the housing, wiring, and connectors clean with a slightly damp cloth.

IMPORTANT:
Do not use any abrasive cleansers or automotive chemicals to clean the Diagnostic Tool, cables, or probes.

17.3.2 Replacing the Battery Pack

If the M2 Scope/Meter battery pack no longer hold a charge, contact your sales representative to order a new one.

IMPORTANT:
The battery pack contains no user serviceable components. Tampering with the battery pack terminals or housing will void the product warranty.

Replace the battery pack with the exact replacement rechargeable nickel-metal hydride (Ni-MH) type battery only. Do not attempt to use standard (lead/zinc) batteries as they do not provide sufficient power to operate the M2 Scope/Meter, and may leak and damage the tool.
**WARNING**

Risk of electric shock.

- Prior to recycling the battery pack, protect exposed terminals with heavy insulating tape to prevent shorting.
- Disconnect all test leads and turn diagnostic tools off before removing the battery pack.
- Do not attempt to disassemble the battery or remove any component projecting from or protecting the battery terminals.
- Do not expose the Diagnostic Tool or battery pack to rain, snow, or wet conditions.
- Do not short circuit the battery terminals.

*Electric shock can cause injury.*

**IMPORTANT:**

Be aware of all applicable safety considerations when replacing, handling, and recycling batteries. Refer to "Battery Safety Guidelines," on page 203 for details.

---

To replace the battery pack:

1. Refer to Figure 17-8:

![Figure 17-8 M2 Scope/Meter battery pack replacement](image)

- 1 — Hanger Catch
- 2 — Captive Screw

2. Press to release the hanger catch on the back of the M2 Scope/Meter (Figure 17-8), then swing the hanger up (180°) so that it is fully extended.
3. Loosen the captive screw that secures the battery cover (Figure 17-8).
4. Remove the battery cover.
5. Remove the battery pack from the M2 Scope/Meter housing to access the electrical connector.
6. Separate the battery pack electrical connector.
7. Connect the new battery pack electrical connector to the M2 Scope/Meter.
8. Fit the battery into the battery compartment.
9. Fit the battery compartment cover.
10. Tighten the captive screw and fold down the hanger.